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Foreword
Welcome to Advanced Editing with DaVinci Resolve 15
I think one of the most exciting things about DaVinci Resolve 15 is that it brings together editing, 
color correction, audio post, and now, visual effects in the same software application! With the 
addition of the new Fusion page in DaVinci Resolve 15, you get over 250 tools for advanced 
node-based visual effects compositing and motion graphics, along with even better color 
correction and editing features, and a full-blown Fairlight digital audio workstation. That means 
you’ll be able to switch between creative tasks without having to export or translate files 
between different applications!

Best of all, DaVinci Resolve 15 is absolutely free! We’ve made sure that the free version of 
DaVinci Resolve actually has more features than any other paid editing system. That’s because 
at Blackmagic Design we believe everybody should have the tools to create professional,

Hollywood caliber content without having to spend thousands of dollars.

I hope you’ll enjoy using DaVinci Resolve 15 and we can’t wait to see the amazing work 
you produce!

Grant Petty 
Blackmagic Design
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Getting Started
Welcome to Advanced Editing with DaVinci Resolve 15, an official Blackmagic Design certified 
training book that teaches professionals and students how to get the most out of editing with 
DaVinci Resolve 15. All you need is a Mac or Windows computer, the free download version of 
DaVinci Resolve 15, and a passion to learn about editing.

This guide blends practical, hands-on exercises with the aesthetics of editing to help you 
discover new techniques for whatever editing tasks you take on. You will learn new editing 
functions, trimming styles, and multilayered timeline capabilities. You’ll also go deeply into 
audio editing and mixing in the Fairlight page to explore techniques used by professional audio 
engineers to enhance the sound design in your projects.

After completing this book, you are encouraged to take the 50-question online proficiency 
exam to receive a Certificate of Completion from Blackmagic Design. The link to the exam is 
located at the end of this book.

About DaVinci Resolve 15
DaVinci Resolve is the world’s fastest growing and most advanced editing software. It also has  
a long history of being the world’s most trusted application for color correction. With DaVinci 
Resolve 15, Blackmagic Design has added a complete set of professional audio editing and 
mixing tools that enable you to complete projects using only one piece of software!
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What you will Learn
In these lessons you’ll work with multiple projects to learn advanced, practical techniques 
used in several editing genres. You’ll acquire real-world skills that you can apply to real-
world productions.

Lesson 1
Covers some general editing techniques to help you get started.

Lessons 2
Reveals some of the most powerful features in Resolve’s Media Page to help you more 
efficiently set up and organize projects.

Lesson 3, 4 and 5 
Use different film and television genres (a dramatic dialogue scene, a documentary interview, 
and an action sequence) to teach you advanced editing techniques and trimming styles..

Lessons 6
Explores all the tools and techniques for multicamera editing.

Lesson 7 and 8 
Focus on motion graphics and visual effects that, as an editor, you will commonly be asked to 
create. By using a variety of compositing, keying and tracking tools in both the Edit Page and the 
Fusion Page, you will produce professional-quality opening graphics and realistic composites.

Lesson 9 
Takes you through a sound editing, design, and mixing workflow in the Fairlight page.

Lesson 10 
Shows how to add subtitles and output a project for cinema with different sound mixes based 
on the audio work you did in Lesson 9.

System Requirements
This book teaches Resolve 15 for macOS and Windows. If you have an older version of DaVinci 
Resolve, you must upgrade to the current version to follow along with the lessons. Fortunately, 
DaVinci Resolve 15 is a free upgrade from previous versions of DaVinci Resolve.

Downloading DaVinci Resolve 15
You can download the free version of DaVinci Resolve 15 from the Blackmagic Design website:

1	 Open a web browser on your macOS, Windows, or Linux computer.

2	 In the address field of your web browser, enter  
www.blackmagicdesign.com/products/davinciresolve.

3	 On the DaVinci Resolve landing page, click the Download button when it appears.
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4	 Follow the installation instructions to complete the installation.

When you have completed the software installation, follow the instructions in the following 
section, “Copying the two-part lesson files,” to download the content for this book.

Acquiring the Lesson Files
You must download two zipped editing lesson files to acquire the media files you’ll use while 
performing the exercises in this book. After you download and save the compressed files to 
your hard disk, extract both zipped files and copy them to a single R15 Editing 201 > Lessons 
folder that you create in your Documents folder.

To Download and Install the Two Lesson Files
When you are ready to download the two lesson files, follow these steps:

1	 Connect to the Internet and navigate to:  
www.blackmagicdesign.com/dvres/editing-with-resolve15-pt1.

The download will begin immediately.

The R15 editing lessons pt1.zip file is 4 GB in size, and depending on your Internet 
connection, should take roughly 15 minutes to download to your computer using a standard 
broadband connection.

2	 Download the second half of the lesson files by navigating to  
www.blackmagicdesign.com/dvres/editing-with-resolve15-pt2.

The “R15 editing lessons pt2.zip” file is 5.1 GB in size and should take roughly 25 minutes to 
download to your computer using a standard broadband connection.

3	 After downloading the zip files to your computer, open your Downloads folder, and double-
click both zip files to unzip them (if your computer doesn’t unzip the file automatically).

4	 In the Documents folder, create a new folder called R15 201 Editing.

5	 From your Downloads folder, move the folders “Action”, “Multicam”, “Rhinos” and VFX to the 
Documents > R15 Editing 201 > Media folder.

You are now ready to begin Lesson 1, “Editing Basics”.



x

A
ck

n
o

w
le

d
g

m
en

ts

Relinking Media Files
Most of the lessons in this book require you to import and open DaVinci Resolve 15 Project files 
(.drp files). After a project file is imported into the Project manager, you will need to relink offline 
clips to their media files.

The easiest way to do so is to follow these steps:

1	 Select the Master bin, right-click and choose “Relink Clips for Selected Bin”.

2	 In the Select Source folder dialog, navigate to Documents > R15 Editing 201 > Media,  
and click OK.

The media files should be relinked and you may continue to follow the steps in the lesson.

The Blackmagic Design Learning Series
Blackmagic Design publishes several official certification books as part of the 
Blackmagic Design Learning Series. They include:

�� The Definitive Guide to DaVinci Resolve 15

�� Advanced Editing with DaVinci Resolve 15

�� Color Correction with DaVinci Resolve 15

�� Fusion Visual Effects with DaVinci Resolve 15

�� Introduction to Fairlight Audio Post with DaVinci Resolve 15

�� And more to come

Whether you want to learn more advanced editing techniques, color grading, or visual effects, 
certified training has a learning path for you. 

After completing this book, you are encouraged to take a one-hour, 50-question online 
proficiency exam to receive a certificate of completion from Blackmagic Design. The link  
to this exam is located at the end of this book.

For more information on additional books in this series and Blackmagic Design certification 
training, visit www.blackmagicdesign.com/products/davinciresolve/training.
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Getting Certified
After completing this book, you are encouraged to take the one-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link to 
this exam is located at the end of this book.

You’ll be listed on the Blackmagic Design website and receive a Certified logo that you can 
proudly display on your professional website, social network page, or in your demo reel.
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Lesson 1

Editing Basics

Welcome to Advanced Editing with 
DaVinci Resolve 15, the certified BlackMagic 
Design curriculum for professional editors.

Editing is so central to cinematic storytelling 
that director Francis Ford Coppola once said, 
“The essence of cinema is editing.” This book 
explores the deep and powerful editing 
features found in DaVinci Resolve 15 as 
applied to the art and craft of editing different 
genres of video. Whether you are working to 
produce the latest cinematic blockbuster, 
a fast-turnaround episodic TV show, or an 
online promo, while the principals of editing 
have not changed in over 100 years the 
technology you’ll find in DaVinci Resolve can 
(and will) significantly change (and improve) 
your editorial methods.

To begin with though, let’s take a quick trip 
through some editing fundamentals which 
cover the basic skills we will build on 
throughout the rest of this book.

Time

This lesson takes approximately 
60 minutes to complete.

Goals

Editing a Trailer	 2

Creating the First Assemble	 9

Finessing the Edit	 32

Audio Mixing Basics	 40

Adding Transitions	 43

Adding Fusion Titles	 46

Carry on Cutting	 48

Lesson Review	 49
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NOTE  This chapter assumes you have downloaded the media for this book. If you 
are unsure, return to the Getting Started section and follow the download instructions 
in “Getting the lesson files”.

Editing a Trailer
Editing is often an iterative process that requires you to build a coherent story from 
disparate pieces of footage. Whilst there are many recognized workflows to putting these 
sounds and pictures together, unfortunately there is no “magic bullet” as every cut has its 
own unique considerations.

With that said, let’s start building a short trailer for an upcoming movie entitled “Age of 
Airplanes” by Brian J. Terwilliger so you can appreciate some of the thought processes 
and happy accidents that often occur in editing suites around the world.

1	 Open DaVinci Resolve on your system.
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The first window you see will be the Project Manager. Naturally enough, this is where 
you can sort, organize, backup, import and restore the individual DaVinci Resolve 
projects you work on.

NOTE  If you’ve been using DaVinci Resolve before, you may have a number of 
projects in the Project Manager already. Feel free to create a new Folder in the 
Project Manager for the projects you’ll be using throughout this book.

2	 Click the New Project button to create a new project and type R15 Editing Lesson 01.

3	 Click Create.

NOTE  DaVinci Resolve does not save individual projects at the OS level like 
some other non-linear editing systems (NLEs) you may be familiar with. 
Instead, your projects are stored and managed within one of two types of 
database. For more information on managing projects and databases, please 
refer to the DaVinci Resolve User Manual or the The Definitive Guide to 
DaVinci Resolve 15.

Your new project opens in DaVinci Resolve on the Edit Page.

4	 If necessary select Workspace > Reset UI Layout to reset the Edit Page workspace to 
the default.
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Importing Source Files
The first step in any editing workflow is to import and organize the source media needed to 
create the story. In later lessons you will learn the power of the Media Page for this, but for 
now you’ll just be importing directly in the Edit Page.

1	 In the Edit Page, choose File > Import File > Import Media. Alternatively you can use 
the keyboard shortcut Command-I (macOS) or Control-I (Windows) or right-click in the 
Media Pool and choose Import Media.

2	 In the system file window that appears, navigate to R15 Editing 201 > Media >  
Age of Airplanes.

Interface Toolbar – for revealing 
and hiding the various panels  

on the Edit Page

Toolbar – for accessing 
commonly used edit 

modes and other 
timeline options

Source Viewer – for reviewing 
and marking up your unedited 

source media clips

Timeline – for structuring 
and arranging the  

edited clips

Media Pool – for 
accessing the source 

media clips for the 
selected bin(s)

Timeline Viewer – 
for reviewing the 

edited media

Bin List – for 
organizing your 

source media clips
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3	 Select all the files in this folder and click Open.

A window appears informing you that the video clips you are importing have a different 
frame rate than your current project settings and is asking if you would like to change 
the settings to match these clips.

4	 Click Change to change the project settings to match these video clips.

NOTE  In the next lesson you will learn how to correctly set the timeline 
settings for your projects and save them as a preset.

The files appear in the Media Pool and are now ready to be organized prior to editing.

Working with Bins
Bins have been traditionally used by editors since the early days of film editing where each 
piece of film would be hung over a physical bin. Although we no longer have physical bins 
in these more flexible digital times, the terminology is still widely used. For the sake of 
argument you can use bins in the same way as you would a folder in your computer’s file 
system to organize the media for editing.
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By default, every DaVinci Resolve project contains one bin: the Master bin (which cannot 
be deleted). You are going to create several bins within the Master bin for each type of clip 
in your project so you can easily find the clip you are looking for.

1	 Choose File > New Bin, or press Shift-Command-N (macOS) or Shift-Control-N (Windows).

2	 A new bin (Bin 1) appears in the bin list. Rename this bin Audio to reflect what types of 
clips you will place in this bin.

3	 In the bin list, select the Master Bin. In the Media Pool select the first of the seven clips 
with the green waveforms denoting an audio clip, then Shift-click the last of the audio 
clips to select all the clips in between.

4	 With the seven clips highlights, click and drag them to the Audio bin in the bin list or 
the Audio bin icon in the Media Pool.



7

E
d

it
in

g
 a

 T
ra

ile
r

Great. You have now filed all the audio clips into their own neat little bin. To access any 
of the audio clips from now on you can click on the Audio bin in the bin list or double-
click the Audio bin icon in the Media Pool. To return to the top-level of your project, 
click on the Master bin in the bin list.

5	 Press Shift-Command-N (macOS) or Shift-Control-N (Windows) to create a new bin. 
Rename this new bin Interviews then return to the Master bin.

There are three interviews with Brian J. Terwilliger in this project; clips AA0113_01.mov, 
AB0102_01.mov and AC0113_01.mov.

6	 Select each of the three interview clips and move them to the Interviews bin.
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File Names vs Clip Names:  
You may be wondering why the three interview clips haven’t got helpful names like 
the rest of the media for this project. The reason for this is that many cameras 
automatically name their files in such a way that means everything to the camera 
but not very much to the human aspect of the editing process: the editor. You can 
choose to rename the clips within your projects if you find this helpful. Just simply 
click on a clip to select it, then click again directly on the clip name. This will 
highlight the name and allow you to type your own name for the clip. This in no way 
alters the original filename for the media on the disk. You will learn more about 
renaming clips in the next lesson.

7	 Create another new bin named Titles and move the clip 11_MOVIE_CREDITS.mov to 
this bin.

Excellent. You’ve managed to impose some order to your project. However, you’ve one 
more bin to add then you can start editing.

8	 Create one final new bin and rename it Timelines. This bin will be used to store the 
timelines we’ll need to create for this project.
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NOTE  There are two additional types of bin available in DaVinci Resolve: 
Smart Bins and Power Bins. You’ll learn more about each of these in the 
next lesson.

Of course, this simple exercise has had you creating just three bins but there’s nothing 
stopping you from creating as many or as few bins that you think you’ll need to be organized. 
Feel free to review the footage and create as any additional bins as you require. You can 
also create bins within bins too by making sure you’ve got an existing bin selected before 
you choose the option to make a new bin.

Creating the First Assemble
Someone once said that the hardest part of writing a book is starting the first chapter. 
Indeed, the same is true for editing; but with sounds and moving pictures rather than 
words on a page. Placing those first few clips into an empty timeline can be quite daunting. 
However, once you have begun assembling the footage you can being to see what’s 
working, what doesn’t work, and what might be coaxed into working with a bit of effort 
on your part as the editor.
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To start this process you’ll need a timeline.

1	 Select the Timelines bin you created at the end of the previous exercise and choose 
File > New Timeline or press Command-N (macOS) or Control-N (Windows)

2	 In the Timeline Name field in the New Timeline window, type Age of Airplanes Trailer. 
Leave all the other options at their defaults and click Create.

A new timeline is created in the selected bin and additional controls have appeared in 
the timeline window.

NOTE  For this introductory lesson you don’t need to be concerned with the 
number of timeline tracks or the audio track type. In later lessons you will learn 
how to configure your audio and track types based on whether you are 
working with mono or stereo clips.

3	 Select the Interviews bin. If required, click the sort menu and choose to sort the clips 
by Clip Name in Ascending order.
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4	 Double-click the clip AA01113_01.mov to open it in the Source Viewer. 

5	 Play the clip from the beginning to the end.

In reality we probably don’t want to use the whole of this clip, but we can choose to 
remove the unwanted parts of this later. There are never really any right or wrong ways 
to edit; just more or less efficient ways.
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6	 Drag the clip from the source viewer to the timeline viewer.

A series of editing overlays appear detailing the different types of edits available to 
you in DaVinci Resolve. Seasoned editors probably recognize many of these options 
from other NLEs, though some are specific to DaVinci Resolve. The default is Overwrite.

7	 With the Overwrite edit overlay highlighted, release the mouse.

Your first clip is edited into the timeline.

8	 Play the clip back in the timeline and stop after Brian says the line “… shoot the real world.”

This is where you’ll make your next edit.
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Controlling Playback 
One of the import parts of learning to edit is effectively controlling the playback of 
you video. Whilst you could use the transport controls underneath the source or 
timeline viewers, keyboard shortcuts are much more effective. DaVinci Resolve’s 
default keyboard layout supports all the usual shortcuts for playback professional 
editors around the world will recognize. For example, you can use the spacebar to 
start and stop playback and the left and right arrow keys to move forward and back 
one frame at a time. More experienced users will be happy to know that the J, K 
and L keys also control playback at different speeds. To explore DaVinci Resolve’s 
keyboard layout in more detail you can choose DaVinci Resolve > Keyboard 
Customization.

9	 In the Interviews bin, double-click AB0101_01.mov to open it in the source monitor.

Play this clip through from the start. We only want to use a part of this clip. When 
working with clips with audio like this, it’s useful to see a representation of the audio 
waveform along with the video in the source viewer.

10	 In the source viewer’s options menu, select “Show Zoomed Audio Waveform”.

How cool is that? Now as you scrub or play through this clip you can see from the 
waveform where he starts and stops speaking. Nice!
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11	 Play the clip from the start once more and then stop playback just before Brian says  
“If it was possible to shoot it, we wanted to go shoot it…” (at around 01:01:11:07).

NOTE  Throughout this book timecode references are used as guidelines for 
where the authors believe the edits work best. However, please feel free to 
explore the footage and use different locations if you feel there are better 
choices. Editing is, after all, a subjective as much as a creative endeavor.

12	 Press I to set an In Point at this location.
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13	 Play the clip through and stop after Brian says “… everything was real” (at about 
01:01:23:20).



16

C
re

at
in

g
 t

h
e 

Fi
rs

t 
A

ss
em

b
le

14	 Press O to set an Out point at this location.

15	 In the timeline toolbar, click the Overwrite Clip button, or press F10.

NOTE  If you are using DaVinci Resolve on macOS you may need to configure 
your keyboard settings in System Preferences to “Use F1, F2, etc. keys as 
standard function keys” to use the default editing shortcuts. Alternatively, 
you can use the fn key with any F-key to override the macOS shortcuts.

The second interview clip is edited into the timeline starting at the position of the 
timeline playhead and using only the portion marked between the in and out points 
in the source. The end of the first clip has been overwritten by the new clip. 

16	 Press Up Arrow on your keyboard to move your timeline playhead back to the edit 
between the two interview clips.

17	 Press / (slash) to review the edit.

The edit is successful enough, but it’s a pretty nasty jump cut. You’ll need to add some 
more footage around this interview to flesh out the story.
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Three-point Editing 
With a few notable exceptions, every edit you perform is generally referred to as 
a three-point edit. This means that DaVinci Resolve is calculating what you want 
to be edited and where you want it edited. In the previous example, the in and out 
points you marked in the source were the first two points required; the third point 
was the position of the playhead in the timeline. When you edited the first 
interview clip into the timeline you were also using three-point editing; even 
though you hadn’t set any in or out points, the software used the clip in the source 
viewer from the beginning (the implied in point) to the end (the implied out point) 
and placed it at the beginning of the timeline, not because it was the first clip but 
because that was where the playhead was. Simple, eh? Throughout these 
exercises try to work out the rules of three-point editing that Resolve is following 
and how the in and out points (real or implied) are being used to complete the 
edits. In later lessons you’ll also be making some four-point edits and edits that 
use in and out points in different ways!

Insert Edits
Ok, time to add some B-Roll footage to bring Brian’s passion for airplanes alive.

18	 In the Master bin, double-click the 02_A380_TAKEOFF.mov clip to load it in to the 
source viewer. Play the clip from the start to review the footage.
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19	 Set an In Point a second or so before the plane’s wheels begin to lift off the runway 
(around 01:00:07:00).

20	 Set an out point once the tail of the plane has left the frame.

21	 Making sure your timeline playhead is still on the edit point between the two interview 
clips, drag the clip to the Insert overlay in the timeline viewer.
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The clip is added in between the two interview clips in the timeline, but has been 
inserted between them rather than overwriting the clip after the playhead.

22	 Move the timeline playhead back to the edit between AA0113_01.mov and  
02_A380_TAKEOFF.mov. This will be the location for your next edit.

NOTE  Using the up and down arrow keys are fast ways of moving between 
the different edit points in your timeline. If you prefer, you can always drag the 
timeline playhead and it will snap to the nearest edit point so long as your 
Snapping option is enabled. Press N to toggle snapping on or off.

23	 Double-click 01_A380_TAXI.mov from the Master bin in the Media Pool.

Play the clip through to review. This is a nice overhead shot of the same type of plane 
as you’ve just edited into the timeline, but the audio is a little distracting.

24	 In the timeline, click the red outlined A1 Destination Control for the track Audio 1.
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These destination controls allow you to specify which parts of the source audio or 
video are going to be edited into the timeline. By disabling the A1 control you will no 
longer automatically edit the audio from the source clip.

25	 Click the Insert Clip button in the timeline toolbar, or press F9 to insert the new clip 
(sans audio) into the timeline.

Cool. That’s looking a little more interesting. You’ll now insert a clip to split an 
existing clip.

26	 In the timeline, play through the second interview clip and stop after Brian says  
“If it was possible to go shoot it, we wanted to go shoot it”.

This will be the location for your next edit.

27	 In the Media Pool double-click 10_MALDIVES.mov and review the clip in the 
source viewer.

28	 Set an in point as you see the shadow of the plane begin to pass across the coral.

29	 In the source viewer type +300 to jump the playhead forward 3 seconds.

30	 Press O to set the out point.
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31	 Press F9 to insert the clip into the timeline at the playhead position.

Did you see how this edit has inserted the marked source clip by splitting the 
existing interview clip’s audio and video, even though we only had video to edit? 
This happened because the auto select control for the Audio 1 track is automatically 
enabled. You’ll learn more about the auto select controls in the later lessons.

Removing the Excess
Ok, your edit is looking pretty good, but you’re now at the stage where you’re probably 
thinking it may benefit from a little bit of trimming to remove some of the unwanted portions 
of the footage.

1	 Move the timeline playhead to the start of the middle interview clip and press 
Command-= (macOS) or Control-= (Windows) once or twice to zoom in better on this clip.
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2	 Option-click (macOS) or Alt-click (Windows) the video portion of the clip  
AB0102_01.mov in the timeline.

Do you notice the small chain icons on the video and audio of this clip? That means the 
two parts of this clip are linked. This can be useful if you wanted to remove or move 
both parts of this clip (meaning it would be quite difficult to move them out of sync with 
each other for example). By using the Option key (macOS) or Alt key (Windows) you’re 
momentarily overriding the linking to select just the video portion of the clip.

NOTE  If you’re selecting both parts of the clip with the Option key (macOS) or 
the Alt key (Windows) make sure the Link Selection function is currently active. 

3	 Right-click the selected video clip and select Ripple Delete from the shortcut menu, 
or press Shift-Delete (Backspace).

The video portion of the clip is removed and the remaining audio tucks nicely under 
the preceding shot of the A380 taking off.

Did you notice what else happened in the timeline? Because you performed a Ripple 
Delete, it meant you didn’t leave a gap and the rest of the footage in the timeline 
moved up, More to the point, the audio and video in the last interview clip remained in 
sync. Again, this is due to the auto select control being enabled on all tracks by default.
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NOTE  If you want to see what would happen with the auto select control 
looking out for you, undo the last step and disable the auto select control for 
the Audio 1 track and repeat the last few steps. Remember to re-enable auto 
select for Audio 1 afterwards.

Another way to remove sections of clips from your timeline is using in and out points.

4	 Play through the third interview clip on the timeline.

You’re going to remove the line “…stay at that location longer…” as it’s a little repetitive 
and unnecessary.

5	 Click the timeline viewer’s options menu and choose “Show Timecode Overlays”.

You now see small overlays in the timeline viewer that display the source timecode of 
the timeline clips.
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6	 Play through the last clip on the timeline and set an in point just before Brian says “… 
stay…” (at 01:01:17:21 using the timecode overlays).

7	 Add an out point after he says “…longer…” (at 01:01:19:02 using the timecode overlays).

8	 Press Shift-Delete (Backspace) to ripple delete the portion between the in and out points.
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9	 Press / (slash) to preview the new edit.

Great. That’s tidied up that part of the timeline, now you’ll turn your attention to the 
first clip.

Trim Edit Mode
1	 Press Shift-Z to zoom back out from your timeline.

2	 Press the Home Key to move the playhead back to the beginning of the timeline.

3	 Press Shift-Z to return to the previous zoom level.

4	 Play through the first clip.

Obviously there’s some unwanted portion of his interview we need to trim off at the 
beginning here.

5	 Place your timeline playhead just before Brian says “In this film…” (at about 01:00:53:05 
using the timecode overlays in the timeline viewer).

6	 Press T to enter Trim Edit Mode.

The Trim Edit Mode toolbar button becomes highlighted.

7	 Click the beginning of the first clip and drag the edit to the right until it snaps to 
your playhead.
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TIP  If snapping isn’t enabled, just press N to quickly enable it during the 
trimming operation.

8	 Press A to return to Selection edit Mode.

Notice that because the audio and video of this clip are linked, you’re trimming both 
parts of the clip together and because you are in trim edit mode you’re automatically 
rippling the timeline; all clips in the timeline on all auto select-enabled tracks after the 
selected edit are being rippled to maintain their sync’ed relationships.

Adding More Tracks
Now that you’ve started refining the timeline more, you’ll possibly want to add the music 
and then build in the final pictures.

1	 Move your playhead back to the beginning of the timeline.

2	 Select the Audio bin and locate the clip Music Score for Trailer.mov.

3	 Drag this clip directly from the bin to the Place On Top overlay in the timeline viewer.

4	 Press Shift-Z to show the entire timeline.

Despite its name, the Place on Top edit has actually added a new audio track below 
your existing audio tracks. The Place on Top edit will actually place the edited clip into 
the first available empty track in your timeline, working its way upwards through the 
video tracks, or downwards through the audio tracks. If it can’t find an empty timeline 
track for the duration of the source clip, then a new track is created to accommodate 
the new clip. Place on Top is useful for adding B-Roll to interviews or titles as you will 
see later.
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You’ll need to attenuate (lower) the level of the music clip otherwise you won’t hear 
the interview audio.

5	 Use the volume curve on the Music Score for Trailer audio clip to lower the clip’s 
volume by about -18db.

6	 Move your timeline playhead to the edit point between the last two interview clips.

7	 From the Master bin, double click the clip 08_SOUTH_POLE_DC3_.mov to open it 
into the source viewer.

8	 Press F10 to overwrite the whole of this clip at the playhead position, overwriting the 
video of Brian’s final interview clip in the process and solving the problem of that jump 
cut at the same time.

NOTE  In a later lesson you will learn other options for fixing visual jump cuts.

9	 Select the clip 07_KENYA.mov in the Master bin and drag across to the Append at End 
timeline viewer overlay.
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The Append at End edit will use the end of the last clip on the targeted track as the 
implied in point in the timeline, irrespective of where the timeline’s playhead is. It may 
not seem like it, but this is still a three-point edit.

10	 From the Master bin, select 06_MILKYWAY.mov and use the timeline viewer overlays 
to perform an Append at End edit.

11	 Double-click 05_BAY_AREA_LIGHTS.mov to open the clip in the source viewer then 
press Shift-F12 to perform an Append at End edit.

12	 Press Shift-Z to show the whole timeline.
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Trimming to Duration
You now need to trim the extra pictures to bring your edit to time.

1	 Place your timeline playhead at the start of 08_SOUTH_POLE_DC3_.mov and press 
Comand-= (macOS) or Control-= (Windows) once or twice to zoom in

2	 Press T to enter Trim edit Mode.

3	 Select the beginning of the 08_SOUTH_POLE_DC3_.mov clip and begin to drag to 
the right to trim the clip.

Whoa! Do you see what’s happening? You’re trimming the beginning of the clip forward 
but the interview audio is being rippled backwards!

4	 Press Command-Z (macOS) or Control-Z (Windows) to undo the last step.

5	 Click the auto select control for the Audio 1 track to deselect it.

6	 Repeat the trim operation in Step 3 to trim the clip but not move the Interview audio. 
Trim the clip so the grey duration tooltip reads about 3 secs.
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7	 Press the down arrow key to move to the next edit at the start of the 07_KENYA.mov clip.

8	 Trim the beginning of this shot until the tail of the yellow plane is in shot and the clip is 
about 4 secs long.

Another way to change the duration of clips and make them visually more interesting 
is to adjust the speed at which the clip plays back at.

9	 Right-click the 06_MILKYWAY.mov clip and choose Change Clip Speed.

10	 In the Change Clip Speed dialogue box, type 225 in the Speed % box and check the 
Ripple Sequence option.
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The 06_MILKYWAY.mov clip is sped up and the trailing shot is rippled back in the 
timeline with its change of duration.

11	 Play through the rest of the timeline until the final beat of the music.

12	 Place the timeline playhead on the final beat of the music score (at 01:00:40:00 using 
the timecode overlays in the timeline viewer).

13	 From the Titles bin, double-click the 11_MOVIE_CREDITS.mov clip to open it in the 
source viewer.

14	 Press F10 to perform an overwrite edit.
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15	 Press Shift-Z to view your entire timeline.

Before going much further, it’s always a good idea to periodically save a copy of the 
timeline you’re currently working on.

16	 In the Timelines bin, select the Age of Airplanes Trailer timeline you’re working on 
and choose Edit > Duplicate Clip.

A copy of your timeline appears in the same bin.

NOTE  You can now continue working on the currently loaded timeline, 
knowing you have a backup of your work to this point. Many editors often 
like to rename the duplicated timeline so they know what they are looking 
at in the bin.

17	 Press Home and play your timeline to review your edit so far.

Excellent. You’ve built a fairly sophisticated trailer. However, there’s still a few things to do 
before the director will be happy.

Finessing the Edit
With a backup copy of your timeline in your bin, it’s now time to start finessing the edit 
further. You’ll begin by adding some sound effects to the b-roll footage to give it more of 
an impact.

1	 Right-click anywhere in the timeline track headers and choose Add Tracks.
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2	 In the Add Tracks dialogue box change the number of video tracks to 0 and the 
number of audio tracks to 2. Ensure the Insert Position for the new audio tracks is set 
to Below Audio 1 and set the track type to stereo. Click Add Tracks.

The additional audio tracks have been added as specified.

3	 Position your timeline playhead anywhere over the second clip 01_A380_TAXI.mov 
and press X.

In DaVinci Resolve, X does not mark the spot, but rather marks the timeline clip under 
the playhead on the lowest active auto selected track.

4	 From the Audio bin, double-click SFX – jet taxi.wav to open it in the source viewer.

5	 In the destination controls in the timeline, drag the red outlined A1 control to A2.
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This tells Resolve you want to edit the next clip into this track.

6	 Press F10 to perform an overwrite edit.

You have just completed a three-point edit, but this time you set the duration of the edit 
by using in and out points in the timeline. No in or out points were set in the source, so 
the implied in point was used; that is, from the start of the clip.

7	 Move the timeline playhead over the clip 08_SOUTH_POLE_DC3_.mov and press X 
to mark the clip.

8	 Open SF-Prop.wav from the Audio bin in the Media Pool.

9	 With your source viewer playhead at the start of this clip, type +200 in the source 
viewer and press I to set an in point.
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10	 Press F10 to perform an overwrite edit.

This time, because you added an in point to the source clip, Resolve uses this point 
when editing the clip into the timeline.

11	 Ensure your playhead is over the next clip in the timeline, 07_KENYA.mov.

12	 Press X to mark the clip.
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13	 From the Audio bin, open SFX – Distant prop plane.wav into the source viewer.

14	 Set an in point roughly 3 seconds from the start of this clip.

15	 Click on the A3 destination control in the timeline track controls.

16	 Press F10 to perform an overwrite edit.

Backtiming Edits
Another editing technique that’s often used and builds on the concept of the three-point 
edit is the backtimed edit. Backtiming an edit means you specify where you want a shot to 
end by just adding an out point rather than an in point.

1	 Place your timeline playhead over the third clip 02_A380_TAKEOFF.mov and press X 
to mark the clip.
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2	 From the Audio bin, open the clip SFX – Jet take off.wav into the source viewer.

3	 Play through the clip until the sound of the jet starts to fade away (around 01:00:18:19).

4	 Press O to add an out point.

NOTE  For backtimed edits to work you only need an out point. If necessary, 
you can remove an in point by pressing Option-I (macOS) or Alt-I (Windows).

5	 Press F10 to make an overwrite edit.
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This time the out point you set in the source viewer has specified where the new clip 
should stop. Pretty neat, yeah?

Using Replace Edits
Another technique you can use to your advantage very effectively is the replace edit. The 
replace edit is slightly different to the three-point edits you’ve been using throughout this 
lesson in that you’re not required to set any in or out points. Instead, the replace edit uses 
the position of the timeline and source playheads to align the edits.

1	 Move the timeline playhead over the clip 10_MALDIVES.mov just before you see the 
wings come into shot (about 01:00:40:02 using the timeline viewer overlays for V1).

2	 Open the clip SFX – Overhead.wav from the audio bin.

This is a simple sound effect file with a prominent waveform.
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3	 In the source viewer, position the playhead over the highest point of the waveform.

4	 In the timeline, click the destination control to A2.

5	 Click the Replace Clip button or press F11.

6	 Press / (slash) to preview the edit.

Quite effective, isn’t it? You’ll work with replace edits again in much greater detail in a 
later lesson.
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Audio Mixing Basics
Now you’ve got some sound effects in your edit the whole timeline has seemed to come 
alive and just goes to show the importance of sound. You’ll work with audio much more 
throughout later lessons, however even at this stage it’s likely that you’ll need to take on 
some basic audio duties, at the very least so the director gets a sense of what the edit will 
eventually sound like.

1	 Press A to ensure you’re working in Selection Mode and then select all the interview 
clips on the Audio 1 track.

2	 Click the Inspector button in the top right corner of the interface to open the Inspector.

3	 Use the Clip Volume slider to raise the level of all of these clips by about 6db.

That sorts the main levels out for Brian’s dialogue clips, but there’s a bit of a spike at 
the beginning of the first clip.

4	 Zoom in to the beginning of the first clip.

5	 Option-click (macOS) or Alt-click (Windows) the volume curve line to add a keyframe 
after the spike. Repeat to add a second keyframe just after the first.
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6	 Lower the part of the audio curve before the first keyframe so the peak is about the 
same height as the other peaks in the clip (a change of about -5db).

7	 Press Shift-Z to zoom back out and see the whole timeline.

Displaying the Audio Meters? 
You can see your audio levels in the edit Page by clicking on the Mixer button in 
the top right corner of the interface. You can then choose to show just the meters 
by clicking in the Mixer’s Options menu (the button with three dots) and choosing 
Meters. This then displays the combined levels for the timeline’s currently selected 
main bus. You’ll learn more about setting mains and other buses in the audio 
mixing lesson.

Mixing the Sound Effects
Now it’s time to turn your attention to the sound effects you added earlier. Firstly you’ll 
want to adjust the levels and then apply fades to the beginning and ends of each clip. 
Fortunately DaVinci Resolve has a quick way to bypass such repetitive tasks.

1	 Adjust the level of the first audio clip on the Audio 2 track, the SFX – Jet Taxi.wav clip, 
by about -8db.

2	 Use the default fade controls at the head and tail of the clip to apply a short fade in 
and out to the clip.
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3	 Select the clip in the timeline and choose Edit > Copy or press Command-C (macOS) 
or Control-C (Windows).

4	 Select all the other audio clips on the Audio 2 and Audio 3 tracks.

5	 Choose Edit > Paste Attributes or Press Option-V (macOS) or Alt-V (Windows).

6	 In the Paste Attributes dialogue box check the box for Volume in the Audio Attributes 
and click Apply.

The Paste Attributes command has pasted the volume settings, including the fade handles, 
to each of the selected clips. You may still want to go through the clips yourself later to 
check they are the right level, but this is a great timesaver.
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Adding Transitions
The use of transitions in your projects should always be done with great care. Any 
transitions you add should be done with a consideration to the story you are telling and 
should not be used if they begin detracting from that aim. As a wise man once said: 
with great power, comes great responsibility.

That said, transitions are a good way to show a change of location or time that might be 
a bit too abrupt for your audience if left with just a straight cut.

1	 Select the edit point between 02_A380_TAKEOFF.mov and 10_MALDIVES.mov.

2	 Press Command-T (macOS) or Control-T (Windows) to add the default cross 
dissolve transition.

3	 Press / (slash) to preview the transition.

You’ll find additional controls for your transitions in the Inspector

4	 If necessary, zoom in on the transition in the timeline and select it. 

5	 In the Inspector, change the Video Transition Style to “Edge Wipe”, change the Angle 
to about -80 and the duration to 12 frames.

6	 Check the Feather box and increase the border to around 96.
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7	 Finally press / (slash) to preview the transition and channel your inner George Lucas.

NOTE  You can access more transition presets by clicking on the Effects 
Library button from the top left corner of the interface and selecting the 
Video Transitions category.

Problems Applying Transitions
Occasionally you may have a problem applying transitions but it’s good to know that you 
can use Resolves flexible Trim Edit Mode to help overcome these.

1	 Select the edit point between 08_SOUTH_POLE_DC3_.mov and 07_KENYA.mov.

Notice the red bars on either side of the selected edit? This tells you that there’s no 
handles or available media on one side or the other of the cut. 

2	 Press Command-T (macOS) or Control-T (Windows) to apply a cross dissolve transition.
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The above dialogue appears warning you that there are insufficient handles. 
As trimming clips to create the handles will shorten your timeline, this probably 
isn’t something you want to happen. Instead you’ll fix this issue using a slip trim.

3	 Click Cancel.

4	 Press T to enter Trim Edit Mode.

5	 In the timeline, zoom in on clip 08_SOUTH_POLE.mov so you can see the clip 
comfortably.

6	 Place your mouse cursor over the filmstrip part of the clip. It will automatically become 
the slip trim icon.

7	 Click and drag the clip to the right by about 1 second to slip the footage within the clip.

8	 Reselect the edit point between 08_SOUTH_POLE.mov and 07_KENYA.mov and 
press Command-T (macOS) or Control-T (Windows) to apply the cross dissolve.

9	 Press A to return to the Selection Mode.
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Adding Fusion Titles
The last step in this introductory editing lesson is to add a title so everyone knows who 
Brian is. DaVinci Resolve comes bundled with a series of templates that have been created 
for your use in the Fusion Page. That doesn’t mean you have to be a compositing expert to 
use them, but it does mean that you can customize them further in DaVinci Resolve’s 
Fusion Page without needing any additional software. In a later lesson you’ll learn to create 
your own titles, track elements within your videos and work with green screen footage in 
the Fusion Page.

1	 Move your playhead to the beginning of the timeline.		

2	 If necessary, open the Effects Library by clicking the Effects Library button in the top 
left hand corner of the Edit Page.

3	 In the Effects Library, select the Titles category.

The Titles category lists all the standard title generators and new Fusion Title 
templates available.

4	 From the list of Fusion Titles, select the template called “Lower 3rd Simple Line”.

5	 Drag the Lower 3rd Simple Line title to the timeline viewer overlays and choose Place 
on Top.

The Fusion title gets placed above the first video clip on a new track.
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6	 Place your timeline playhead over the center of the title clip.

The controls for this title automatically appear in the Inspector.

7	 In the Inspector, double-click the Main Text bar to expand the text controls.

These controls allow you to adjust the main characteristics of the text within this 
Fusion Title.

8	 In the Main Text box highlight the “Super Fancy Title” text and type Brian J. Terwilliger.

9	 Double-click the Main Text bar again to collapse the text controls and then double-
click the Line Controls bar.

10	 Change the color of the line from green to your preferred shade of yellow.
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11	 Finally, in the timeline, trim the end of the title to the end of the first clip on Video 1. 
Allow the title to cache and playback.

NOTE  This title has built-in keyframed animation to bring the title in and out. In a 
later lesson you will learn how you can adjust these keyframes for perfect control 
over your text animations.

Carry on Cutting
Congratulations! You have just completed the first lesson in this book and should now have 
a more rounded understanding of the editing toolset within DaVinci Resolve 15. However, 
before you move to the next lesson you might want to put your new skills to the test as 
there’s still a few things you can do to finesse this edit. Try and accomplish these tasks on 
your own. Don’t forget you should duplicate your timeline to create a backup version before 
you make any major changes! Good luck!

1	 Trim each of the sound effect clips on Audio 2 and Audio 3 so that there’s more overlap 
as one sound effect fades out and the other fades in.

2	 Add keyframes to the music score clip on Audio 4 so that the volume rises after Brian’s 
last line.

3	 Use the Razor Edit Mode to cut up Brian’s last line and position it further down the 
timeline to create more pacing for his dialogue.

4	 Add more Fusion Titles for each airplane clip to highlight the many different locations 
(Maldives, South Pole, Kenya) that feature in this film.
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Lesson Review
1	 True or False: DaVinci Resolve automatically saves all new projects to your 

computer’s Desktop? 

2	 What element is most often used to organize imported clips in DaVinci Resolve?

A) Folders
B) Thumbnails
C) Bins

3	 What types of edits can be performed using the toolbar buttons above the timeline?

A) Overwrite 
B) Insert 
C) Append at End

4	 True or False: DaVinci Resolve only allows you to manually add one video or audio 
track at a time?

5	 From which interface element in the Edit Page can you add a preset Fusion Title to 
your timeline?

A) The Inspector
B) Edit Index
C) Effects Library
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Answers
1	 False. All new projects are saved into the currently active database.

2	 Bins are most commonly used to organize imported clips in DaVinci Resolve.

3	 A and B. The Toolbar has buttons for performing Overwrite, Insert and Replace edits. 
Append at End edits can be performed using the Timeline Viewer overlays, the Edit > 
Append at End of Timeline menu option or by pressing Shift-F12.

4	 False. You can add as many video and audio tracks as you require by choosing the 
Add Tracks option after right-clicking in the timeline track headers.

5	 C. Preset Fusion Titles can be added from the Titles category of the Effects Library 
in the Edit Page.
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Backing up Source Files
The most important asset of any project is the camera-original media. It is irreplaceable, 
and if corrupted in any way, the alternatives can be painful. So, it makes sense that the very 
first thing you must do is to back up that original media.

1	 Open DaVinci Resolve and, in the Project manager, create a new project. Name your 
project R15 Editing Lesson02 EditPrep.

You’ll use this empty project to back up content from disk image file which you will use 
to simulate plugging in a drive with new media. However, you could just as easily use 
a C-Fast or SD card from a camera.

2	 Click the Media page button, or press Shift-2.

The Media page is the most efficient page for importing and organizing media, syncing 
clips, and adding metadata. It is also where you can back up camera-original media 
using the clone tool.

3	 To display the clone tool, click the Clone tool button in the upper-left of the toolbar.

A new window opens between the Media storage browser and the viewer which you 
can use to create a backup of media cards, folders, or even an entire drive of content.

NOTE  To complete the next few steps in this exercise, you will need to have 
approximately 2.5 GB of available storage on your system.
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4	 At the bottom of the Clone tool panel, click the Add Job button.

Each item you want to clone or back up is considered a job. You can add as many jobs 
as you like and then create clones of content all at once. You add content by dragging 
a folder, a disk image, or camera card content from the Media storage browser into the 
Clone tool panel.

5	 Open a new Finder window (macOS) or Explorer window (Windows), and navigate 
to R15 Editing 201 > Lessons > Lesson 02 Edit Prep. Double-click the R15_Editing_
Lesson02.iso file to open it.

This ISO file is a disk image that will appear on your system as a virtual hard drive.  
You have just simulated plugging in an external source, such as a hard drive or camera 
media card.

6	 Return to DaVinci Resolve.

In the list of media storage locations, a new source called Lesson02_Media is  
now available.
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7	 Drag Lesson02_Media into the Clone tool panel’s Source area.

Each job requires at least one destination for the cloned media; however, you can add 
multiple destinations to create multiple backups at once.

8	 In the Media storage browser, navigate to the “R15 Editing 201 > Lessons > Lesson 02 
Edit Prep” folder, and drag the “Backup destination” folder into the Clone tool panel’s 
Destination area.

9	 In the upper-right corner of the clone tool panel, in the options menu, choose Checksum 
Type > MD5.

TIP  You can also Right-click a folder in any media storage location, 
and choose “Set as Clone Source” or “Add as Clone Destinations”.
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A checksum is a way to detect and prevent errors that can occur during the copy 
operation. Several checksum methods are available, but MD5 checksum has become 
the industry standard, and studios that require checksums with media offload on set 
will typically require it.

10	 Click the Clone button at the bottom of the Clone tool panel to begin the backup. 
During this time, you can continue using Resolve. 

11	 When the copy is complete, a green Complete label appears on the job in the  
Clone tool. 

12	 In your operating system’s interface, navigate to the R15 Editing 201 > Lessons > 
Lesson 02 Edit Prep > Backup destination folder. 

In addition to containing the entire contents of the disk image, the backup destination 
includes a MD5 checksum text document that reports any errors as a result of the 
checksum verification.

13	 Return to Resolve, and in the toolbar, click the Clone tool button to close the panel.
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14	 In the Media storage locations, Right click the Lesson02_Media location, and choose 
Unmount Drive to unmount the drive from your system, thereby allowing it to be 
removed safely.

Cloning your camera-original content is so essential that it is worth putting DaVinci Resolve 
on set, so a backup can be performed even before the set is struck and everyone goes 
home. In so doing, you can clone and check the media; and if something is wrong, you will 
know to reshoot right away with the least impact on schedules and budgets.

NOTE  For Windows users, if the disk image does not unmount using the above 
method, you can always right-click the mounted disk image and choose “Eject”.
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Customizing New Projects
After you have backed up all your content, configuring the actual project that you want to 
work on can be made easier if you have created presets for the most common project 
types that you’ll work on.

Rather than checking your project settings each time you open a project, you can configure 
options in the Project settings window and save those as your defaults. So, every time you 
open a new project under your user profile, DaVinci Resolve will default to those settings. 
Plus, you can also load these presets into existing projects.

1	 Choose File > Project settings, or press Shift-9 to open the Project settings window.

2	 In the Master settings, set the “Timeline resolution” to “1280 x 720 HD 720P”, 
and ensure that the “Timeline frame rate” is set to 24 frames per second.

3	 Click the Presets category.

4	 In the Presets panel, click the Save button to save the current configuration.

The selected preset is always the Current Project, which means that only the open 
project will contain these settings. You also can save a preset to apply to other projects.
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5	 Select the “Current Project” preset you’ve just updated, and choose “Save as”. 
Enter the new preset name as R15 Editing, and click OK.

Your settings for this project are now saved. To quickly apply them to any project 
in this database, you can select the preset, and click “Load”.

If you want every new project to open using a specific configuration, you can save 
any preset into the guest default config setting.

6	 Right-click the R15 Editing setting and choose Save as User Default config.

The preset is copied into the guest default config. Now, every new project you 
create will use those settings.
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Project presets allow you to easily create, manage, and switch between presets to enable 
the various project resolutions, frame rates, and other settings that you might need to work 
with. Project presets can save nearly every parameter and setting across all panels in the 
Project settings window; however, only the “guest default config” is used as the default  
for new projects.

Syncing Dailies
Now you’ll import the dailies into your project and begin organizing the media by syncing 
any audio and video clips that were recorded on separate devices. Some productions 
record audio on dedicated digital audio devices to capture the highest quality audio, or 
when it’s not practical or desirable to record audio directly to a camera. When the files 
come in from the day’s shoot, you’ll need to sync the separate audio and video clips.  
In some cases, you can auto sync these using timecodes found on both clips, or by 
comparing camera-recorded audio with the separate audio clips. In some instances, 
you may not be so lucky and you will need to manually sync your clips.

1	 In the Media storage browser, navigate to R15 Editing 201 > Lessons > Lesson 02 
Edit Prep> Backup destination.

This was the destination location you set in the Clone tool when copying the disk 
image in the previous exercise.

2	 Select all three folders. Right-click any of the folders, and choose “Add folder and 
SubFolders into Media pool (Create Bins)”.

3	 In the Media pool, switch to list view, and click the Clip name header to sort the bin 
in ascending order. (The arrow will point up.)

TIP  You can also transfer settings from any project to the current project in the 
Project manager. To do so, press Shift-1to open the Project manager, right-click any 
project, and choose “Load Project settings to Current Project”. A dialog box asks 
you to confirm replacing your current project’s settings. To do so, click “Load 
Project settings”.
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4	 In the bin list, click the Video clips bin, and then Cmd-click (macOS) or Ctrl-click 
(Windows) the Audio Clips bin to display the contents of both bins in the Media pool. 

5	 Double-click CLIP0001.mov.

Play through the interview with Sasha in the viewer.

This clip has poor audio, possibly because it was recorded using the on-camera 
microphone.
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6	 Double-click Audio0001.wav, and play through this clip in the viewer.

This clip contains the correct audio for Sasha’s interview.

7	 In the Media pool, select CLIP0001.mov and Audio0001.wav, right-click either file, 
and choose Auto-sync Audio > Based on Waveform.

8	 From the recent clips pop-up menu at the top of the viewer, choose CLIP0001.mov, 
and play it to hear the newly synchronized picture and sound.

Resolve automatically matches the waveforms of the two pieces of audio to correctly 
sync the production audio with the video clip.

TIP  If you have many clips to sync in this manner, you can select multiple audio 
and video clips, right-click one of them, and choose Auto-sync Audio > Based 
on Waveform to let Resolve work its magic and sync them all automatically.
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Syncing Manually 
The previous example worked well, but sometimes automatic operations don’t work  
as smoothly.

1	 Double-click CLIP0002.mov to open it in the viewer, and play through the clip.

Because no audio was recorded with this clip, you have no audio waveform with which 
to auto-sync the clip.

2	 In the Audio panel, click the Waveform tab to prepare to display the audio waveform 
of a selected clip.

3	 In the Media pool, select Audio0002.wav. The waveform viewer will update to show 
the audio waveform of this clip.

You will need to manually sync these two clips. To do so, you need to position the 
playheads for the video clip and the audio clip where you think the clips align.

4	 In the viewer, drag the jog bar through the clip until you see Sasha clap his hands.

5	 Press the Left and right arrow keys to position the playhead on the exact frame where 
his hands are together at 03:30:31:19.
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6	 In the Audio panel, drag the jog bar until you see the first waveform peak that indicates 
the hand clap at 03:30:31:17.

7	 Press the Left and right arrow keys to position the audio panel playhead on the audio 
peak of the hand clap.
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8	 At the bottom of the audio panel, click the Link/Unlink Audio button.

The transport controls beneath the audio window disappear; and the clips are now 
linked. Let’s make sure that the sound and picture are lined up correctly.

9	 Move the playhead to the beginning of CLIP0002.mov, and click play to verify the 
picture and sound are in sync.

While it is much easier to use Resolve’s auto sync feature to sync clips based on their 
timecodes or audio waveforms, being able to manually sync clips is also useful if the audio 
has a transient audio signal that you can visually locate in the video. That’s why most 
dual-system setups use clapperboards to help in this process.

Modifying Clip Audio Channels
The next step in your edit prep process is to ensure that the audio in the project is 
configured correctly. You can do that in the Clip attributes window.

1	 In the Media pool, click the CLIP0003.mov clip to select it.

2	 Shift-click CLIP0012.mov to also select it and all the video clips in-between.

Even though one clip doesn’t have audio, you can simultaneously modify those clips 
that do have audio in the Clip attributes window. 

TIP  Audio scrubbing is a useful feature when trying to identify a particular 
location on an audio clip. Choose Timeline > Audio Scrubbing, or press Shift-S, 
to toggle it on and off.

TIP  If you’re not entirely happy with your results, clicking the Link/Unlink  
Audio button again will unlink the clips and allow you to readjust the sync 
relationship all.
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3	 Right-click any of the selected clips, and choose Clip attributes.

In the Clip attributes window, you can configure various aspects of how clips are 
displayed, played, and heard.

4	 Click the Audio tab.

In the Audio tab, you may change the number of tracks used when editing the clip into 
the timeline, the configuration of the individual channels within those tracks and 
whether those channels are used or muted. In this case, you’re working with stereo 
clips; but because this audio was recorded in-camera, it makes sense to configure 
these as mono clips.
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5	 In the Format column pop-up menu, choose Mono to reconfigure the current audio 
track as mono, and set the Source channel to Embedded Channel 1.

6	 In the uppermost Format pop-up menu, choose Mono. Click Add to insert another 
mono track, and change its Source channel to Embedded Channel 2.

7	 Click OK to save the setting and close the window.

These clips are all now correctly configured with two tracks of mono audio.

NOTE  You can individually configure multiple tracks with different 
configurations for each clip, depending on the audio formats supplied to you 
and how clips will be used throughout the edit.
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Clip attributes encompass several useful configuration features, but you’ll want to configure 
most of them before you edit a clip into a timeline. Once clips are placed into a timeline, any 
changes you make to the clips attributes in the Media pool will affect only new edits. Existing 
edits in any timeline conform to the clip attributes in place at the time the edit was made. You 
can adjust these within the timeline by right-clicking the clip, and choosing Clip attributes.

Configuring Metadata Presets
As useful as metadata is, it can become overwhelming. Resolve has several metadata 
categories you can use to reduce metadata to a manageable subset of the whole. 
However, you can customize metadata presets to display only the information you most 
need or want to see.

1	 Choose DaVinci Resolve > Preferences, or press Cmd-, (comma) in macOS or ctrl-, 
(comma) in Windows.

2	 In the preferences window, click the User tab, and select the Metadata category  
to the left.

In the Metadata presets pane, you can create, modify, and delete custom 
metadata presets.

3	 Click the New button to create a new metadata preset, and name it my metadata 
preset. Click OK.

TIP  To remove an audio track and its configuration from any clip, move your mouse 
pointer over the track, and click the trash can icon that appears to the right.
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In the lower-half of the Metadata pane, under Metadata options, you’ll see all the 
metadata you might add to the preset.

4	 Select the checkboxes for Description, Keywords, Scene, and Shot.

5	 At the upper-right of the Metadata options, click Save to save your changes to the preset.

6	 Click Save at the bottom of the preferences window to save and close the  
preferences panel.

7	 In the Media pool, select one or more clips; and if necessary, click the Metadata  
button to open the Metadata editor to the right of the interface.

8	 Click the options menu, and choose the new “my metadata preset”. Click the sort 
menu, and choose All Groups. 

Using this preset, fields for the four selected metadata items appear in the metadata 
editor. Currently, the fields are empty for all the clips in the Media pool; you could enter 
this information manually, or if the information exists outside of DaVinci Resolve, you 
could import it.

TIP  Your preset will appear blank in the Metadata editor unless it is first set 
to show all groups or a subset that contains all the fields of your preset.
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Importing Metadata
You have many ways to populate your clips with metadata. Some may be entered on the 
camera during production, although metadata is rarely a priority for the camera operator or 
an assistant. You can enter it manually, which very few people want (or have the time) to do. 
Or, you can assign someone on set to be responsible for entering metadata in a simple 
CSV (comma-separated values) format. Many smart slate apps now store metadata such 
as shot, scene take, and more. You can then import that data into Resolve using the CSV 
format and save yourself hours of work in the cutting room.

1	 Choose File > Import Metadata to > Media pool.

2	 In the file dialog, navigate to R15 Editing 201 > Lessons > Lesson 02 Edit Prep. Select 
CC-metadata.csv, and click Open.

The Metadata Import dialog allows you to choose how you want Resolve to match the 
clips with additional metadata. In this case, you can match clips based on their file 
names and timecodes.
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3	 Deselect the “Match using clip start and end Timecode” box.

4	 Click OK to import the metadata.

The metadata is imported and added to the clips based on matching file names. 

5	 Verify the added information by clicking a few of the clips and viewing their metadata 
in the Metadata editor.

Your clips now include scene, shot, description and keyword information. This metadata 
will help as you organize and rename the clips to something more useful than the cryptic 
file names given to them by the camera.

Renaming Clips with Metadata
Clip names from a camera, or almost any capture device, are often an alphanumeric string 
that typically includes the date and time that the clip was made. They are not always the 
most descriptive names and often need to be changed for editing purposes. Entering clip 
names manually is one way to address this, but it is not the only way (or even the more 
efficient way) to rename them.

Variables are references to other metadata that exist on the clip such as scene, take, and 
shot number—so-called because variables are not the same for each clip. You can enter a 
variable into the clip name and Resolve will reference the correct information for each clip 
(provided the information is present). For example, you can use the metadata you’ve just 
entered to change the generic names of the clips in your Video clips bin to more 
descriptive names.

1	 Select the Video clips bin, and press Cmd-A (macOS) or Ctrl-A (Windows) to select all 
the video clips in the bin.

2	 Right-click any of the selected clips and choose Clip attributes.

3	 In the Clip attributes window, select the Name tab.
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4	 In the Clip name field, type a % (percentage sign).

Entering % indicates that you are about to enter a variable. When you enter that %,  
a list of variables appears.

5	 Press K to begin typing, and enter key, to see all of the variables that start with a “k”.

6	 In the pop-up menu, click Keyword to add it to the Clip name field.

7	 Press the spacebar to add a space after this variable. Type %des and choose Description.

You can combine text that you enter with preset variables to create a more descriptive 
clip name. For instance, you can type a space to separate each variable, and add the 
word “shot” before each shot number.

8	 Enter a space after the description variable, type shot, and enter another space.
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9	 Type %sh to display all the variables with an “sh,” and in the pop-up menu, choose 
Shot to add it into the Clip name field.

10	 Click OK to close the window, and apply the clip name variables.

The clip names now show a combination of the keywords, descriptions and shot 
numbers for each clip.

If you have the metadata attached to your clips, you should use it. Naming clips with 
variables can save hours of manual typing and provide clear, descriptive names that 
you can match with other documents in a production like camera logs and script notes.
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Searching with Metadata
You also can use this metadata to find clips quickly and easily. Being able to find the 
material you want or need as rapidly as possible means you can more effectively focus 
on the story and the flow of your edit.

1	 Select the Video clips bin.

2	 At the top of the Media pool, click the magnifying glass button to reveal the search field.

By default, the search criteria for the selected bin is set to search across a clip’s file name.

3	 In the “Filter by” pop-up to the right of the search field, choose All fields.

Resolve will search across all the available metadata fields.

4	 In the search bar, enter ext to display all the exterior shots that have EXT as a keyword.

5	 In the search bar, highlight ext, and enter Sasha to reveal the two shots that have 
Sasha entered into their description fields.

6	 Clear the search bar by clicking the x to the right to return to the full list of media in the 
Video clips bin.

Resolve’s powerful and responsive search feature lets you leverage the flexibility of 
metadata to easily find Media pool clips in even the largest project.
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Saving Searches using Smart Bins
You’re probably already familiar with using bins in DaVinci Resolve to store and organize 
your media. However, Smart Bins provide a clever way to automatically filter your media 
based on various rules that you define. They can be a powerful way to quickly organize 
an entire project.

1	 In the Smart Bins area of the Media pool, right-click and choose Add Smart Bin.

The Create Smart Bin window appears.

2	 Enter Interviews as the name of this Smart Bin.

3	 Click the File Name option, press K, and choose Keywords.

4	 In the field to the right of the window, type interview.

5	 Click Create Smart Bin.

This Smart Bin contains only media that has “interview” in the keywords metadata 
fields. If you were to add this keyword to any other clip, it would also automatically 
appear in this Smart Bin.

6	 Right-click in your list of Smart Bins, and choose Add Smart Bin.

7	 Name this Smart Bin B-Roll.
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8	 Choose Media pool Properties, Keywords, and “does not contain”, and in the final field, 
enter interview.

9	 Option-click (macOS) or Alt-click (Windows) the + (plus sign) button to add another 
set of criteria.

10	 Change the All pop-up on this new set of rules to Any.

11	 Click the Keywords pop-up menu , and press C to move to Clip name. Press C again 
to move to Clip Type, and choose Clip Type.

12	 In the final pop-up menu, choose “Video”.

13	 Click the + (plus sign) button, and choose “Video+Audio” in the final pop-up menu.

14	 Click Create Smart Bin to save this Smart Bin with its rules.

This Smart Bin now contains any clip without the “Interview” keyword, but only if it is a 
clip that contains just video, or a clip that contains video and audio, thereby excluding 
clip types such as timelines, compound clips, or multicam clips from finding their way 
into this Smart Bin.

Finally, you may need to create a Smart Bin for media based on a resolution, codec  
or framerate.

15	 Right-click in your Smart Bins list, and choose Add Smart Bin.

16	 Name this Smart Bin Misc Media.

17	 Change the second pop-up menu to Resolution. (You can repeatedly press R to 
cycle through the metadata that begins with the letter R.) Set the third pop-up menu 
to “is not”, and the next two fields to 1280 x 720.
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18	 Click Create Smart Bin.

This Smart Bin collects the two pieces of media in this project that have a video 
resolution other than 720p.

As you can see, coupled with the power of metadata, Resolve has some flexible and detailed 
searching functions; so, you should always be confident you’ll be able to find your media. 
One word of caution, however, is that a search is only as good as the quality of the available 
metadata. Sometimes a simple spelling mistake can thwart all of a search engine’s benefits.

Creating Power Bins
Bins and Smart Bins are great organizational tools to use within a project. The Power Bin 
is a third bin type that can assist you with organization. Unlike regular bins or Smart Bins 
which exist only within the current project, Power Bins appear in every project you create 
within a database. They are useful for storing elements you want to reuse across multiple 
projects such as graphics, titles, sound effects or music files.

1	 Choose View > Show Power Bins.

Power Bins are displayed in the Media pool above the Smart Bins.

TIP  To change the rules of any current Smart Bin, right-click the Smart Bin, 
and choose “Edit Smart Bin”.
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2	 Select the Power Bin’s Master bin, and press Shift-Cmd-N (macOS) or Shift-Ctrl-N 
(Windows) to add a new Power Bin. Name the bin Logo.

3	 Select the Graphics bin that’s currently in your project.

This bin contains a file called CC-logo.tif.

4	 Drag CC-logo.tif to the Logo Power Bin.

Because Power Bins appear in every project you create, this image file will be available 
for any project you have in your current database.

The next time you find yourself with a series of projects that share elements such as sound 
effects, graphics, or common video elements, Power Bins can be a powerful tool to save 
you time copying clips into different projects.

NOTE  Multicam, Compound Clips, Fusion Clips or Timelines cannot be placed 
in Power Bins.
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Optimizing Clips for Editing
One of the last steps you might choose to do before you begin editing in earnest is to 
consider optimizing high-resolution media. Working with camera-original content is ideal 
when color grading but it can slow you down if it over-taxes the hardware you’re working on. 
As you are trying out different shots, trimming and adjusting clips, you need a proper feel for 
the pacing of a scene and the changes you’re making. A computer that isn’t able to process 
media efficiently at its current resolution can result in a frustrating editing experience.

If you plan to edit and color grade on the same computer, Resolve includes a convenient 
method for creating lower-resolution clips while retaining a relationship with the camera 
originals. Generating optimized media enables the speed you want when editing, yet leaves 
you only one click away from the camera-original media when you need it for color grading.

1	 In the Misc Media Smart Bin, select SF Bay Sunset Shot 15.

This clip is at 4000 x 2160 resolution and uses the Apple ProRes 4444 XQ codec. It is 
considerably larger than the other clips, and may therefore slow down your computer 
as you edit. You’d be well advised to generate optimized media for this clip. Before you 
do so, however you’ll want to configure the resolution and codec to be used to create 
the optimized file.

2	 Choose File > Project settings, or press Shift-9, and choose the Master settings category.

The Optimized Media and Render Cache area of the Master settings pane includes 
options for selecting the resolution and compression codec of the optimized media.

3	 Click the Optimized Media resolution pop-up menu to view its options.

You can choose to scale down the clip by a specific percentage or allow the automatic 
setting to make the decision for you. “Choose Automatically” scales down only those 
clips that are larger than the timeline resolution. Such clips are scaled down to the 
current timeline resolution or as closely as possible to the original resolution. Clips at 
the timeline resolution or lower are not scaled.
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4	 Choose Quarter.

Using this setting will create an optimized version of this file that is 1000 x 540 resolution.

5	 In the Optimized Media format pop-up menu, choose ProRes 422 Proxy (macOS) or 
DNxHR LB (Windows).

These two compression formats are low bandwidth, so they will provide better 
performance as you edit. 

Now you can return to the Media pool and generate optimized media for the clip.

6	 Click Save to close the Project settings window.

7	 With SF Bay Sunset shot 015 still selected, right-click the clip, and choose Generate 
Optimized Media.

The creation of the optimized file begins and a progress bar indicates how long it will 
take to process the clip. Once finished, the new media is stored on your cache disk in 
the first location set in the Media storage Panel of the System Preferences.
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Identifying Optimized Media
With a simple project such as you have here, it is easy to remember which clips you have 
optimized and which you haven’t. However, in a real-world project with dozens of bins and 
hundreds of clips, you’ll need a way to quickly identify optimized clips.

1	 Select the B-Roll Smart Bin. Review the columns of the Video clips bin, and locate the 
resolution and codec columns.

For this optimized clip, the columns still display the camera-original resolution and 
codec. Remember, the optimized media did not replace the camera-original files.  
They still exist on your hard drive and are linked to these clips. So, Resolve continues 
to display the camera-original parameters.

2	 Right-click any column heading in the bin, and in the list of column options, choose 
Optimized Media.

The Optimized Media column displays None in the columns of clips that have no 
optimized media, whereas it displays the optimized resolution for clips that have  
been optimized. 

TIP  To delete optimized media for an entire project, choose Playback > Delete 
Optimized Media.
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3	 Double click the SF Bay Sunset shot 015 clip to load it into the viewer.

You can easily switch between the optimized media and the original files in the 
playback menu. 

4	 Place the playhead near the middle of this clip so you can see a silhouetted profile  
of the cyclist.

5	 Use your mouse scroll wheel to zoom in on the image to around 300%, or in the upper-
left corner of the viewer, click the magnification pop-up menu, and choose 300%.

6	 Hold down your middle mouse button and drag to reposition the image in the viewer 
until you can see the edge of the cyclist’s silhouette against the brighter background.
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7	 Choose Playback > Use Optimized Media If Available to deselect the option.
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You should notice the compression artefacts disappear around the edges of the cyclist 
when you switch between the optimized media and the original clip. Let’s switch back 
to observe how the clip appears less sharp. 

8	 Choose Playback > Use Optimized Media If Available.

9	 In the magnification pop-up menu, choose Fit to return to viewing the entire frame in 
the viewer.

DaVinci Resolve displays one of the two files based on the menu choice. Choosing 
Optimized Media will help you work faster during the edit because Resolve won’t have to 
process the full image resolution, but you can quickly and freely switch to the high-
resolution image for grading or other purposes. 

Each project starts with a phase of importing and organizing footage. The features covered 
in this lesson highlight how DaVinci Resolve can benefit your post-production workflow 
before you even step into the cutting room.

Now you’ve seen some of the organizational aspects of working with Resolve, let’s look 
at some of the more advanced techniques you can employ during editing. 

Lesson Review
1	 When using the clone tool, what is the default checksum type?

A) None

B) SHA 512

C) MD5

2	 True or False? You can save a preset of your current project settings for future 
project configuration.

3	 What methods can you use to auto sync sound to video files in the Media page?

A) Waveform

B) Timecode

C) Markers

4	 Which type of bin can you access across different projects in the same database?

A) Smart Bins

B) Super Bins

C) Power Bins

5	 True or False? Optimized media replaces your original media files.
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Answers
1	 C. MD5. 

2	 True. Project presets are saved in the Presets panel of the Project settings.

3	 A. Waveform, and b. Timecode.

4	 C. Power Bins.

5	 False. Optimized Media is generated and stored in the first location set in the Media 
storage panel in DaVinci Resolve > Preferences, and is used when Playback > Use 
Optimized Media if Available is enabled.



Lesson 3

Cutting a Dialogue 
Scene

Editing a dialogue scene is often done by 
establishing the location and cutting between 
shots as they would play out in real time. 
Commonly known as continuity editing, this 
technique is centered around cutting 
between two (or more) shots, alternating 
back-and-forth to each character as their 
dialogue and reactions warrant. In this lesson, 
you’ll apply this continuity technique to a 
scripted scene. You’ll start with one of the 
most firmly established conventions in 
cinema—the shot/reverse-shot—and see how 
DaVinci Resolve 15’s editing, match framing, 
and trimming tools can speed up this classic 
editing style.

Time

This lesson takes approximately 
60 minutes to complete.
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86

S
el

ec
ti

n
g

 y
o

u
r 

B
es

t 
Ta

ke
s

Selecting your Best Takes
Editing is a series of choices. Your first choice is often to sort through the daily collection  
of clips and single out the best takes. After that, you can start to block out the scene.

Watching each take and choosing those parts that feature the best performances is often 
the most time-consuming part of your entire editing process, but it is also a critical step in 
becoming familiar with the available content available and identifying which shots might and 
might not work. In Resolve, creating subclips is one way to help identify the best selections, 
or selects, within each clip. A subclip is a totally new instance of a clip that you create from a 
selection within a longer clip. By creating subclips of your content, you can avoid repeatedly 
sifting through long clips looking for a particular bit you remember. If you make subclips 
while locating the good bits within clips, you’ll instantly be able to find them again.

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 03 Dialogue, and select R15 Editing Lesson 03 Dialogue.drp. Click 
Open, and click OK to import the project into your Project manager.

2	 Open the project, and relink media files.

3	 On the Edit page, in the Media pool bin list, select the “Dailies day 02” bin. 

4	 Drag all three clips in this bin into the source viewer.

By dragging these clips into the source viewer at the same time, you can access 
them using the recent clips pop-up menu at the top of the viewer. Doing so provides 
an easy way to switch between the last 10 clips you loaded in the source viewer 
without searching for them in the Media pool.

NOTE  When working in Resolve, you often have a choice of many routes to the 
same result. The workflows described in this book have proven to be creative, 
efficient, and flexible for each task. They also emulate workflows that many editors 
use on a regular basis. Ultimately, however, your preferred workflows will emerge 
from your own methods and experiences.
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5	 If it’s not already open in the viewer, select 02_Dr_Sarah Close Up_.mov in the 
recent clips pop-up menu to load it into the source viewer.

This clip starts with a clapper and takes a good 20 seconds to get going. Instead of 
watching or scrubbing through the unusable range each time you return to this clip,  
you can make new subclips based on in and out points that you set.
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6	 Scrub through the clip until just before the woman enters from the left at around 
01:00:35:00.

7	 Play the take until she turns her head toward the camera and stop playback.

The director has decided that the bald male actor is not making the cut, but you 
can still use the remaining portion of the take. 

8	 In the source viewer, type 46. (period) on the keypad, and press Enter to move 
the playhead to 01:00:46:00. 
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This location is far enough into the clip to cut out most of the bald actor and makes 
for a good starting point for your subclip.

9	 Press I to mark an in point that identifies the start of your subclip. 

10	 Play the clip until you hear the director yell, “Cut” at around 01:01:10:00, and mark 
an out point.

11	 To make a subclip based on these in and out points, choose Mark > Create SubClip, 
or press Option-B (macOS) or Alt-B (Windows).

In the Media pool, in list view, look at the contents of the Dailies day 02 bin. You can 
see that a new clip is underneath its parent clip. Notice that the word “subclip” is 
appended to the file name. You might find it useful to keep these subclips in a separate 
bin so you don’t confuse them with the original source clips.

12	 Choose File > New Bin, or press Shift-Cmd-N (macOS) or Shift-Ctrl-N (Windows) to 
create a new bin. Name this bin Subclips.
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13	 Select the Dailies day 02 bin. Drag the 02_DrSarah_Close_Up_.mov subclip to 
the Subclips bin, and select the Subclips bin to see its contents.

14	 In the source viewer recent clips pop-up menu, choose 03_DrSarah_Wide_Take 1_.mov 
to open it in the source viewer.

15	 Play the clip from the beginning and mark an in point when the bald actor begins 
to walk away at around 01:02:55:00.

16	 Press L twice to fast forward to the end of the clip where the director yells, “Cut” 
at around 01:03:50:00, and mark an out point.

17	 Press Option-B (macOS) or Alt-B (Windows) to create another subclip in your currently 
selected Subclips bin.

18	 In the source viewer recent clips pop-up menu, choose 04_Wide_DrSarah_Take 2_.mov.
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19	 Again, because this is a second take of the wide shot, play the clip from the beginning, 
and mark an in point when the bald actor begins to walk away.

20	 Press L twice to fast forward to the end of the clip where the director yells, “Cut,” and 
mark an out point.

21	 This time, drag the marked clip from the source viewer back into the Subclips bin in 
the Media pool.

The new subclip is added to the bin.

Although a subclip is totally independent of its source clip, it does differ from placing a 
duration marker to identify a portion of a clip, which is a technique you may already be 
familiar with. Unlike ranges identified by duration markers, you can organize subclips 
into their own bins, load them into the source viewer, add metadata, and edit them into 
the timeline using any of the editing functions in Resolve. In effect, you’re treating them 
exactly like any other source clip.

However, remember that when you edit using a duration marker to identify a portion of 
a source clip, you still have handles available on either side of the marker after it is 
placed in the timeline. By default, a subclip has no handles beyond the initial in and out 
points you used to create it.

TIP  You can convert existing in and out points into duration markers by 
choosing Mark > Convert In and Out to Duration Marker, or convert existing 
duration markers to in and out points by choosing Mark > Convert Duration 
Marker to In and Out.
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Modifying Subclips
To simulate handles in a subclip, it’s useful to set your initial in and out points a little before 
and after the portion you want to subclip, thereby leaving a little bit of wiggle room when 
you later trim the clips.

However, when you find that you need a few extra frames extra not included in your 
subclip, you can always extend the boundaries of that subclip.

1	 Double-click the 04_Wide_DrSarah_Take 2_.mov Subclip to load it into the source 
viewer and see the full extent of the subclip you created in the previous steps.

2	 In the Media pool, right-click the 04_Wide_DrSarah_Take2_.mov Subclip, and choose 
Edit Subclip.

In the dialog that appears, you can adjust the subclip’s start and end values or remove 
the limits of the subclip entirely.

3	 Change the New Subclip Start time to 10 seconds earlier and click Update. 

The source viewer updates the positions of the in and out points to reflect this change, 
and the bald-headed man is once more included in this subclip.

Editing with Continuity
One method to use when cutting dialogue is to first identify which take is the master shot,  
a clip that represents a complete good take in terms of dialogue and action. Ideally, this clip 
can form the backbone of the scene. You can then replace part of that master shot with 
close-ups and reaction shots that build both time and space continuity.

In the following exercise, a quick master shot timeline was created for you.

TIP  When you don’t have one shot that works as a master shot, you can assemble 
a very rough cut that effectively blocks out the scene and represents a clear idea 
of the target.
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1	 In the timelines bin, double-click the “Party’s over edit” timeline to open it in the 
timeline viewer.

This timeline will act as the master shot for this scene. Let’s play it to see how the scene 
should unfold. 

2	 Play the timeline from start to end.

This master shot focuses on the FBI agents, so it is up to you to add reverse angle 
shots of the doctor. Some editors call the next step “removing the air;” but, more 
precisely, it consists of eliminating unnatural intonations or pauses in the dialogue 
when you cut between reverse angles.

3	 In the “Party’s over edit” timeline, navigate to the cut point between the first two clips, 
and mark an in point.

4	 Play the clip until the FBI agent says the doctor’s name, and you hear her off-screen 
response, “Yeah?” Mark an out point just before the agent speaks again, around 
01:00:11:20.

5	 In the Subclips bin, double-click 02_DrSarah_Close Up_.mov Subclip to open it in the 
source viewer.

Let’s start by marking an out point because it will be easier to locate.
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6	 Play the clip until the doctor turns her head, and mark an out point just after she says, 
“Ah yes?”

You need just a bit of this clip to show the party scene and introduce the lead  
female character.

7	 In the source viewer, type -3. (minus sign, 3,period), and press Enter to move the 
playhead back three seconds.

Because this dialog is just incidental chit-chat before the doctor turns, you can place 
an in point here.

8	 Press I to mark an in point.

Unfortunately, you have a slight timing problem here: all four marked points are well 
placed, but the resulting durations of your two selections differ. You can preview the 
edit using the preview marks.

9	 Choose View > Show Preview Marks.
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The preview marks display a virtual outpoint in the timeline ruler to indicate where 
the source clip’s out point will land. 

10	 Press F10, or click the Overwrite Clip button above the timeline.

Performing an overwrite edit limits the edit based on the shorter source clip and leaves 
a long pause as the FBI agent walks into frame. If you were to proceed with this edit, 
you would have to trim the pause to correct for the continuity of the scene.

11	 Choose Edit > Undo, or press Cmd-Z (macOS) or Ctrl-Z (PC)

Fortunately, Resolve has a unique edit called ripple overwrite that will overwrite the 
source clip and appropriately trim the timeline with just one click. The ripple overwrite 
replaces a selection in the timeline with a clip of a different length and does so without 
opening a gap or overwriting the adjacent clip .

12	 Choose Edit > Ripple Overwrite or press Shift-F10 to perform the ripple overwrite edit.
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In the timeline, play over the edit to verify that you have successfully overwritten the 
unwanted part of the clip with a shot that introduces the doctor. This time, the frames 
between the preview mark and the timeline’s out point were automatically removed by  
the ripple overwrite edit.

You’ve just used a continuity editing style by alternating shots between the doctor and the  
FBI agents. These shot/reverse shot sequences create a sense of space by matching the 
characters’ eyelines along the axis of action (that is, the 180-degree line). The FBI agents are 
looking to the left at the doctor, and in her shot, the doctor is looking to the right at the agents.

Match Frame with an Offset
Let’s try another example of continuity editing by cutting in another reaction shot of the 
doctor. This time you’ll use Resolve’s match frame feature to keep the source clip and 
timeline in sync, making it easier to cut in reverse angles.

1	 In the timeline, position the playhead at the end of 02_DrSarah_Close Up_.mov Subclip.

2	 Play the timeline for roughly 10 seconds until you hear the off-screen doctor, say, 
“I’ll catch up with you later.”

You need a reaction from the doctor to indicate that the FBI is showing up at her party, 
and you want to end the reaction shot in time to cut back to the FBI agents to get their 
impatient reactions. 

3	 Position the timeline playhead after the FBI agent says, “We need you to come with us right 
away” and before the doctor says, “Umm.”, roughly three to four seconds from the last cut.

4	 Press I to mark an in point in the timeline.

At this point you can turn your attention to the source clip that you want to cut in. 
Because the dialogue is the same on both the doctor’s close-up in the source viewer 
and the FBI agent’s shot in the timeline, you want to pick up the source clip dialogue in 
a spot that roughly matches your timeline playhead location. Resolve has a very nice 
match frame feature to do just that.
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5	 Without moving the timeline playhead, in the timeline, Option-double-click (macOS) or 
Alt-double-click (Windows) anywhere on the previous 02_DrSarah_Close Up_.mov 
Subclip.

The 02_DrSarah_Close Up_.mov Subclip is loaded in the viewer with the previously 
marked in and out points used to edit the clip into the timeline. 

The playhead in the source viewer is offset from the out point by the same three to four 
seconds that you moved the timeline playhead. This is where the doctor starts to react 
to the FBI and her assistant stops speaking. It’s a good place for your in point.

6	 Press I to mark an in point in the source viewer. 

Let’s place the out point after the friend asks if the doctor is OK, and the doctor turns away.

7	 Play the clip in the source viewer, and mark an out point just after the doctor turns her 
head, but before she says, “Yeah, yeah,” at around 01:01:02:20. 
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This time, a preview mark appears in the timeline showing us the implied outpoint. 

8	 Play forward in the timeline, and set an out point just after the doctor’s assistant asks, 
“Is everything ok, Sarah?” but before the doctor starts to reply.

9	 Press Shift-F10 to perform a ripple overwrite edit. 

Now you have placed your shot/reverse shots to move this dialogue scene forward. 
Let’s review the edits.

10	 Press the Home key, and play the timeline to review your edits. 

This type of shot/reverse shot juxtaposition is the most common technique used to initially 
block out your scene. That’s why the ability to keep the same offsets between source and 
timeline using the modified match frame feature is a major time saver.
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Going Beyond the Straight Cut 
A straight cut, with which audio and video start and end simultaneously, can be quite 
abrupt and a little jarring. A split edit, often referred to as either an L-cut or J-cut because  
of the implied shape it creates in the edit, delays either the audio or video cut of a clip. 
Staggering the cuts this way can create a more natural transition between shots.

The most common split edit is the J-cut, in which you first introduce the sound of the next 
shot and then cut to the picture a beat or two later. This is the way that most of us perceive 
the world around us; for example, when you hear a car horn in the street, you will look for 
the source of that sound a fraction of a second later. An L-cut leads with the image and 
then cuts in the audio, often used when you want to show a character’s reaction to 
something happening or being said.

In Resolve, you have multiple ways you can create J- and L-cuts. Let’s look at a J-cut split 
edit in which the upcoming clip audio is heard first, and the picture edit is slightly delayed.

Extending Edits 
A common way to create a split edit is to trim either the video or audio part of the clip after 
a straight cut was made in the timeline. Let’s cut in another shot using a simple straight cut, 
and then adjust the video of that clip to create the J-cut.

1	 In the timeline, position the playhead at the end of the last 02_DrSarah_Close Up_.mov 
Subclip that you just edited into the timeline

2	 Play the timeline for roughly 10 seconds until you hear the off-screen doctor say, 
“So are you going to tell me what this is about?”

L-cutJ-cut
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You want the audience to see the impatient reaction of the FBI agents and then hear 
her line. Because you don’t have this line in the close-up shot, you’ll need to switch to 
one of the wide shots.

3	 In the Subclips bin, double-click 04_Wide_DrSarah_Take 2_.mov Subclip to load it 
into the source viewer.

4	 Play from the start of the clip until you hear the doctor say, “So, are you going to tell 
me what this is about,” at around 01:05:42:00.

That’s the line you want to use in your timeline. 

5	 Position the source viewer around 01:05:42:12, and mark an in point just as the doctor 
begins turning toward the camera. 

6	 Play the clip until the doctor finishes her line, “Are you going to tell me what this is 
about?” Add an out point before the agent replies with “We need your help.”
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7	 In the timeline, set an in point where the doctor has turned to face the FBI agents, 
just before she says, “So are you going to tell me what this is all about?”

At this point in the timeline, you may notice that the preview mark for the source out 
point indicates that the delivery of this line in the 04_Wide_DrSarah_Take 2_.mov 
Subclip is just a tiny bit longer than the current take in the timeline. 

8	 In the timeline, play forward and set an out point after the doctor says, “So are you going 
to tell me what this is all about?” but before the FBI agent says, “We need your help”.

9	 Press Shift-F10 to perform a ripple overwrite edit. 

OK, so that fixed the timing of your new take. Now you need to split the edit.
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10	 In the timeline, Option-click (macOS) or Alt-click (Windows) the video edit between 
04_Wide_ Dr Sarah_ Take 2_.mov Subclip and 05_Wide_ Agents_ Take 1_.mov.

11	 Play forward until the FBI Agent has said, “We need your help.”

12	 Choose Trim > Extend edit, or press E. 

The extend edit moves the selected edit point to the position of your playhead in the 
timeline, in this case performing an instant rolling trim.

Review your new split edit.

That edit now feels very natural in that you see the doctor react to the FBI agent’s 
demand, while the FBI agent’s line of dialogue motivates the picture cut a second or so 
later. This is a powerful editing technique that is used all the time not just in dialogue 
scenes such as this, but in editing across all genres.
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Marking Split Edits 
A more sophisticated way to create a split edit is to actually mark the split in and out points 
on either the source viewer or timeline. Let’s cut in the next shot using this technique.

1	 Play the timeline until you hear the doctor say, “My help? You’ll have to do better  
than that.”

This is where your next shot will be cut in. Again, you’ll use the reverse wide shot of  
the doctor.

2	 In the timeline, position the playhead before the doctor says, “My help?,” and mark 
an in point.

3	 In the source viewer, play 04_Wide_ Dr Sarah_ Take 2_.mov Subclip, and mark an 
in point at the start of the doctor’s line “My help?” at around 01:05:46:00.

This is where you want the audio to start, but you don’t want the video to cut just yet.

4	 Play forward in the source viewer, and stop playback just before the doctor delivers her 
next line, “You’ll have to do better than that,” at around 01:05:47:00.

5	 Under the source viewer, right click anywhere along the jog bar, and choose Mark Split 
> Mark Video In, or press Shift-Opt-I (macOS) or Shift-Alt-I (Windows).

The jog bar splits into two lines. The green line indicates the in point for the audio 
and the blue line shows the different in point for the video. Of course, you still need 
to place an out point.

6	 Play forwards in the source viewer until the doctor finishes her line. Set a regular out 
point after she says, “You’ll have to do better than that.”

TIP  You can use the same method to mark split edits directly in the timeline 
or timeline viewer.
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7	 Press F10 to perform an overwrite split edit and play over the new cut to review it.

Congratulations! You have just learned two different methods for adding split edits and 
created two effective J-Cuts to enhance the flow of this scene. In the next exercise, 
you’ll learn some other techniques for trimming in real-time.

Trimming On-the-fly 
The extend edit is a powerful feature that works with ripple trims as well as rolling trims. 
In fact, it works well anywhere you want to quickly trim to the playhead. Let’s explore this 
by working on the end of the cut you just made. This time, however, you’ll perform an 
extend edit on-the-fly. By just listening to the cut and trimming in real-time as the edit plays, 
you can get a better feel for the trim. You will hear and see how the edit works in real-time 
instead of just looking at incremental frame updates and hearing audio scrubbing.

1	 In the toolbar, click the trim mode button, or press T.

2	 Select the head of the last video and audio cut for the 05_Wide_Agents_Take 1_ clip.

3	 Under the timeline viewer, click the loop button.

With loop play activated, Resolve will continuously play whatever playback option you 
choose. To loop play over the trim point, let’s play the selection.



105

G
o

in
g

 B
ey

o
n

d
 t

h
e 

S
tr

ai
g

h
t 

C
u

t 

4	 To review the edit, press / (slash) to loop play the selection.

A long gap is present between the doctor’s last line and the FBI agent’s response. 
Let’s trim that gap on-the-fly.

5	 After the doctor speaks her line, but before the FBI agent says, “OK we don’t have 
a lot of time,” press the E key to mark a new cut point to remove some of the silence 
between the two lines. (Use the waveforms of the audio on the first track as a guide.)

6	 Let the selection loop play a few times, and modify the edit by pressing either , (comma) 
to add a single frame to the head or . (period) to remove a single frame from the head.

7	 When you feel the edit is right, press spacebar to stop playback.

The rhythmic beats of your audio and the associated sound edits contribute 
significantly to the pacing and mood of a scene. Trimming on-the-fly is one way to 
realize the most natural and organic feel with that rhythm.

Let’s continue practicing trimming on-the-fly with another cut. You’ll bring the video cut 
back a bit to see a little more of the FBI agent’s reaction. You’ll make the selection in 
the timeline using keyboard shortcuts.

8	 Press Opt-U (macOS) or Alt-U (Windows) to deselect the audio track and make the 
selection video-only.

9	 Press U twice to cycle the selection until both side of the cut are selected, as indicated 
by the green highlight.
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10	 To loop the edit, press / (slash) to play.

11	 As the doctor finishes her line and the FBI agent steps back in toward her, press the 
E key to roll the edit back a second or so to create an L-cut.

12	 Let the selection loop a few more times, and modify the edit by pressing either , 
(comma) to roll the edit back one frame or . (period) to roll it forward one frame. 

13	 Press the spacebar when you have finished perfecting your edit.

14	 In the toolbar, select the selection tool, or press A.

By this point, you should be well aware that J- and L-cuts are all about keeping the edit 
flowing seamlessly. Offsetting the audio or video cuts from each other even slightly allows 
you to keep the dialogue moving forward while giving the audience a peek at the reaction 
of other characters helping the whole edit knit together better. 

To finish this scene off, you have one more reaction shot of the doctor to add. Using any of 
the techniques you’ve learned so far, add the shot of the doctor delivering the line, “You 
mean like a virus? That wouldn’t be possible,” in the 04_Wide_DrSarah_Take 2_.mov 
subclip. Don’t forget to use split edits to show her reaction to the news the FBI agent gives 
her! You may also want to revisit the other edits you previously made in this scene. 
Assuming the pacing of the dialogue works, can any of the cuts be improved by splitting 
the video edits?

Auditioning Multiple Takes
When cutting dialogue, you can easily fall into the trap of cutting based solely on words. 
But dialogue editing is trickier than that because you not only have to pay attention to the 
words, but also the eyes, the mouths, and the body language of the performers. All these 
performance elements are essential to establishing the emotion of a scene. So, even 
though your cut may maintain dialogue continuity, you might want to search out alternate 
takes that feature superior performance elements. 

Comparing different takes often means repetitively revising your timeline. DaVinci Resolve 
makes this process a lot easier with the Take Selector.

1	 In the timeline, position the playhead at the second shot in your timeline,  
02_Dr_Sarah_CloseUp.mov Subclip.

The director feels this shot doesn’t effectively introduce the party and wonders how 
the wide shot might look in its place. 

2	 In the Subclips bin, double-click 03_DrSarah_Wide_Take 1_mov Subclip to open it 
in the source viewer. 

3	 Play the first half of the subclip to review it and refamiliarize yourself with the take.

4	 Mark an in point just before the FBI agent walks into shot, around 01:02:59:00.

5	 Mark an out point when the Doctor turns and says, “Yeah,” around 01:03:03:00.
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To audition this take in the timeline without actually replacing the current close-up shot, 
you can use Resolve’s take selector.

6	 In the timeline, right-click 02_Dr_Sarah_close up, and choose Take Selector.

The take selector acts like a container for multiple clips. While only one of those clips 
is seen when you play the timeline, you can switch between the clips at any time.

7	 From the source viewer, drag the 03_Dr Sarah_Wide_Take 1_Subclip onto the take 
selector clip in the timeline.

TIP  The rest of the timeline is inactive when the take selector is in use. 
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The take selector now shows the two clips stacked on top of each other. 

You can add as many takes as you want to audition.

8	 In the Subclips bin, double-click 04_DrSarah_Wide_Take 2_.mov Subclip to open it 
in the source viewer. 

9	 Mark an in point in roughly the same part of the shot as the previous take, just before the 
FBI agent walks into shot; and mark an out point when the doctor turns and says, “Yeah?”

10	 From the source viewer, drag 04_DrSarah_Wide_Take 2_.mov Subclip onto the take 
selector clip in the timeline.

TIP  You can also drag the clip from its bin in the Media pool directly into the 
take selector.
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Now all three takes are visible in the take selector. The initial clip is still the active take, 
but you can change that by clicking the clip you want to view in the timeline.

11	 In the take selector, click the middle clip in the stack to view it in the timeline.

12	 Press the / (slash) key to play over the new take.

The new clip conforms to the duration of the original clip in the timeline. However, 
you can see in the take selector stack that the new take is longer than the original clip. 
When you select a take that is shorter or longer than the original clip, you can ripple 
the timeline to adjust to the new take’s length.

13	 In the upper-right corner of the take selector, click the ripple button.

The timeline now adjusts to fit the longer take.

14	 Move the playhead to the start of the clip and click play to review the rippled timeline.

15	 In the take selector, click the upper clip to view it in the timeline.

16	 Move the playhead to the start of clip, and play to review this take.

The director believes the middle wide-angle take introduces the party scene the best, 
so you’ll make the new take a permanent part of the timeline.

17	 In the take selector, click the middle clip to choose that take.

18	 In the upper-left corner of the take selector, click the close button to collapse the 
take selector stack.

19	 Right-click the clip and choose Finalize Take.

TIP  The currently selected take in the take selector is actually the clip with 
the dullest brightness, thereby matching the other clips in the timeline.
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While this lesson has been about editing dialogue, its underlying theme is continuity. 
Continuity editing involves matching screen direction, position, and temporal relations from 
shot to shot. Using the two-up display while trimming, trimming on-the-fly, applying ripple 
overwrite editing, and using the take selector are just a few of the many Resolve features 
that support this single most important principle of editing.

TIP  You don’t have to finalize the take. You can leave the alternate takes within 
the take selector to review again later, if you choose. To reopen the take selector 
stack, double-click the take selector icon in the lower-left corner of the clip in 
the timeline. 
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Lesson Review
1	 What methods can you use to create a subclip from a marked duration of a clip in 

the Edit page?

A) Drag the clip from the source viewer to the Media pool

B) Press Option-B (macOS) or Alt-B (Windows)

C) Click the Source Viewer Options menu, and choose Make Subclip

2	 What do the preview marks on the timeline indicate?

A) They show where you can add Markers

B) They help you determine where clips will be placed when making a three-point edits

C) They show you where your text and graphics will align on the Timeline Viewer

3	 True or False? Ripple Overwrite is a three-point edit.

4	 How can you change the pre-roll and post-roll times when playing around a selection 
in the timeline?

A) Pre-roll and post-roll times cannot be changed.

B) In DaVinci Resolve User Preferences

C) In the General Options of the Project settings

5	 True or False? All clips in the take selector should all have the same duration.
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Answers
1	 A. and B. You can create subclips by choosing Mark > Create Subclip, and right-clicking 

the Source Viewer jog bar; then choose Create Subclip, press Option-B (macOS) or 
Alt-B (Windows), or drag the subclip from the source viewer into the Media pool.

2	 B. Preview marks help you determine where clips will be placed whenever you execute 
a three-point edit.

3	 False. Ripple Overwrite is a four-point edit that you use when the duration of the 
marked source clip is different from the duration marked in the timeline, and when 
you want the timeline to ripple to accommodate the difference in duration.

4	 B. You adjust pre-roll and post-roll times are adjusted in the Editing panel of the 
DaVinci Resolve User Preferences.

5	 False. The take selector can contain clips of different durations. When switching 
between these clips, you can enable the ripple take button in the upper-right corner  
(to the left of the trash can button).



Lesson 4

Making A Radio Edit

Editing interviews is a great skill to master. 
Being able to finesse an interview to get the 
very best out of your interview subject takes 
a lot of practice and a good ear for the 
spoken word.

When cutting interviews, whether for a 
documentary or a web promo, it’s common  
to create the first cut to produce the best-
sounding interview and almost completely 
disregard the visuals until that first rough cut 
is done. This cut is called a radio edit 
because it is similar to editing an audio-only 
interview. Once you have the interview audio 
cut properly, you can turn your attention to 
the video edits, often referred to as the paint 
because you are illustrating, or “painting”, 
your interview with appropriate pictures from 
your b-roll rushes.

In this lesson, you’ll use advanced audio  
and video trimming and other workflow 
features in DaVinci Resolve 15 to finish an 
engaging one-minute promotional piece  
for a vegan restaurant.

Time

This lesson takes approximately 
50 minutes to complete.

Goals

Examining Audio in a Radio Edit	 114

Editing Subframe Audio	 124

Creating Variable Speed Changes	 126

Using Smooth Cut	 130

Working with Advanced  
Transition Tools	 131

Lesson Review	 137
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Examining Audio in a Radio Edit
Let’s begin by opening a project with most of the radio edit already cut, but including some 
clips in which the audio hasn’t been examined for clarity. You’ll play the clips, and then 
begin to identify and remove the small stutters and stray “umms” to get the best statement 
from your interview subject.

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 04 Radio Edit. Select R15 Editing Lesson 04 RadioEdit.drp, choose 
Open, and click OK to import the project into your project manager.

2	 Open the project, and relink media files.

3	 In the Media pool, select the timelines bin, and double-click the “01 Radio Edit start” 
timeline to open it in the timeline window.

The first part of this interview with Miss Rachel, chef at the vegan restaurant, has 
already been cut for you.

4	 Play the timeline to hear the one-minute interview.

Notice how the interview is edited so it sounds clean, without many distracting pauses, 
stutters, or poorly chosen words. Check out the rushes from the Interview Clips bin to 
get a sense of how this edit was pieced together from the original clips. You will also 
notice a couple of small gaps that were left intentionally to add short pauses between 
thoughts or subjects and to allow the interviewee (and the audience) to take a breath. 
However, one area in this timeline still needs your attention.

5	 In the timeline, go to the start of the first orange clip, around 01:00:45:00.
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6	 Mute Audio 2 and play the three orange clips to hear their audio content.

With the music track muted, it’s easier to focus on the interview audio.

When creating a radio edit, you want to remove any large or small bits of audio that 
may detract from the message. These three clips, include a number of places where 
her words could be tightened to improve her conversational flow. You’ll be looking at 
different techniques you can use to remove parts of this interview. As always, you’ll 
need to consider which techniques work best for you.

7	 Play the first orange clip again and stop playback when you hear the first time that the 
interview subject says, “Umm,” around two seconds from the beginning of this clip.

8	 Using the Timeline View Options menu, expand the size of the audio track so you can 
clearly see the waveform. You may also want to zoom into the location of the playhead 
by pressing Cmd-= (equals sign) in macOS or Ctrl-= (equals sign) in Windows a couple 
of times. Now you should be able to clearly identify the problematic “Umm.”
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9	 Press the B key to switch to razor edit mode. Click just before the waveform 
representing the “Umm” and just before she says, “We’re taking…”

Doing so has isolated the “Umm” into a separate clip. The dotted lines on the edit 
points represent through edits; that is, edits that are visible on the timeline but 
playback smoothly because no frames have been removed from either side of the cut. 
The edits were also added to both the audio and video parts of the clip because the 
timeline-linked selection was active.

TIP  To remove an unwanted through edit, in the timeline, place your playhead 
after the through edit, and choose Timeline > Join Clips, or press Option-\ 
(backslash) in macOS or Alt-\ (backslash) in Windows. 
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10	 Return to Selection mode by pressing A. Select the “Umm” clip, and press Shift-Delete 
(or backspace) to perform a ripple delete.

11	 With your playhead over the new edit point, press / (slash) to play the edit.

You’re aiming to have this audio edit be as inconspicuous as possible. When you play 
around the current edit, try listening to the cut without watching the picture. Does it 
sound as if an edit is there? If it does, you’ll need to do a little finessing, which you’ll  
be looking at soon.

Continue playing what is now the second orange interview clip until you hear the next 
problem where she says, “We’re taking dishes and flavors.” She stutters and says the 
word “and” twice. It’s a simple task to tidy this up.

12	 Press the JKL keys to play forward and backward over the clip, finally positioning the 
playhead just before the first “and”.

13	 Press Shift-V to select the clip under the playhead.

14	 Press Cmd-B (macOS) or Ctrl-B (Windows) to add a through edit to the selected clips.

TIP  When you perform an edit, you can’t know how successful it’s going to 
beuntil you playback your timeline. It’s highly doubtful if things are perfect 
straightaway (though happy editing accidents have been known to occur). 
In reality, most edits you’ll perform will always need to be improved with a few 
trims here and there.

TIP  Remember that you can jog the playhead back and forth by holding down 
the K key and tapping the L or J key. It’s also useful to have audio scrubbing 
turned on so you can hear the starts or ends of words. Choose Timeline > 
Audio Scrubbing, or press Shift-S, to toggle audio scrubbing on and off.
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15	 Jog forward until the playhead is located before she says the second “and.” 
Press Cmd-B (macOS) or Ctrl-B (Windows) again to add a second through edit.

16	 Move your playhead over the isolated “and” in the timeline. Press Shift-V to ensure that 
the clip is selected, and press Shift-Delete (or backspace) to ripple delete the clip.

17	 Press / (slash) to play around the new edit.

Again, try listening to the edit without looking at the jump cut you’ve just created. 
Remember, you’re trying to create a natural-sounding interview that won’t distract 
the audience. Don’t worry if the current edit is not as smooth as you would like; 
you’ll finesse it soon.

Keep playing through the interview. The next portion you’re going to remove is the 
“Umm” just after she says “textures.” This time you’re going to place timeline in and  
out points to remove this unwanted portion of the interview.

TIP  Pressing this keyboard shortcut adds an edit point to a selected clip or 
clips at the playhead position. It’s a little more precise than clicking to add a 
cut in razor edit mode.
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18	 In the timeline, place your playhead at the start of the “Umm,” and press I to add an  
in point.

19	 Jog the playhead forward six or seven frames until you hear her start to say, “and really 
making them.” Press O to set an out point just before she says, “and.”

You’ve now set in and out points around the portion of the interview you want to 
remove. But notice that the highlighted portion of the timeline also includes the music 
on Audio 2, even though this track is muted.

20	 In Audio 2, click the Auto Select button to disable the function, or press Command-
Option-F2 (macOS) or Control-Alt-F2 (Windows).

TIP  Because Resolve’s playhead is inclusive of the current frame, in points are 
always added to the head of the frame and out points are added to the tail of 
the frame. When adding out points, it’s often useful to find the frame you want 
to keep (usually at the start of the next word) and then move the playhead one 
frame back before adding the out point. By doing so, you’ll be sure to keep the 
frame you wanted.
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By turning off the auto-select control for Audio 2, you’ll notice that the highlighted 
section no longer covers the music clip, so it will not be included in the next step. 

21	 Press Shift-Delete (or backspace) to ripple delete the contents between the in and 
out points in the timeline, and on tracks with auto select enabled.

22	 Press / (slash) to preview your new edit.

For a little extra credit, the director has also asked if you could tidy up the end of the 
orange clip; she doesn’t like the interviewee’s use of the word “palatable” to describe 
the food. This is a slightly more subjective cut; but when trying to put together the best 
description of the food at the restaurant, it may be desirable to aim higher than simply 
“palatable.” Do you think you’d be able to edit out the words “palatable and” so that 
she simply says, “making them delicious”?

Trimming using Keyboard Shortcuts
Resolve 15 has very complete roll, ripple, slip, and slide trim commands that you can 
perform using the mouse. However, when you’re making small, subtle changes to an edit - 
often adding or removing single frames - it’s useful to perform most of your trimming using 
keyboard commands. In doing so, you’ll exercise the most precise control over each of 
your edits. Learning how to get the best from Resolve’s trimming options is an important 
step in choosing the best technique for any given situation. 

In the next exercise you’ll exclusively use keyboard shortcuts to move and select the cut 
points you need to trim.

1	 Position the playhead at the start of the orange clips.

2	 Press the down arrow to go to the first cut in that clip.

3	 Press / (slash) to preview the edit.

Listen closely to the audio edit you created in the previous steps. Does it sound like  
a natural, continual part of her speech pattern? Identifying how to adjust the edit 
effectively, whether to add or remove frames from either the outgoing or incoming 
clips, is a skill that will only come with practice.

4	 Press T to enter trim mode.
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5	 Press V to select the cut for trimming. Then press the U key until only the outgoing (left) 
side of the cut is selected for ripple trimming.

6	 Press , (comma) to trim the selected edit one frame to the left or . (period) to trim it 
one frame to the right.

TIP  Press V to select the edit point nearest the playhead on the highest auto 
select-enabled track; and press U to toggle between the trim operations for 
the currently selected editing mode.
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7	 If necessary, press U twice to change the trim to the head of the incoming shot, 
and press , (comma) or . (period) to add or remove frames.

8	 Press / (slash) to play around the cut point and check your trim decision.

Continue to refine the edit until you are happy with the results. Then you can move 
on to the next cut.

9	 Press the down arrow to go to the next cut in your timeline. This edit is selected in 
the direction you last had the previous edit selected.

TIP  Because you’re concentrating on the audio in these clips, it’s useful to 
keep an eye on the clip waveforms to see if you’re adding or removing parts  
of words.

TIP  Press Shift-, (comma) or Shift-. (period) to perform a nudge operation that 
trims multiple frames at once. The default value is five frames, but you can 
change this value by going to DaVinci Resolve > Preferences, selecting User 
settings, and adjusting the Pre-roll and Post-Roll times in the Editing panel.
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10	 Press / (slash) to play around the cut point and to determine what you need to trim.

11	 Decide if the edit needs to be refined or not, and press U to change to the appropriate 
trimming operation.

12	 Press the , (comma) or . (period) keys to refine the edit, adding or removing frames from 
either the tail of the outgoing clip or the head of the incoming clip. 

13	 Press / (slash) to review your trim. 

When the audio edit sounds good, move on to the next cut. 

14	 Press the down arrow to go to the next cut in that clip.

15	 Press / (slash) to play around the cut point and identify what you need to trim.

16	 Press U to toggle the edit direction, and press , (comma) and/or . (period) to refine 
the edit.

17	 Press / (slash) to review your trimming.

18	 When you have finished, press A to exit trim mode and return to the selection tool.

You have refined a small part of this interview using various techniques to remove 
unwanted parts of what the subject says and refining the rest into a succinct description  
of her business. When chipping away at a longer cut with the goal of making it shorter, 
these keyboard-oriented trim commands enable you to see and hear a trim as you make  
it which can be invaluable!

Feel free to keep on practicing on the two additional orange clips in this timeline.
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Editing Subframe Audio
While video trimming is limited to a project’s framerate (24 fps, in this project), audio is 
captured using tens of thousands of samples each second. DaVinci Resolve includes the 
ability to edit audio at this subframe level which enables a much more detailed ability to 
trim. Access to subframe audio editing means that you can separate subtle syllables or 
words that are slurred and make them sound clean and clearer. Let’s use subframe audio 
editing to smooth some of the dialogue that you just trimmed in the radio edit.

1	 	Place the playhead over the start of the clip after the first gap in this timeline  
(clip A001_11161158_C007.mov at 01:00:31:20).

2	 Press / (slash) to play over the cut.

Listen carefully and you’ll hear a portion of the previous word, “and,” before she 
continues with, “We have our vegan macaroni and cheese.”

3	 To access subframe audio editing, press N to disable snapping and press Shift-Cmd-L 
(macOS) or Shift-Ctrl-L (Windows) to turn off linked selection.

4	 Enable the selection tool by pressing A.

5	 To select the cut for trimming, press V, and then press Option-U (macOS) or Alt-U 
(Windows) until only the audio track is selected.
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6	 Press Cmd-= (equals sign) in macOS or Ctrl-= (equals sign) in Windows several times 
to zoom into the timeline as far as you can go.

Remember, because you are trimming subframes, you need to zoom in to see  
more detail.

7	 Press the U key until both sides of the audio cut are selected.

The tool tip tells you that you’re not trimming off any frames, because the portion of 
the audio you are trimming is within the duration of a video frame.

8	 Drag the audio cut to the right and find a location where you get the cleanest transition 
in to “we” without hearing any of the “and.” Make sure you don’t take off so much that 
you lose the start of “we.”

9	 Press / (slash) to play around the selected cut and hear your cleaner edit.



126

C
re

at
in

g
 V

ar
ia

b
le

 S
p

ee
d

 C
h

an
g

es

10	 When you are happy with your trimming, reenable snapping and linked selection in  
the timeline.

Now that you’ve trimmed the audio in your project at the subframe level, you’ve learned 
how to apply a greater degree of audio control. 

Continue refining this timeline, practicing the techniques you’ve learned so far in this 
lesson. When your radio edit is finished, you’re ready to add the paint, or b-roll, to cover 
holes and visual jump cuts. That said, you can still apply plenty of tricks to help massage 
the footage into the exact shape you want and make your story as engaging as possible.

Creating Variable Speed Changes
Changing the speed within a clip can grab the audience’s attention by turning what can be 
an ordinary clip into something that makes people sit up and take notice. That is especially 
true on the somewhat pedestrian food shots. In Resolve 15, you’ll find many advanced 
controls to manipulate the playback speed of clips. One of these tools, the retime controls, 
enables you to apply multiple speed changes to the same clip without splitting the clip into 
multiple cuts. Such speed changes are commonly as speed ramps. To explore these 
techniques, you’ll use a timeline that has some b-roll clips added to the project.

1	 In the timelines bin, double-click “02 Radio Edit with B-Roll” to load it into the  
timeline window.

2	 Choose Workspace > Reset UI Layout to reset the timeline to its default size.

3	 Play the timeline to review the edit.

Notice how the new b-roll clips illustrate what Miss Rachel is talking about, as well as 
hiding most of the jump cuts and gaps created during the radio edit. Note also the 
sound of the restaurant added on the Audio 2 track (with the music having been 
dropped to Audio 3) to fill in the sound gaps between the interview clips.

4	 In the timeline, go to the yellow clip on the B-Roll track, which starts at around 
01:00:39:00.
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This shot of the barbecued seitan would be nicer if it slowed down as the plate came 
closer. Right now, the entire shot moves too fast.

5	 Press Cmd-+ (plus sign) in macOS or Ctrl-+ (plus sign) in Windows to zoom into the clip 
on the timeline.

6	 Right-click the clip and choose Retime Controls, or press Cmd-R (macOS) or Ctrl-R 
(Windows).

A blue bar appears along the top of the clip with the speed percentage of the clip 
displayed underneath the video thumbnails.

7	 Place the playhead about halfway into the duration of the clip.

This is the location where you would like to start slowing down the clip playback.  
You do so by adding a speed point at the playhead location.
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8	 Along the bottom of the clip, click the disclosure arrow to the right of the speed 
percentage display, and choose Add Speed Point.

The speed point divides the clip into two sections, with each section now having its 
own playback speed. You can set the speed in the menu you used to set this speed 
point. Let’s increase the speed slightly for the first half of the clip, and then slow it down 
for the second half.

9	 Click the disclosure arrow for the segment on the left and choose Change Speed > 200%.



129

C
re

at
in

g
 V

ar
ia

b
le

 S
p

ee
d

 C
h

an
g

es

10	 Position your mouse pointer on the right edge of the Speed Change bar, and when the 
pointer changes to a double arrow, can drag the edge of the clip to the point where 
she laughs. Doing so reduces the speed even further and better covers the jump cut.

11	 Play over the speed change to view the results.

You now have an eye-catching shot that feels more contemporary and engaging than 
the straight food shot you had. Unfortunately, the slow parts of the footage now appear 
a little stuttery because Resolve has to repeat frames to create that speed change.

12	 Select the clip in the timeline, and open the Inspector. In the Retime and Scaling controls, 
change Retime Process from Project settings to Optical Flow.

13	 Finally, to smooth the transition between to the two speed sections, right-click the clip 
in the timeline, and choose Retime Curve, or press Shift-C. 

TIP  Optical Flow is an intensive process whereby Resolve examines the 
movement of pixels from one frame to another and attempts to interpolate 
that information to create new frames.
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The retime curve opens in the timeline below the clip.

14	 In the retime curve, select the retime keyframe, and click the Bezier control. Drag the 
handles out to adjust the amount of smoothing applied to the speed change.

15	 Finally, click the retime curve icon on the clip to hide the retime curve, or press Shift-C. 
Right click the clip, and choose Retime Controls, or press Cmd-R (macOS) or Ctrl-R 
(Windows) to hide the retime controls.

This food shot in your timeline is now much more dynamic and exciting. You’ve also easily 
manipulated a moving shot to increase its impact and help cover the jump cuts in the 
interview edit.

Using Smooth Cut
Another way to hide a jump cut from your viewer is to use the Smooth Cut transition. 

1	 In the timeline, place your playhead over the edit between the first and second 
interview clips, just after the lower-third title has faded away (at around 01:00:09:00). 
Press / (slash) to preview the cut.

This is a classic jump cut that distracts from the story about the merits of this 
vegan restaurant.

2	 In the upper-left of the interface, click the Effects Library button to open your 
Effects Library.
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3	 Click the Video Transitions group, and in the Dissolve category, locate Smooth Cut.

4	 Drag the Smooth Cut transition to the edit point between the first and second interview 
clips so it’s centered across the edit.

5	 Set the duration of the transition to four frames by either dragging the edges of the 
transition in the timeline, or typing 4 in the Duration field of the Inspector. 

You should see that Resolve successfully manages to blend the two sides of the jump cut 
into what appears to be a single take. 

Remember, though, that you should use this transition with great care; you don’t want to 
change or misrepresent the meaning of something your interviewee said through your 
editing, no matter how subtly!

Working with Advanced Transition Tools
Transitions in Resolve are very straightforward to use. But they also allow you to go much 
deeper into transition customization than you might have thought possible. Resolve has a 
built-in curve editor for transitions that enables you to customize the acceleration of any 
transition animation. Let’s create one for your radio edit.

1	 Go to the lime green clip on the V2 B-Roll track at around 01:00:33:00.
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This is the shot of macaroni and cheese in the middle of your timeline.

2	 Play over the cross dissolve transition at the end of this clip.

The transition works well, but the incoming shot takes a few frames before the camera 
motion settles down. If you ease out on the transition, it will fade into the incoming shot 
more slowly, thereby reducing the impact of the camera movement at the start of the clip. 
You can address this by creating a custom ease-out using the transition curve editor.

3	 Select the transition, and in the lower-right corner of the transition, click the diamond 
icon to open the keyframe editor.

If you just wanted to move a keyframe earlier or later, you could use this editor. 
However, to create a custom acceleration curve, you must use the curve editor.

TIP  If you can’t see the diamond icon on your transition, zoom further in 
to your timeline. 
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4	 On the right side of the keyframe editor that appears below the clip, click the curve 
editor icon to open the transition curve editor. 

Instead of making numeric adjustments to your transition in the Inspector, you change 
the slope of the curve in this curve editor to change the transition acceleration.  
The default linear transition is a diagonal line from the lower-left to the upper-right. 
However, you can flatten that line’s slope to slow the transition speed. To slow down 
the curve at the start, you can add a control point along the line and decrease the 
slope between the initial control point on the left and the new control point you add.

5	 Option-click (macOS) or Alt-click (Windows) about one-third of the way along the 
diagonal line to create a control point.
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6	 Drag down the new control point until the Transition Curve tool tip reads 0.10.

This setting indicates that at this keyframe, the transition will be only 10% complete.

7	 Press / (slash) to play around the selected transition and view the results.

If the acceleration isn’t hiding enough of the slow camera start at the beginning of the 
clip, you can move the control point horizontally to change the timing.

8	 In the keyframe editor track, drag the control point to the right until it is almost in the 
middle of the clip to lengthen the slow acceleration.
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9	 Press / (slash) to play around the selected transition.

Although you delayed the acceleration, a very linear transition remains between the 
control points. You can smooth these transitions using the interpolation buttons at the 
top of the curve editor.

10	 Select the center control point that you added. It turns red.

11	 Click the second interpolation button from the left to create an ease-in/ease-out 
interpolation for the control point and to display Bézier handles that will allow you to 
perform further refinement. 

Because the Bézier handles are almost completely horizontal when added, they will 
create a pause in the transition, holding it for just a moment. However, that’s not what 
you want so you’ll need to adjust the handle to accentuate the slow acceleration at the 
start of the clip.



136

W
o

rk
in

g
 w

it
h

 A
d

va
n

ce
d

 T
ra

n
si

ti
o

n
 T

o
o

ls

12	 Drag the right Bézier handle slightly up and to the right to create a smoother curve.

13	 Press / (slash) to play around the selected transition.

14	 If you are happy with the results, you can close the curve editor by clicking the curve 
editor button in the upper-right corner of the graph. Then, click the diamond shaped 
keyframe editor button in the lower-right corner of the transition icon in the timeline to 
close the keyframe editor.

Custom transitions such as this are most often used in very specific situations, but you can 
also save them as presets if you anticipate the need to reuse a custom curve transition in 
the future.
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Lesson Review
1	 What is known as a “radio edit”?

A) When your edit will be used on radio as well as television

B) A cut-down version of your film used by reviewers

C) A technique of concentrating on the audio before editing the visuals

2	 What does an edit point with a dotted line represent in the timeline?

A) A back-timed edit

B) A through edit

C) An edit that needs a transition applied

3	 Which retiming process can produce much smoother results by restructuring the visual 
data between frames of footage?

A) Stereoscopic

B) Optical flow

C) Frame blend

4	 What transition could be used to make short jump cuts less noticeable?

A) Smooth wipe

B) Smooth dissolve

C) Smooth cut

5	 How can you access the advanced transition controls?

A) Right-click the transition in the timeline, and choose Advanced Transition Controls

B) Click the Transition’s keyframe button, and click the curve editor button

C) Click the transition’s curve editor button in the Inspector.
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Answers
1	 C. A “radio edit” is created when you focus on editing the audio of an interview to make 

it sound smooth and natural before turning your attention to the covering visuals. 

2	 B. A through edit—where you have an edit on a clip but haven’t removed any frames—
is represented as an edit point with a dotted line.

3	 B. Optical flow uses motion estimation to generate new frames from the original source 
frames to produce exceptionally smooth results when retiming a clip with linear motion.

4	 C. Smooth cut is a special-purpose transition designed to make short jump cuts less 
noticeable by using optical flow processing to automatically morph a subject between 
to positions across the duration of the transition.

5	 B. To reveal the Transition Curve editor, click the keyframe diamond in the lower-
right corner of the transition to display the Keyframe Editor, and then click the curve 
editor button.



Lesson 5

Editing an  
Action Scene

Some of the most enjoyable editing jobs are 
cutting action scenes. Although action scenes 
don’t come along every day for most editors, 
the techniques for cutting such scenes can be 
valuable when editing sports, dance, and 
other movement-oriented footage.

As editor, it is up to you to create the overall 
rhythm and flow of the action. You can do so 
with the number and variety of the cuts you 
use, and the duration of the shots. Choosing 
multiple angles, cutting on action, speed 
ramping, judiciously removing frames, and 
inserting the right reaction shots will all 
heighten the excitement.

In this lesson, you’ll edit, trim, reframe, and 
retime clips in DaVinci Resolve 15 to create  
a highly impactful fight sequence.

Time

This lesson takes approximately 
60 minutes to complete.

Goals

Starting a Dailies Timeline	 140

Using Tabbed and Stacked Timelines	 142

Cutting on Action	 147

Enhancing the Action	 153

Comparing Timeline Versions	 166

Lesson Review	 169
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Starting a Dailies Timeline
It is easy to import all your action dailies and then wonder where to start, but don’t let a 
big fight scene overwhelm you. Begin by making a dailies reel and marking all the best 
moments. Once you’re done, you will be able to quickly assemble a cut. 

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 05 Action. Select R15 Editing Lesson 05 Action.drp, choose Open, 
and click OK to import the project into your Project manager.

2	 Open the project, and relink media files.

This project includes a timeline with a version of the fight scene already cut.

3	 Move the playhead to the start of the timeline, and click play to review the edit.

Overall, the director is happy with the general flow of the fight; but he would like to try 
re-cutting the scene to give it a bit more impact, as well as experimenting with different 
reaction shots. While you could immediately duplicate the original timeline and start 
refining the edit, let’s first consider other ways of working between different timelines.

4	 In the Media pool, select the Dailies bin, and click the list view button.

5	 Click the Start TC column to place the clips in ascending order.

Each clip now appears in the order it was shot. This will be helpful moving forward 
because all of the shots from a single camera setup (meaning, all the different takes) 
will usually be located next to each other which will make them easier to find. You can 
go one step further and place all of the clips in a timeline using this sort order.

6	 Right-click the Dailies bin, and choose New Timeline Using Selected Bins.
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7	 Name the timeline Rushes. 

8	 Change the “No. of Audio Tracks” to 2 to reflect the audio clip attributes of the  
source clips.

9	 Deselect “Use Selected Mark In/Out”.

10	 Click Create.

The Rushes timeline is created in the Dailies bin and opens in the timeline window.

11	 Press Shift-Z to view the entire Rushes timeline. 

The clips in the Dailies bin are now placed into the timeline based on the bin’s sort order. 
You also chose not to use the existing in and out points applied to each clip to ensure you’re 
seeing the full duration of each take. 
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Using Tabbed and Stacked Timelines
You can use this Rushes timeline as a source clip because doing so is easier than loading 
each clip separately while looking for alternative takes. To start, let’s create a new timeline 
that will be your new fight scene rough cut. The first cut should contain everything you 
want to happen at roughly the right time. This process isn’t about finessing anything; it is  
all about laying the groundwork. 

1	 Select the timelines bin, and choose File > New Timeline. Name it Sword Fight v2. 

2	 Change the Audio Track Type to Mono because the source audio you’ll be using 
includes only mono channels.

3	 Click Create.

You want to be able to edit one source timeline into another timeline. To do so, it’s often 
easier to see more than one timeline at the same time.

4	 Select the Timeline View Options, and choose the first option to enable Stacked Timelines.
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The timeline window now shows the two timelines you’ve opened in separate tabs.  
You can select each tab to view the contents of that timeline. 

5	 In the pop-up menu for the Sword Fight v2 timeline tab, choose the Rushes timeline.

You can also see different timelines at the same time by viewing stacked timelines.

6	 In the upper-right corner of the timeline, click the new stacked timeline button.

A second, tabbed timeline window appears below your original timeline.

7	 In the lower timeline window, in the pop-up menu on the empty timeline tab and 
choose the Sword Fight v2 timeline.

You can now see the contents of the Rushes timeline and the Sword Fight v2 timeline 
simultaneously. Let’s clean up the interface a little so you can concentrate on this scene.

TIP  You can open more tabs by clicking the + (plus sign) button to the right of 
your timeline tabs, and close existing tabs by clicking the X next to the name of 
each tabbed timeline. You can also drag timeline tabs horizontally to change 
their order.



144

U
si

n
g

 T
ab

b
ed

 a
n

d
 S

ta
ck

ed
 T

im
el

in
es

8	 Click the Media pool button to hide the Media pool.

9	 Click in the upper-right corner of the Timeline Viewer to enter single viewer mode.

10	 Click the tab for the Fight Scene v1 timeline, and press Shift-Z to view the entire 
timeline in its tabbed window. 

You are now ready to create an alternative, tighter cut of this fight scene.

11	 In the Fight Scene v1 timeline, select all the yellow clips that make up the main 
fight sequence.

12	 Drag the selected clips into the empty Sword Fight v2 timeline (in the lower 
timeline window.)

The selected clips are copied from one timeline into the other.

13	 Press Shift-Z to view the newly edited contents in the Sword Fight v2 timeline.

You can also edit between timelines using a variation of the three-point editing technique.

14	 In the upper timeline window, click the Rushes timeline tab .

15	 Move your playhead to the start of the third clip in this timeline, 04_pirates.mov.

16	 Play through the clip and set an in point where the hero jumps in for the second time.

17	 Type +112 to move the playhead forward by one and a half seconds and add an out point.

18	 Choose Edit > Copy to copy the select portion of the Rushes timeline.
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19	 Click in the Sword Fight v2 timeline window, and ensuring your playhead is at the start 
of this timeline, choose Edit > Paste Insert.

The copied portion of the Rushes timeline is inserted into the Sword Fight timeline and 
it effectively establishes the start of the fight scene. Now you’ll insert a quick reaction 
shot of the female lead.

20	 In the Rushes timeline, move the playhead to 13_pirates.mov and play through the 
reaction shots of the heroine.

Because the hero has just jumped into the frame, let’s cut in a surprised reaction from her.

21	 Set an in point where the woman gasps at 00:05:46:00.

TIP  This timecode value is for the Rushes timeline. To see the original source 
timecode for each clip right-click the timeline viewer timecode box, and choose 
Source Timecode.
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22	 Type +4. (plus sign, 4, period) to move the playhead forward four seconds, and add 
an out point after the woman turns from looking up.

23	 Press Option-/ (slash) in macOS or Alt-/ (slash) in Windows to play between the in and 
out points.

This four-second range has a good reaction from the actress. She jumps, apparently 
in response to the swashbuckler jumping in from somewhere, and then she looks up to 
the right, as if to figure out where he came from. This is a perfect reaction for your cut.

24	 Press Cmd-C (macOS) or Ctrl-C (Windows) to copy the marked section.

25	 Select the Sword Fight v2 timeline.

26	 Ensure that your playhead is at the edit point between the first and second clips.

27	 Press Shift-Cmd-V (macOS) or Shift-Ctrl-V (Windows) to paste insert the copied clip 
into the timeline.

28	 In the upper timeline window, click the close timeline window button to leave just the 
Sword Fight v2 timeline open.

By utilizing Resolve’s tabbed and stacked timeline views, you can easily edit the contents 
between different timelines. By using this technique, you have created separate versions of 
these clips in your new timeline that you can trim and adjust without disrupting or changing 
your original edits.

Now that you have another fully blocked-out version of the sword fight scene, let’s help  
the director achieve his vision of a tighter fight sequence by looking at some trimming 
techniques that work for all types of genres but especially well for action scenes. 

Editing from a Source Timeline

Another technique favored by many editors is to open the timeline of rushes in the 
Source Viewer, mark the appropriate part of the footage and edit as normal using 
overwrite, insert, etc. You can achieve this in DaVinci Resolve by dragging a 
timeline into the source viewer. When editing in this manner you may want to 
enable Edit > Decompose Compound Clips on Edit to prevent you from having to 
decompose the compound clips manually (you’ll learn more about compound clips 
in Lesson 7). You can also see the source timeline by choosing Timeline > Swap 
Timeline and Source Viewer.
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Cutting on Action
Cutting on action is a basic editing technique, not just for action scenes but for movement 
in any type of scene.

The idea is that you cut from the action in one shot to the matching action in another shot. 
The scene will not only flow more smoothly compared to cutting on pauses in the action but 
doing so adds to the continuity in the scene. You already have your basic blocked-out sword 
fight, so let’s use some dynamic trimming to make sure your cuts happen on the action.

1	 Press T to enable trim editing mode.

2	 Move the playhead at the start of the third clip in the timeline, the [04_pirates clip.

3	 Press spacebar to play the clip.

4	 Although the end of this clip occurs on the action of two swords hitting, the shot is too 
long for a fast-paced action scene. To fix this, you can cut earlier by trimming the shot 
so the cut occurs on an earlier sword hit. 

To refine this edit, you’ll use DaVinci Resolve 15’s Dynamic Trim Mode.

5	 Move the playhead near the cut between the [04_pirates and 07_pirates clips.

6	 Choose Trim > Dynamic Trim Mode, press W, or click the Dynamic Trim Mode button 
in the toolbar to enable dynamic trimming.

The edit nearest the playhead is selected and both the playhead and the dynamic trim 
mode button turn yellow to indicate that dynamic trimming is enabled. Now, instead of 
pressing JKL to shuttle up and down the timeline, these keys will adjust the selected 
cut point.

7	 Press the U key twice to select the tail of the outgoing shot.
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8	 Press J to trim frames off the tail of the shot. Watch the viewer until you see the swords 
connect with the pirate on the left and then release the keys.

9	 If you go too far, press L to restore frames.

10	 Press / (slash) to play around the selected cut and review the change.

The most important thing when placing this edit is to match the action with the earlier 
sword hit. You want the outgoing shot to end earlier, just before the swords make 
contact for the first time. Whether you cut just before or just after the action depends 
mostly on your sense of timing; but in this case, you should cut just before the action 
because the incoming shot appears to be in a good spot.

11	 Press the down arrow to select the tail of the 07_pirates clip.

TIP  If you find that the footage is playing too fast for you to place the cut, hold 
down the K key and tap the J or L keys to trim one frame at a time. You can also 
hold down the K and the L or J keys to scrub through the trim.

TIP  When working in Dynamic Trim Mode, the JKL keys enable you to trim 
in real time, and the spacebar, which would normally start and stop playback, 
changes to the “play around current frame” function.
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12	 Press / (slash) to play around the selected cut.

Although this action more or less matches, it could do with quite a bit of tightening up. 
Again, you will use dynamic trimming to end the cut earlier.

13	 Press J to trim back to the previous sword clash with the villain to the right of the hero.

14	 Press the U key twice to toggle the trim to the head of the incoming shot.

TIP  If you feel that you need to see a little more or a little less when playing 
around the selection, you can adjust that play-around time by going to DaVinci 
Resolve > Preferences, selecting the User tab, and then selecting the Editing 
pane. In General Settings you will find options for Pre-roll time and Post-roll time.
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15	 Press L to ripple trim the incoming shot forward to the point where the hero and the 
villain’s swords clash

16	 Press / (slash) to play around the selected cut.

Cutting on action is the basic editing technique learned by every fledgling editor. You 
use the action to motivate the cut. Keeping with that simple principle will lead to your 
edits becoming more fluid.

Repeating Action
Now that you have fine-tuned a few cuts by matching their action, let’s toss a little wrench 
into the principles of action editing. A common contemporary tactic when cutting action 
scenes is to repeat the same action on key shots to really milk the impact of a shot. 
Sometimes action occurs too quickly and might be missed by viewers. That is the case 
for the trim you just made. Even a few overlapping frames in two shots can increase the 
dynamism of an action.

TIP  Remember, you can use the JKL keys to perform single frame trims by 
holding down K and tapping the J or L keys.
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1	 Press the up arrow to move back to the previous edit between [04_pirates and  
07_pirates.

2	 Click the loop button under the timeline viewer to enable looping during playback, 
or press Cmd-/ (slash) in macOS or Ctrl-/ (slash) in Windows. 

3	 Press / (slash) to play over the selected cut between [04_pirates and 07_pirates.

This strike in the sword fight might happen too quickly for viewers to fully “digest” it. 
You can create a very brief overlap to emphasize it a bit more. Let’s start on the 
outgoing side and then switch to the incoming shot.

In addition to using the JKL keys, you can press , (comma) and . (period) to make 
single-frame trims.

4	 If necessary, press U until the tail of [04_pirates is selected, and then tap . (period) 
two or three times to add two or three frames to the tail of the cut.

5	 As you continue loop playing, press U twice to select the head of 07_pirates.

6	 With the incoming side of the cut selected, tap , (comma) two or three times to add 
frames to the head of the cut.

7	 Using the U key, continue selecting either side and continue to refine the overlap.

8	 Press spacebar to stop playback. 

9	 Press W to disable Dynamic Trim mode.

10	 Under the timeline viewer, disable the loop button or press Cmd-/ (macOS) or  
Ctrl-/ (Windows).

Creating these very short overlapping action frames gives the viewer time to catch up. 
However, the opposite is also true; making action go a bit faster can also lend a greater 
sense of energy to a scene.

Rolling Edits in Dynamic Trim Mode
As you’ve probably noticed when you’ve been switching between the two sides of a ripple 
trim, you can also roll edits in Dynamic Trim mode too.

1	 Move your playhead forward to the edit between 05_pirates and 06_pirates and 
press / (slash) to preview the edit.

The shot feels a bit forced, waiting for the hero to turn his head.

2	 Place you playhead near the cut and press W to enable Dynamic Trim mode and 
select the edit point.

3	 If necessary, press U until you have select the edit as a rolling trim.
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4	 Press J to roll the edit back about a second to before the hero turns his head.

5	 Press W to toggle Dynamic Trim mode off.

Slipping and Sliding in Dynamic Trim Mode
As well as making ripple and roll trims in Dynamic Trim mode, you can also make slip 
and slide trims.

1	 Place the playhead over the next-to-last shot in your timeline, the reaction shot of the 
heroine in 12_pirates.

The current shot doesn’t clearly convey her feelings, so the director would like to use 
a later reaction shot.

2	 Press T to ensure you’re in Trim Edit mode, and press W to turn on Dynamic Trim mode.

3	 Press Shift-V to select the 12_pirates clip under the playhead.

4	 Press J to slip the clip backward, and choose a later reaction shot that is more suitable.
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5	 Press / (slash) to preview your changes.

You can also slide clips.

6	 Press S to switch Dynamic Trim mode from slip to slide. The toolbar button changes.

7	 Hold down K and tap J a couple of times to slide the reaction shot backward a 
few frames. Be careful not to slide too far because you still want to see the hero’s 
cheeky wink.

8	 Press W to turn off Dynamic Trim mode and A to return to Selection mode.

As you can see, working in Dynamic Trim mode has many advantages when it comes to 
ripple, roll, slip, and slide trimming. However, you can employ a number of other editorial 
tricks to further enhance this action scene.

Enhancing the Action
Changing the speed of clips in an action scene requires a delicate touch to get that extra 
boost of energy without making a scene look comical. Depending on the shot, a speed 
increase between 10 or 15 percent will give a fight scene some extra punch.

1	 Play the 05_Pirates clip.

TIP  Slipping a shot using shortcuts often feels as if it’s working in reverse. 
When you are slipping a clip, you’re moving the content of the shot in the 
direction of your trim rather than relocating the in and out points.

TIP  You can also switch between slip and slide trims by right-clicking the 
Dynamic Trim mode button in the toolbar.
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First, let’s change the speed of one clip.

2	 Select the 05_pirates clip , right-click it, and choose Change Clip Speed.

3	 In the Change Clip Speed dialog, set the Speed to 110.00 %. Select “Ripple sequence” 
and Pitch Correction, and click Change.

Selecting “Ripple sequence” ensure that gaps won’t be created in your timeline as you 
speed clips up and shorten their durations. Selecting Pitch Correction will keep the 
audio sounding natural.

4	 Play over the changed shot to review the speed change.

Notice how much more forceful the sword swipes appear. It’s subtle, but adding it to 
shots in which the actors move a bit too slowly makes the action appear more realistic. 
For extra good measure, see if you can influence the director and director of 
photography to shoot actions scenes with a fast shutter speed. Combining that footage 
with speed changes will make your scene feel even more energized.

NOTE  Pitch correction is available only when using macOS 10.10 
“Yosemite” and newer.
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Increasing Tension with Variable Speed Changes
Not all clips require a device as simple as a constant speed change. Occasionally, you will 
want to assign different playback speeds to different ranges within a clip. This is the case 
with one of the shots in your timeline.

1	 Move the timeline playhead back to 18_pirates.

2	 Play over the clip to review it.

Although this clip looks fine at 100-percent speed, the middle of the clip has a pause in 
the action. It would be nice to extend this to build more tension toward the end of this 
fight. Using the retime controls, you can divide the clip into ranges, and assign different 
playback rates for each range.

3	 Position the playhead about one-third of the way into the clip.

This roughly locates the area you should slow down to extend the pause in the action.

4	 Right-click the clip, and choose Retime Controls, or press Cmd-R (macOS) or Ctrl-R 
(Windows).

5	 At the bottom of the clip, in the Change Speed submenu, choose Add Speed Point.
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A speed point is added at the playhead location, dividing the clip into two ranges, each 
with its own Change Speed submenu. You’ll add one more speed point, so you want to 
slow down only the middle of the clip and return to sound speed after that.

6	 Position the playhead about two-thirds of the way into the clip.

7	 At the bottom of the clip, in the Change Speed submenu, choose Add Speed Point.

You have now divided the clips into three sections that you will use to ramp down the 
speed in the middle. 

Because clip durations change when you change the playback speed of clip sections, 
you can decide if the changes should open gaps or ripple the timeline by choosing the 
selection tool or the trim mode tool. In this case, you want to make these edits tighter, 
so you’ll ripple trim using the trim mode tool.
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8	 Press T to enable Trim Edit mode.

9	 In the Change Speed submenu under the section in the middle, choose Change 
Speed > 75%.

The time appears next to the Change Speed submenu update to show each section’s 
current playback speed and the timeline ripples to accommodate the clip’s change  
of duration. 

10	 Play over the clip to see the results of the variable speed change.

You can modify the position of each speed point and the speed of each section by 
dragging the speed points. Each speed point has two handles: The upper handle will 
speed up or slow down the section to the left, whereas the lower handle will change 
the location of the speed point. 

Changes playback speed to 
speed section left of speed point

Changes the frame where  
the speed point occurs
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On your clip, if you want the slow speed to occur only during the small pause in the 
sword fight, the first speed point is placed too early and the second speed point is 
placed too late.

11	 On the first speed point, drag the lower handle to the right until the male lead finishes 
engaging in the sword fight with the pirate who is lower in the frame.

Notice that the speeds of both sections on either side of the speed point did not 
change speed. Only the location of the speed point has changed.

12	 On the second speed point, drag the lower handle to the right until the male lead 
begins to engage again with the pirate who is higher in the frame.

Now you might want to keep those locations, while changing the speed of the first 
and last segments to speed them up just a bit.

13	 On the first speed point, drag the upper handle to the left until the speed of the first 
segment is roughly around 120%.
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The last segment does not have a speed point, but you can change the speed of the 
segment using the speed bar at the top of the clip.

14	 Position the mouse pointer over the upper-right corner of the speed bar.

The pointer changes to a resize cursor and you can drag the edge to change the 
speed of the last segment.

15	 Drag the speed bar corner to the left until the speed of the first segment is roughly 
around 120%.

16	 Play over the clip to review your changes.

17	 Press Cmd-R (macOS) or Ctrl-R (Windows), or right-click the clip and choose Retime 
Controls, to close the retime controls.

18	 Press A to change to the selection tool.

Being able to manipulate the speed and location of a speed change independently 
using one speed point is a simple yet powerful device. You’ll explore even more ways 
to manipulate speed and speed points in Lesson 5.

Adding and Selecting Multiple Cuts
In addition to changing a clip’s speed, a technique often used to raise the energy of action 
scenes is to simply remove one or two frames just before the action. Placing this subtle jump 
cut just before a hit or some other action can often make the shot appear more intense.

1	 Press Shift-Z to see the entire timeline.

2	 Position the playhead over the fourth clip in the timeline, 07_pirates.mov.

3	 Play over the clip to review it.

Because you need to remove just a frame or two, it is easiest to create an edit point 
where you want to remove the frames.
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4	 Position the playhead a few frames from the start of 07_pirates.mov, just as the hero 
and the villain’s sword are still touching, but before the villain moves back slightly.

Positioning the playhead close to the point of action usually adds to the impact.

5	 Choose Timeline > Razor, or press Cmd-B (macOS) or Ctrl-B (Windows), to add a 
through edit at the playhead position.

This command adds an edit across all the clips with auto select enabled. 

6	 Position the playhead a few frames before the end of 07_pirates.mov, just before the 
swords clash.
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7	 Again, choose Timeline > Razor, or press Cmd-B (macOS) or Ctrl-B (Windows), to add 
a second through edit at the playhead position.

With the edit points in place, you can select both edit points and trim them simultaneously.

8	 Press T to select Trim Edit Mode.

9	 Position the pointer in the gray area of the timeline above and to the left of the first 
razor edit you created.

10	 Drag down and to the right until both through edits are selected.

11	 Press the U key until only the outgoing side of both through edits are selected.

TIP  You may need to zoom into the timeline to perform this selection.
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12	 Press , (comma) to trim one frame from each of the selected cuts.

13	 Press / (slash) to preview these new cuts.

14	 Press A to return to the selection tool.

When used in the right locations, this type of trim can have an effect similar to shooting 
with a fast shutter speed. When done well, it quickens the pace of an action scene.

Reframing Shots
Controlling the speed of a clip–either through single-frame trims or retiming shots–helps  
to build tension, even if only for a split second. Mixing up angles can have the same effect. 
Unlike a typical dialogue scene, when you have multiple camera angles available for an 
action scene, use them! And when you don’t have them, you can fabricate them by resizing 
and repositioning shots you do have.

1	 In the timeline, position the playhead at the start of the third clip from the end, 06_pirates.

2	 Select the clip, and press / (slash) to play over it.

This is the main hero shot in the scene, yet it is a fairly wide shot with a lot going on. 
It might be a better hero shot if you turned it into more of a close-up.
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3	 In the lower-left of the timeline viewer, click the on-screen controls.

To use the on-screen controls to scale up the image, you need to create more room 
around the frame. You can do so by reducing the image magnification in the viewer.

4	 Use your middle mouse wheel to zoom out in the timeline viewer, or in the magnification 
menu in the upper-left of the timeline viewer, choose a value lower than your current 
setting so the image and its on-screen controls appear smaller in the viewer.
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5	 Drag out any corner handle of the wireframe to slightly increase the size of the image.

Now you’ll reposition the shot so it is nicely framed on the hero without cutting off the 
pirate to the right.

6	 Drag anywhere within the wireframe to reposition the shot to show more of the right 
side of the frame. 

7	 Press / (slash) to play over the resized and repositioned clip.
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The rescaling appears fine, but the camera movement that was acceptable as a wide 
shot is now too chaotic for a close-up. You can smooth out the camera movement 
using Resolve’s stabilizer, which is located on the Color page.

8	 Click the Color page button, and in the toolbar, select the tracker button.

9	 In the mode pop-up menu in the upper-right corner of the Tracker palette, choose Stabilizer.

10	 Click the Stabilize button

11	 Press Cmd-/ (slash) in macOS or Ctrl-/ (slash) in Windows to turn on loop, and click 
play to see the results.

Unfortunately, the Stabilizer has introduced some strange twisting motion in the image. 
This is because the Resolve stabilizer not only stabilizes vertical and horizontal camera 
movement, it can also stabilize tilt, rotation, zooming, and perspective.

You want to keep that handheld feel while smoothing out some of the erratic camera 
movement. To do so, you will stabilize only the up and down camera movement.

12	 In the Stabilizer window, in pop-up menu in the lower-right, change Perspective 
to Translation.

Whereas the default Perspective setting stabilizes all characteristics of a camera move, 
choosing Translation stabilizes only the X and Y movement.

13	 Click the Stabilize button again.

Notice that using that stabilization setting retained the overall natural camera 
movement while smoothing out the X and Y motion. Let’s look at the unstabilized clip 
to refresh your memory of the original shot.

14	 While the clip is looping, select the Bypass Stabilization checkbox to disable the 
stabilization.
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The clip instantly scales down a bit because this is how stabilizers work. They up-size 
the image just enough to apply inverse motion that offsets the camera movement.

15	 Deselect Bypass Stabilization to reenable the stabilization.

The results could still use a bit more smoothness to the motion.

16	 At the bottom of the Stabilizer palette, in the Smooth data field, enter 0.75. 

Increasing the Smooth parameter value will remove additional jarring motion while 
retaining the primary camera motion. Increasing the smoothness also requires 
additional image resizing, so it is best to start with clips recorded at resolutions larger 
than the final output. 

17	 Return to the Edit page. 

You may think that all this resizing would lower the quality of your image, but in many cases 
it does not. When cutting 4.6K content from a Blackmagic Design URSA camera for HD or 
even 2K digital cinema output, you have the benefit of being able to zoom in and reposition 
clips to get the framing you want. Even though the project may be in HD, DaVinci Resolve is 
smart enough to always start with the original clip’s size when resizing.

Comparing Timeline Versions
Throughout any project you will create several versions of a timeline. And when multiple 
versions of a scene exist, someone inevitably will want to know how they differ. So, it is 
up to you to know be able to point out those differences. Resolve includes a unique and 
helpful comparison tool for comparing two versions of a scene.

1	 In the upper-right corner of the timeline viewer, click the double box icon to return to 
Dual Viewer mode, and then click the Media pool button. 

2	 In the Media pool, select the timelines bin.
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3	 With the Sword Fight v2 timeline still open, right-click the Fight Scene v1 timeline, 
and choose Compare With Current Timeline.

The timeline comparison window shows the current timeline in the timeline viewer 
along the bottom and the timeline that you right-clicked along the top.

4	 In the upper-right corner of the timeline comparison window, drag the zoom slider to 
the left until you see both timelines in their entirety.

Areas of the timelines are highlighted to indicate larger areas in which changes occur. 
The green highlights indicate entirely new sections that do not appear in the current 
timeline. The red highlights indicate sections that do not appear in the right-clicked 
timeline. Both the upper and lower timelines have their own playheads, so you can 
review each one. Your current Sword Fight v2 timeline will play in the timeline viewer  
as usual, and the Fight Scene v1 timeline will play in the source viewer.
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5	 Drag the upper timeline playhead over the green section of the comparison timeline.

The comparison timeline appears in the source viewer. To view the current timeline in 
the timeline viewer, you can drag the playhead along the lower timeline.

6	 Drag the lower timeline playhead over the red section of the timeline to see it in the viewer.

As you compare the two timelines, you can accept and add changes into the 
current timeline.

7	 Right-click the first green area in the comparison timeline, and choose Accept Change.

The green section in the comparison timeline is now added to the current timeline.

8	 Right-click the second green area at the end of the upper timeline, and choose Accept 
Change to add the closing shots from the original cut to your new, enhanced cut.

9	 In the lower-right corner, click the close button to return to the current timeline with all 
the new changes.

As you may have noticed, you edit action scenes with many of the same tools you would 
use in any other genre, but you do so in distinctive ways. Action scenes are just short 
storylines in and of themselves, so the tools and some of the techniques used to advance  
a dialogue scene are also used here. You needn’t be anxious about editing your first action 
scene; just remain organized and treat it like a mini-story.
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Lesson Review
1	 How can you see more than one timeline at the same time?

A) Choose Timeline > Open Additional Timeline

B) Cmd-double-click (macOS) or Ctrl-double-click (Windows) another timeline

C) By enabling tabbed timelines in the Timeline View Options menu

2	 What visual indicators does Resolve give to let you know you’re in Dynamic Trim Mode?

A) The Dynamic Trim toolbar button changes to yellow

B) The timeline playhead changes to yellow

C) The Trim Edit mode button changes to yellow

3	 True or False: The function of the J, K and L keys differ when you are in  
Dynamic Trim Mode?

4	 What does the lower speed point handle adjust?

A) The speed of the clip to the left of the speed point

B) The speed of the clip to the right of the speed point

C) The position of the speed point on the clip

5	 Where are the stabilization controls located?

A) In the Effects Library

B) In the Inspector of the selected clip

C) In the Color page
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Answers
1	 C. You enable stacked and tabbed timelines by clicking the top left button in the 

Timeline View Options pop-up.

2	 A. and B. The timeline playhead and the Dynamic Trim Mode toolbar button both 
change to yellow.

3	 True. When in Dynamic Trim Mode, the J, K and L keys are used to trim the selected edit(s).

4	 C. The lower speed point handle adjusts the position of the speed point on the clip 
without adjusting the speed either side.

5	 C. The stabilization controls are located on the Color page.



Lesson 6

Editing Multicamera

Many types of productions capture a scene 

using multiple cameras running simultaneously, 

including scripted dramatic series, reality 

programming, interviews, and music videos. 

These multicamera productions all require  

a unique editing setup in which you can 

synchronize and view all of the angles at once.

DaVinci Resolve 15’s multicamera feature 

allows you to initially synchronize multiple 

clips, and then easily manage and edit 

between camera angles without any further 

concern about sync issues. Resolve enables 

you to cut to any camera angle, safe in the 

knowledge that you can later change your 

mind and select a different angle from the 

same sync point.

In this lesson, you will explore the power  

of multicamera functionality, discover some  

of the best ways to work with simple and 

complex multicamera setups, and learn how 

to solve some common challenges. 

Time

This lesson takes approximately 
75 minutes to complete.

Goals

Syncing Angles	 172

Editing a Multicamera Music Video	 178

Complex Multicamera Editing	 186

Lesson Review	 197
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Syncing Angles
From the very beginning of a project, accurately establishing the sync relationship between 
multiple camera angles is critical to a successful multicamera edit, so let’s look at the 
various ways you achieve this in Resolve.

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 06 Multicam. Select R15 Editing Lesson 06 Multicam.drp, choose 
Open, and click OK to import the project into your Project manager.

2	 Open the project, and relink media files.

3	 In the Media pool, select the 01 Sasha Interview bin.

4	 Play each of the clips to review the interview contents.

This bin contains two clips shot from different angles of an interview with Sasha from 
the cycle shop Citizen Chain in which he explains the inspiration for the business’s 
name. It’s a nice story, but the director would like it to flow a little better. Thankfully, 
because this interview was shot on more than one camera, you can cut between the 
cameras instead of adding b-roll cutaways to cover jump cuts in the edit, or patching 
the interview with the Smooth Cut transition.

First, you need to sync the interview clips.

5	 In the Media pool, select both clips. Right-click either clip, and choose “Create New 
Multicam Clip Using Selected Clips”.

The New Multicam Clip window opens in which you can select how Resolve will 
create the multicam clip.

6	 In the Multicam Clip name, type Sasha Interview.

7	 Leave the Frame Rate at 24. Resolve uses the frame rate of the source clips.

8	 Change the Angle Sync to Sound.

Resolve will automatically synchronize the two clips using their audio content as 
references, much as you did when syncing dual system clips in Lesson 1.
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9	 Leave “Move Source Clips to ‘Original Clips’ Bin” selected.

10	 Click Create.

Resolve analyses the clips’ audio and creates a new multicam clip in the selected bin 
called Sasha Interview. A new bin also appears, Original Clips, that contains the two 
interview source clips.

Viewing the Multicam Clip
Now that you have created the multicam clip, you can work with it just as any other source 
clip. However, because it contains both angles in a single clip, you can switch between the 
two shots at any time.

1	 Double-click the Sasha Interview multicam clip to open it in the source viewer.



174

S
yn

ci
n

g
 A

n
g

le
s

Because this is a multicam clip, Resolve automatically displays both angles side-by-
side. The angle with the red outline represents the currently active angle, the angle 
that you will see and hear.

2	 Play the multicam clip in the source viewer. Both angles should be in sync.

3	 In the source viewer, set an in point just before Sasha says, “I was a big fan of Orson 
Welles (around 01:00:07:00).

4	 Set an out point after Sasha nods at the camera, but before he says, “Sort of a happy 
coincidence“ (around 01:00:34:00).

5	 Select the Timelines bin, and press Cmd-N (macOS) or Ctrl-N (Windows), or choose 
File > New Timeline.

6	 Name this timeline Multicam Interview, and click Create.

7	 Press F10 to perform an overwrite edit into the Multicam Interview timeline, and press 
Shift-Z, if necessary, to view the whole clip. 

NOTE  You may notice some black frames at the start on the shot on the left, 
labelled Angle 1, because the camera recording this shot may have started rolling 
a short time after the other camera started. These frames are not a problem. In 
fact, multicamera source clips don’t have to be exactly the same length.
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When you play this multicam clip in the timeline, you’ll see only the currently active 
angle. The second angle is hidden.

Refining the Radio Edit
Now that you have the interview in the timeline, you can start to edit to improve the flow of 
Sasha’s storytelling. First, you’ll have to remove a couple of distracting “umms” and “ahhhs” 
to remove. Then, you’ll want to tighten up the last part of the interview.

1	 Play through the timeline until you hear the first “ahhh.” Set an in point before that 
“ahhh,” and set an out point before Sasha says, “Going through school.”

2	 Press Shift-Delete (or Backspace) to ripple delete the marked section.

3	 Press / (slash) to preview the edit.

By now, this process should be second nature to you.

4	 Continue playing the timeline and use the same technique to remove the “ummm” a 
few seconds later, after he says, “I appreciate the pun,” and before he says, “Citizen 
Chain, Citizen Kane.”

5	 Another “ahhh” occurs before he says, “And only after we named the shop.” Ripple 
delete it.

6	 Set another in point after he says, “It was only after we named the shop,” and place an 
out point just before he says, “We found out that Rosebud was really a bicycle.” Again, 
ripple delete this section of the interview to tighten up the punchline of the story.
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At this point, your director is satisfied that your new cut has engaged the audience 
sufficiently, so doesn’t want to use the rest of the interview.

7	 Set an in point before Sasha says, “The inspiration for Rosebud,” but don’t set an  
out point.

8	 Press Delete (or Backspace) to remove the rest of the interview from this timeline.

9	 Press Shift-Z to fit the timeline in the available space.

10	 Press Home to return your playhead to the start of the timeline, and click play to listen 
to this radio edit.

Remember, at this stage you are listening to ensure that the interview sounds right and 
contains no obviously distracting audio edits. If you need to adjust any edits, use the 
techniques you learned in Lesson 3 to ripple trim the edit points to suit yourself.

Once you have the radio edit working, you’re ready to switch the angles of your  
multicam clip.

Switching Angles in the Timeline
Not all multicamera edits must done on-the-fly, cutting between angles in real time as the 
footage races past. You can switch between the different angles within a multicam clip at 
any time.

1	 In the Multicam Interview timeline, place the playhead on the edit between the first 
and second clips.

TIP  You can identify a multicam clip in the timeline by the little box icon next 
to the name of the clip.
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2	 Press / (slash) to review the cut.

Ouch! I think you’ll agree, that’s a pretty nasty jump cut.

3	 Right-click the first clip in the timeline, and choose Switch Multicam Clip Angle > Angle 2.

4	 Press / (slash) to review the new edit.

Now, the jump cut isn’t quite so noticeable, but splitting the edit will hide it a little 
more effectively.

5	 Press V to select the edit between the first and second clips.

6	 Press Option-U (macOS) or Alt-U (Windows) to select the video edit, and press U, 
if necessary, until the video edit is selected as a rolling trim.

7	 Press , (comma) two or three times to roll back the video edit a few frames to create 
a small L-cut.

8	 Press / (slash) once more to review the edit.

The slight offset of the video edit from the audio cut slightly softens the edit, making 
it much less jarring.

9	 In the timeline, select the third clip. Right-click it, and choose Switch Multicamera Clip 
Angle > Angle 2.

10	 Select the fifth clip, right-click it, and choose Switch Multicamera Clip Angle > Angle 2.

11	 Review each of these edits, and if necessary, repeat the rolling trim procedure to split 
the video edit from the audio edit. Offsetting the edits even one or two frames can 
make a big improvement in the way the edits are perceived.
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12	 When you have finished, press Cmd-A (MacOS) or Ctrl-A (Windows) to select all the clips 
in your timeline. Right-click any of the selected clips, and choose Flatten Multicam Clip.

Flattening a multicam clip in the timeline removes all the additional angles, and leaves 
the active angle in its place as a normal timeline clip.

By shooting this interview with more than one camera, you are able to cut the interview 
effectively without having to paint it entirely with b-roll or rely on the Smooth Cut transition.

Editing a Multicamera Music Video
The fun aspect of working with a multicamera edit is that you can cut between the different 
cameras in real time, as if you were sitting in the studio gallery and directing a live shoot. 
Often, this real-time technique will save you hours because you’re able to cut the material 
in the time it takes to play the timeline.

In the next exercise, you’re going to concentrate on a simple multicamera edit for the 
beginning of a music video. You will then explore more in-depth features of multicam 
editing in DaVinci Resolve 15.

1	 In the Media pool, select the Timelines bin, and press Cmd-N (macOS) or Ctrl-N 
(Windows) to create a new timeline. Name this timeline Simple Music Video.

TIP  Remember, you don’t always have to roll the edit backward to create an 
L-cut. A cut might work better if you roll the video edit forward to create a J-cut.
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The new timeline automatically opens and replaces the previous timeline in the 
timeline window.

2	 Right-click the 02a JBR Angles bin, and choose Create New Multicam Clip Using 
Selected Bin.

3	 In the New Multicam Clip window, name your multicam Simple Music Multicam.

4	 Change the Angle Sync to Sound.

5	 Change the Angle Name to Clip name.

Once again, the multicam clip is created in the selected bin, and the original source 
clips are tucked into a new Original Clips bin.

TIP  You can create multicam clips using selected clips or the contents of one 
or more selected bins.
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6	 Double-click the Simple Music Multicam clip to open it in the source viewer.

At first, it looks as if these clips have no video content; but if you play through the first 
few seconds, you’ll see the video of each clip appear because the audio clip starts a 
little before each of the video clips, much as in Sasha’s interview. 

The multicam source viewer organizes the angles from left to right and from top to 
bottom. So, in this 2x2 multicam layout, angle 1 will appear in the upper-left window 
and angle 4 will appear in the lower-right window. Notice that the angles names have 
inherited the original clip names.

NOTE  The Angle Name option dictates the order in which the angles are 
sorted. When you choose Sequential, Resolve labels the angles and sorts  
them as Angle 1, Angle 2, and so on, based on their starting timecode values. 
Choosing Clip name sorts the clip names in ascending alphanumeric order  
and labels the angles. Similarly, choosing “Metadata - Angle” or “Metadata - 
Camera” sorts the clips based on information in their respective metadata fields.
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7	 In the source viewer options menu, make sure “Video and Audio” is selected. 

8	 In the source viewer, click the MUSIC angle to select it.

When you play the clip back in the source viewer, you will now hear the music track 
rather than the camera audio recorded on the set.
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9	 Set an in point just before the music starts, after the sync bleeps (at 01:00:03:03).

10	 Perform an overwrite edit to edit this clip into the empty timeline.

11	 Press Shift-Z, if necessary, to view the whole clip, and press Home to return the 
playhead to the start of the timeline.

In the timeline, the clip remains blank because you are monitoring an angle that has no 
video, the angle with the music track.

12	 In the source viewer mode pop-up menu, choose Multicam to display the multicam viewer.

In the source viewer below the multicam clip, you see three buttons that set the parts 
of this multicam clip you will edit: video, video and sound, or only sound.

13	 Click the video button to the left to edit only the video of this multicam clip.

14	 In the source viewer, Option-click (macOS) or Alt-click (Windows) the video for CAM_01.

Holding down the Option (macOS) or Alt (Windows) key switches the video of the active 
angle. If you didn’t use this keyboard modifier, you would cut the video of the active angle.

15	 The source viewer now displays two boxes; the blue box identifies the active video 
angle and the green box identifies the active audio angle.
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Now for the fun part…

16	 With the playhead at the start of the timeline, click play, and begin clicking each of the 
video clips in the source viewer to cut between the angles of the multicam clip. You will 
see the edit points appear in the timeline as you cut between the angles. Keep going 
until the angles run out and you reach the end of the timeline.

17	 Return the playhead to the start of the timeline, and click play to review your 
multicamera masterpiece.

This first attempt at a real time multicamera edit is probably not going to result in a 
perfect edit. It’s very rare that you would cut to the exact angle at exactly the right time 
on your first try (although happy editing “accidents” have been known to happen). 
Instead, think of this as your rough cut. You’ll now need to refine the edit.

TIP  You can also press the 1, 2, and 3 keys along the top of your keyboard 
to cut between the angles in real time.
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Adjusting a Multicamera Edit
Now that you have completed your rough cut, when you review it you’ll probably notice 
two main issues: you’ve made a cut at the wrong time, or you cut to the wrong angle. 
Even worse, it could be both issues!

Fear not. You’re not directing live television here; this is post-production so you can change 
your mind before anyone has seen your previous “creative choices.” In fact, you already 
know how to change an existing cut point by simply performing a rolling trim using any one 
of several techniques.

Previously, when working on the multicamera interview, you switched the angles in 
the timeline. When you have more than two angles, it’s easier to switch angles in the 
source viewer as in the next exercise.

1	 In the timeline, play your multicam edit until you see a shot you want to change, 
then stop playback.

As the edit plays, the source viewer will also update because, in multicam mode, 
the source viewer is automatically ganged to the timeline playhead position.

2	 In the multicam viewer, Option-click (macOS) or Alt-click (Windows) a different image 
to switch the active angle to the new angle.

TIP  When working with a multicamera edit, you need to be very mindful of the 
sync between the angles. For this reason, it’s probably not advisable to begin 
rippling, slipping, or sliding shots until you are confident you have mastered 
those edits.
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When you’re switching the active angle, the mouse pointer changes to a replace  
edit icon.

It’s just as easy to add further cuts to your multicam edit too.

3	 In the timeline, move the playhead to the middle of one of the multicam clips, and in 
the source viewer, click any other angle.



186

C
o

m
p

le
x 

M
u

lt
ic

am
er

a 
E

d
it

in
g

A new edit point appears at the playhead position in the timeline and changes the rest 
of the multicam clip after the cut to the new active angle.

Excellent. Now that you’ve got a real taste of how much fun multicamera editing is,  
and how it works in Resolve, it’s time to look at a more complex editing challenge.

Complex Multicamera Editing
Editing a multicamera clip with three or four angles is very enjoyable and relatively 
straightforward. Things become much more challenging when dealing with multicamera 
shoots that used more cameras.

Understanding some of the issues that you may encounter during a complex multicamera 
edit is essential to learning how you can begin to solve these problems.

1	 Select the Timelines bin, and press Cmd-N (macOS) or Ctrl-N (Windows) to create a 
new timeline. Name this timeline Complex Multicam.

Again, this new timeline replaces the previous timeline in the timeline window.

2	 Select the 02a JBR Angles bin, and Cmd-click (macOS) or Ctrl-click (Windows) the 02b 
JBR More Angles bin.

3	 Press Cmd-A (macOS) or Ctrl-A (Windows) to select all the clips in these bins, and 
choose New Multicam Clip Using Selected Clips.

TIP  Pressing the number keys at the top of your keyboard (1, 2, 3, and so on) 
makes a cut at the playhead position in the timeline. Pressing Option-<number 
key> in macOS or Alt-<number key> in Windows) switches the multicam clip angle 
at the playhead position in the timeline. You can perform either of these operations 
during playback or when the playhead is stationary.
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Even though the 02a Simple Multicam bin already contains a multicam clip from the 
previous exercise, Resolve will ignore it when you are making the new multicam clip. 
You can always Cmd-click (macOS) or Ctrl-click (Windows) to remove it from the 
selection, if you wish.

4	 In the window that opens, change the name of the multicam clip to Miserable Girl.

5	 Set the Angle Sync to Sound

Although synchronizing clips using sound is a great method, you can also synchronize 
clips using timecode, in points, out points, or clip markers. These other methods are 
useful when, for whatever reason, the source clips were recorded without sound or 
with poor-quality reference audio

6	 Set the Angle Name to Clip name.

7	 Select “Detect clips from same camera”.

Doing so ensures that Resolve will look at the metadata for each clip and see if any of 
the clips share a camera number or name. When they do, those clips are treated as a 
single angle in the multicam clip and sorted based on timecode.

TIP  The camera number metadata is located in the Shot & Scene category of 
the metadata panel.
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8	 For this example, deselect “Move Source Clips to ‘Original Clips’ Bin” to leave the 
source clips where they are and click Create.

The Miserable Girl multicam clip is created and placed in the uppermost selected bin.

9	 Double-click the Miserable Girl multicam clip to load it into the source viewer.

10	 In the source viewer, set an in point just before the music starts at 01:00:03:05, 
and overwrite the clip into the Complex Multicam timeline.

TIP  If you can’t easily find your multicam clips, this project already includes 
a Multicam Clips Smart Bin.
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It is important to edit the multicam clip into the timeline prior to switching to the 
multicam source viewer because that viewer is designed specifically to work when 
multicam clips are already edited in the timeline.

11	 Press Shift-Z and then press Home to return the playhead to the start of the timeline.

12	 In the source viewer mode pop-up menu, choose Multicam.

13	 Play through the timeline, keeping an eye on the source viewer to check the sync  
of all clips. 

Because the clip name sorting organizes clips alphabetically, CAM 01 is the first clip in 
the list and is used in the timeline as the default picture and sound reference. 

Renaming Tracks 
Although the multicamera clip appears as one segment in the timeline, it is actually a type 
of container timeline, which is very similar to a compound clip. You will work more with 
compound clips in Lesson 06; but for now, it’s useful to know that you can open a multicam 
clip in its own timeline when you need to make changes, such as altering an angle name.

You can use the pop-up menu in the timeline header to rename angles to be more 
descriptive and helpful. However, renaming is available only when you expand the track 
view in the Timeline View Options menu. 

1	 In the Timeline View Option pop-up menu, select stacked timelines.

TIP  Black frames are shown at the start and end of some clips because all 
of the cameras started and stopped recording at slightly different times. 
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The timelines you worked on across this project now open as individual tabs.

2	 In the timeline, right-click the Miserable Girl clip, and choose “Open in Timeline”.

The multicam clip opens in its own tabbed timeline and you can see how Resolve has 
structured and organized it. The organization is simple: any content on the Video 1 
track is displayed in the multicam viewer as Angle 1. If content is present on Video 2, 
it is displayed as Angle 2, and so on. The same naming convention applies to the audio 
clips. Notice that the track names follow the names of the original clips.

3	 In the timeline header for the V2 track, click the name CAM_02_Pt1.
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4	 Rename the track to CAM_2.

5	 Click the timeline tab for the Complex Multicam timeline, and in the multicam viewer, 
verify that the name of the second angle is updated.

Rearranging Angles in the Viewer
When viewing the order of angles in the multicam viewer, you may deem some angles less 
important and some more important. Sometimes these superfluous or less-important 
angles clutter your screen and distract you from selecting the angles you actually want. 
You can limit the number of angles displayed in the viewer using the multicam display 
pop-up menu.

1	 In the lower-right of the source viewer, click the multicam display pop-up.

You can choose how many angles are displayed by selecting one of the grid options.

2	 Choose 3x3 to display three rows of three columns for a total of nine angles in  
the viewer.

The source viewer organizes the angles into pages to provide access to the additional 
camera angles.

3	 Click the right page control arrow to display additional angles.

This page displays angle CAM_10; a nice shot of the lead guitarist. You might want this 
important close-up shot on the first page, so let’s relocate that angle in the track order.

4	 In the timeline, click the Miserable Girl tab.

TIP  Limiting the number of displayed angles can also improve playback 
performance on slower computers.
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5	 Scroll up to locate the CAM_10 track, right-click the timeline header, and choose 
Move Track Down.

Doing so swaps the CAM_10 and CAM_9 angles in the track order, which should 
also move the guitarist onto the first page.

6	 Click the Complex Multicam tab to return to the main timeline.

In the source viewer you’ll see that CAM_10 has switched places with Cam_09.

Adding New Angles
Another reason you may need to open a multicam clip in its own timeline is to add 
additional angles that you were not able to add when you created the multicam clip. For 
example, you may have created the original multicam clip using sync’d timecodes, but had 
one clip that didn’t have the proper timecode. In a situation like this, it’s useful to know that 
you can manually add angles after the multicam clip has already been created.

1	 In the timeline, click the timeline tab for the Miserable Girl multicam clip timeline.

2	 Click the Timeline View Options button, and select the rightmost clip view option.  
Press Shift-Z to fit the entire timeline in the window.
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This arrangement collapses all the tracks to a small size, leaving you the maximum 
amount of space to move tracks around in the timeline.

3	 In the Media pool, select the 03 JBR Extra Angle bin.

4	 Open the New Angle.mov clip into the source viewer.

This clip is a low-angle shot of the entire stage that is missing from the original 
multicamera angles. 

5	 Position the jog bar at the start of the source clip, and press Shift-down arrow to jump 
to the first marker. Press I to add an in point.

NOTE  Notice that CAM_02 contains two clips. These two clips were captured 
by the same camera and placed on the same track according to their timecode 
based on the Angle Name option you selected when creating the multicam clip. 
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This marker was placed at the start of the music for you. Having it in place makes it 
quicker to sync this angle with the multicamera clip.

6	 In the Miserable Girl multicam clip timeline, position the playhead at the start of the 
music at 01:00:03:05. The in point set in this timeline is the original in point that you set 
prior to editing the multicam clip into its own timeline.

7	 Press Option-Cmd-1 (macOS) or Alt-Ctrl-1 (Windows) to disable the A1 source control, 
or disable the source control for A1 in the timeline track headers.

8	 Press F12 to perform a place on top edit, and edit the clip in track V11 (the lowest free 
track) so this clip starts at the correct position.
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A new angle is added to the multicam clip. You can use the standard slip and slide 
trimming tools, as necessary, to refine the sync relationship of this clip with the music.

9	 In the timeline, close the Miserable Girl tab. You have finished changing your multicam 
clip for now.

10	 In the source mode pop-up menu, re-enable the multicam viewer.

11	 Click the Timeline View Options button, and click the button to enable audio 
waveforms. Choose other timeline view options to suit yourself.

Ok, back to the fun bit. It’s time for you to do some more multicam editing! 

12	 In the multicam viewer, click the audio-only button, switch to page 2, and Option-click 
(macOS) or Alt-click (Windows) the MUSIC angle to switch the multicam clip audio to 
the music track.

NOTE  While a place on top edit will normally create new video and audio 
tracks as necessary, in this case, an empty V11 track was already in the timeline. 
V11 was empty because Angle 11 in this multicam clip is used for the music track 
which has no video. By manually adding the new video-only angle to the 
empty V11 track, both clips now display as the 11th camera angle in the viewer.
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13	 Switch to page 1, click the video-only button, and Option-click (macOS) or Alt-click 
(Windows) CAM_03 to switch the picture to this first starting angle. 

14	 Return the playhead to the start of this timeline.

15	 Click play, and start editing!
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When you have played to the end of this multicam clip, go back through your edit and 
refine it by rolling the edit points, switching existing angles, and adding new cuts. Don’t 
forget the two additional angles on the second page in the multicam viewer! Although your 
instincts might tell you to flatten the timeline and remove all of the unused angles, consider 
that color grading can be easier when opening a timeline and grading each track instead of 
grading clip-by-clip.

When editing multicamera projects and playing back in real-time, you are really trying to 
assess the rhythms and themes of the music and capture those characteristics as you are 
cutting. Sometimes you might cut a multicam clip in three or four ways to experiment with 
various pacing strategies and later decide which one is showing the most love; but as with 
all editing, each cut requires constant revisiting and reworking to ensure that your audience 
is watching the best possible results.

Lesson Review
1	 What options do you have for synchronizing angles in a multicam clip from video clips 

without sound?

A) Use in or out points

B) Use markers

C) Use timecode

2	 What is the maximum number of angles you can view simultaneously in a multicam clip?

A) 16

B) 18

C) 28 

3	 What modifier key is held down to switch the entire multicam clip to another angle 
instead of adding a new edit point?

A) Command (macOS) or Control (Windows)

B) Option (macOS) or Alt (Windows)

C) Shift

4	 True or False? You cannot change the order of angles, add additional angles to an 
existing multicam clip, or change the current order of the angles.

5	 True or False? When you choose to flatten a multicam clip, you lose all the other 
synchronized angles.
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Answers
1	 A., B., and C. You can choose to synchronize angles using in points, out points, 

timecode, or markers instead of sound.

2	 A. 16. You can have multiple pages of more angles, but the maximum number of angles 
you can view in any one page is 16 (4x4).

3	 B. Option-click (macOS) or Alt-click (Windows) an angle to switch the existing angle. 

4	 False. Right-click a multicam clip, and choose Open in Timeline to adjust an existing 
multicam clip.

5	 True. Flattening a multicam clip removes all the unused angles and leaves only the 
clip that was used in the active angle in the timeline.



Lesson 7

Creating Multilayered 
Composites 

Multilayered promotional videos, or promos, combine 
video, audio, motion graphics, and text into a seamless 
animated storyline. While creativity and imagination 
make every promo unique, the ultimate goal still 
comes down to clearly conveying the message.

You can apply the layering, graphic, and animation 
techniques you learn in this lesson to commercials 
in which you need to quickly persuade viewers to 
engage with a business. These techniques also 
come into play when creating educational content 
that needs to explain difficult or complicated 
concepts in an easy-to-understand way.

Because motion graphics communicate important 
messages, they must be easily grasped by the 
viewer. As a result, you strive for clarity and 
simplicity. The visual effects that you include, 
movement you create, and colors you choose must 
enhance the overall clarity of the piece. By doing  
so, you create an animation that communicates  
its message effectively to the target audience.

This lesson will introduce the compositing and 
animation features available to you in DaVinci 
Resolve 15’s Edit page. As an editor, you will often 
be required to build composites and apply some 
level of keyframe animation. Then, you, or a motion 
graphics artist, can use that composite as a guide, 
or previz (previsualization), for further work in the 
Fusion page or Fusion Studio.

Time

This lesson takes approximately 
75 minutes to complete.

Goals

Roughing out your Vision	 200

Working with Graphics	 218

Working in a Compound Clip	 223

Improving Multi-layered Performance	 231

Adjusting Keyframes	 233

Lesson Review	 239
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Roughing out your Vision
To ensure the clarity of your multilayered promo, you must have a vision for the project 
before you even begin. Unless you fully define what you need to communicate, it will be 
very difficult for you to choose the right approach.

The goal for this promo is to create a multilayered, thirty-second promotional piece 
incorporating multiple video layers into an animated wall of pictures. Before you actually 
start putting your promo together, let’s look at the style you will want to use.

1	 In the Project manager, right-click and choose Import. Navigate to Rhinos Compositing. 
Select R15 Editing Lesson 07 Compositing.drp, choose Open, and then click OK to 
import the project into your Project manager.

2	 Open the project, and relink media files.

3	 In the Edit page, in the Master bin, double-click the final composite clip, and play it.

This clip is a multilayer graphic promo like the one you will create. As you can see, 
to realize a project such as this, you need lots of images visible at the same time, 
and they must be stacked on top of each other using multiple timeline video tracks. 

The vertical placement of clips is best dealt with after you have determined when the 
most important shots should be seen. So, let’s take a closer look at the starting timeline 
which roughs out the basic structure of the promo but is still missing a few elements. 

4	 In the timelines bin, double-click “01 start timeline”.
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5	 Play the timeline from the start to review the current edit.

This timeline already has most of the voiceover (VO) in place, along with some music 
and b-roll clips. In the next exercises, you’ll continue building out the narration and 
adding more of the b-roll clips.

Recalling Previous Clips
When you are cutting VO for a promo, you often bounce between two or three takes.  
As you switch back and forth, it helps to know a few fast ways to return to clips that you 
used previously.

This timeline contains a sentence from the VO source clip that you would like to use. The 
easiest way to locate and load the VO clip into the source viewer is to match frame it from 
an existing VO clip in the timeline.

1	 In the timeline, ensure that the playhead is over the third VO.wav clip on track Audio 1, 
just before the on-camera Interview HD clip.

To successfully match frame and find the desired sentence, you need to indicate which 
track DaVinci Resolve 15 should be examining. You can set the correct track for the 
match frame by disabling auto select on all of the tracks above the track you want to 
match frame to, which in this case is Audio 1.

NOTE  You can also manually select a clip to match frame to, irrespective of 
the auto select controls focus.
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2	 Click the auto select button to disable auto select for Video 1, or press Opt-F1 (macOS) 
or Alt-F1 (Windows). 

3	 In the lower-right corner of the timeline viewer, click the match frame button, or press F, 
to perform a match frame operation.

TIP  You’ll also find a match frame button under the source viewer with which 
you can locate the current source frame in the timeline.
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The match frame function loads the clip under your timeline playhead and on the 
highest auto select-enabled track into the source viewer. This simple action saves you 
the trouble of tediously searching through the Media pool to locate the clip you have 
already used. 

4	 With the source viewer active, type 3. . (two periods) and press Enter.

Pressing two periods is the same as adding two decimal points with zeros. So, it is the 
equivalent of typing 3:00 minutes. This location is near the starting point for the next clip.

5	 Press spacebar to play over the ending sentence.

You’ll use this last sentence as the ending for your promo.

6	 Return to the three-minute location, and mark an in point before the doctor says, 
“This is why I continue to fight,” at around 00:03:01:00.

7	 Mark an out point after she says, “Give up on them,” at 00:03:08:00.

Now you want to add this VO to the end of your timeline, you’ll do so using the append 
at end edit function.

TIP  When you want to locate a particular timeline clip in the Media pool, select 
the clip in the timeline, and choose Clip > Find Clip in Media pool; right-click the 
clip, and choose Find in Media pool; or press Opt-F (macOS) or Alt-F (Windows).
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8	 Press Shift-F12 to append the clip to the end of the timeline of the targeted audio track.

9	 Play over the onscreen interview and the audio VO you just added to the timeline to 
review the edit.

The VO clip was edited directly after the end of the on-camera interview. When cutting 
a voice element, don’t forget that people need to breathe, and for that matter, so does 
your edit.

10	 In the timeline, move the playhead anywhere over the new VO.wav clip you just added.

11	 Press Shift-V to select the clip.

12	 Type +10 and press Enter.

You just moved the clip by a relative amount (10 frames) because the plus key was 
entered before the numerical value. Doing so adds some much-needed breathing 
space between the two sentences. At this point, take some time to review the entire 
edit before you move on to the next exercise.

Editing with Fit to Fill 
Fit to fill is a four-point edit in which both the source clip and timeline have in and out 
points. When these two selections have different durations, DaVinci Resolve automatically 
calculates the rate of speed adjustment required to make the marked duration of the 
source clip fit into the marked duration of the timeline. This automatic speed change is 
helpful in promos where you want a particular action to happen within a musical beat or 
within a certain VO section.

1	 With the playhead positioned at the start of the timeline, click play, and mark an in point 
at the third musical beat (at roughly 01:00:02:00).

2	 Mark an out point on the fifth musical beat (at around 01:00:04:00). 
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The duration between these marks should be about two seconds, which you can verify 
in the upper-left duration field in the timeline viewer.

3	 In the Media pool, select the Media bin.

4	 Double-click Clip 02 to load it into the source viewer.
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The marks are already set on this clip and ready for you to edit into the timeline with 
a duration of four seconds. Let’s look at the content you are going to use.

5	 Press Opt-/ (slash) on macOS or Alt-/ (slash) on Windows to play from the in to out 
points before returning the playhead to its current frame.

The rhino in this shot moves very slowly. You are going to speed up the shot because 
you want to fit the full action of the rhino looking up into the two-second duration you 
just marked on the timeline.

6	 In the timeline track header, disable the A1 destination control so you edit only the 
video track.

7	 Press Shift-F11 to perform a fit to fill edit. 

A speed change icon appears on the clip and the clip in the timeline is sped up to fit 
the four-second source clip into the two-second timeline region. 

8	 Return to the start of the rhino clip in the timeline and watch the edit. 
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Fit to Fill is an easy edit to make in this way; but in some cases, it can be even easier. 
If you are performing a fit to fill edit to replace an existing clip in the timeline, you 
needn’t mark in and out points. You can position the timeline playhead over the 
segment and enable the auto select control for that track. When performing the fit to 
fill edit, Resolve will automatically calculate the in and out points for the segment.

Aligning Action with a Replace Edit
So often in promos, you want multiple pictures to appear on-screen at the same time. To do 
so, they must be layered vertically on different tracks in the timeline, but at the same time. 
For your next few edits, you’ll stack up clips that will work well together on-screen. 

Creatively, the director wants multiple shots of guns firing on screen simultaneously in your 
wall of pictures. She also wants this moment to occur at a natural pause in the voiceover.

1	 In the timeline, play from the start of the loading rifle clip, and stop at the pause 
between “It isn’t because they dislike you” and before the doctor says, “It’s just 
because they are scared,” at about 01:00:19:15.

This is where the new clip’s gunshot should be heard. When performing a replace edit, 
it’s important to position the playhead where you want the sound or action to occur.

2	 Press the right and left arrow keys to ensure the playhead is positioned between 
“dislike you” and “it’s just because”.

TIP  If you will need to locate this exact frame later, you might want to add a 
clip or timeline marker as a reference.
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3	 In the Media pool, double-click single round shot to open it into the source viewer.

At one point, the gun is fired in this clip. You can find it easily using the audio overlay 
in the source viewer. 

4	 In the options menu above the source viewer, choose Show Full Clip Audio Waveform.

By examining the audio waveform overlay, you can easily locate the gun being fired 
because the shot is the only sound in this clip. 
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5	 In the source viewer, drag the playhead directly over the frame where the gun fires. 

Using the source playhead, you identified the gunshot as a sync point; and in the 
timeline, you identified the pause between the doctor’s two sentences as the other 
sync point. You’re almost ready to perform a replace edit.

An effective replace edit is all about the playhead’s position in the timeline and the 
source viewer. This placement is critical because when you perform the replace edit, 
the playhead frame in the source viewer is introduced exactly at the playhead frame in 
the timeline. 

You may already have used the replace edit function to replace an entire clip on the 
timeline. However, if you add in and out points in the timeline before performing a 
replace edit, the points can limit the amount of source media handles that is edited on 
either side of the playhead location. 

6	 Press Q to activate the timeline viewer.

Previously you disabled auto select on Video 1 to match frame to the audio, now you 
need to enable it on this track to mark the clip’s duration.

7	 Click the auto select button on Video 1, or press Option-F1 (macOS) or Alt-F1 (Windows), 
to enable auto select for video track 1.
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8	 Choose Mark > Mark Clip, or press X, to mark in and out points for the duration of the 
loading rifle video clip on the Video 1 track.

To edit in the new clip and layer it above the loading clip, you need to add a new 
video track. 

9	 In the timeline, right-click the Video 1 track header, and choose Add Track.

A new Video 2 track is added above Video 1. Now you’ll patch the video from the 
source clip onto Video 2 track.

10	 Press Option-2 (macOS) or Alt-2 (Windows) to patch the source video to Video 2 
in the timeline.
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Because you also want the gunshot to be heard, you’ll also edit in the audio.

11	 Press Cmd-Opt-2 (macOS) or Ctrl-Alt-2 (Windows) to patch the source Audio 1 into Audio 2.

With the duration correctly marked, the right tracks targeted, and your playhead in 
the correct position, you are now ready to perform your replace edit.

12	 Press F11 to perform a replace edit.

The gunshot clip is now layered on top of the clip on Video 2, and the sound of the 
gunshot occurs exactly in the pause of the sentence.

13	 Press / (slash) to review the edit you just made to see and hear the placement of  
the gunshot.
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You have one more gun firing shot to add. You’ll edit this on another layer above 
single round shot. 

14	 In the Media pool, double-click two rounds shot to open it in the source viewer.

This clip has two places where a gun is fired. You’ll locate the second gunshot using 
the audio overlay.

15	 In the source viewer, drag the playhead directly over the frame in which the gun fires. 

Now you need to patch the audio and video to new tracks in the timeline. 

16	 Right-click anywhere in the timeline header and choose Add Tracks.
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In the Add Tracks dialogue, you can determine how many tracks you’re adding and 
where they are placed in relation to existing tracks.

17	 In Video Tracks, set the Insert Position menu to Above Video 2; and in Audio Tracks, 
set the Insert Position menu to Below Audio 2 and the Audio Track Type to Mono.

18	 Click Add Tracks to add the audio and video tracks.

Depending on your screen size, you may need to reduce the size of your video tracks 
using the Timeline View Options.

You do not always have to patch to a specific numbered track. You also can quickly 
patch to the next highest video track by using the up arrow keyboard shortcut.

19	 Press Cmd-Shift-up arrow (macOS) or Ctrl-Shift-up arrow (Windows) to patch source V1 
one track higher to Video 3 in the timeline.
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20	 Press Cmd-Opt-down arrow (macOS) or Ctrl-Alt-down arrow (windows) to patch source 
A1 on track lower to your new Audio 3 in the timeline.

21	 In the timeline, make sure your playhead is still over the point where the gun is fired 
in Single round shot.

22	 Press X to mark the clip in the timeline on the lowest track with auto select enabled 
(Video 1).

23	 Press F11 to replace the clips on the targeted tracks.
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The replace edit is ideal for making edits in which the timing and placement of action 
is far more important than where the start and end of a clip might happen.

Aligning Action with Slip Edits
You aligned the two gunshot clips using replace edits. But what about aligning actions with 
sound after a clip is already edited into the timeline? The easiest way to align clips with 
sound once they are edited is by performing a slip edit.

Let’s look at loading rifle which is positioned under your gunshot clips on Video 1. Because 
you cannot currently see loading rifle in the timeline, you need to disable the clips on the 
higher tracks.

1	 In the timeline, select single round shot and two rounds shot. Right-click one of the 
clips, and choose Disable, or press D, to disable the clips.

The two selected clips are no longer visible in the viewer and they are dimmed in the 
timeline, which reveals the loading rifle clip beneath on Video 

2	 Press / (slash) to play over loading rifle to view its contents.

At the start of the clip, the rifleman slaps the cartridge into his gun. Aligning that action 
with the gunshot sound effect would sync all the visuals very nicely.
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3	 Make sure your playhead is still positioned over the sound of the gunshot on Audio 2. 
If it isn’t, use the waveforms of the guns firing as a guide (or any markers you may have 
added as reference).

Now you can slip the rifle shot to align with the gun sound effect.

4	 Press T to select the trim edit mode tool.

5	 Move your mouse pointer over the thumbnail and click loading rifle to select it with the 
slip cursor, or press Shift-V to select the clip on the lowest track with an enabled auto 
select control.

6	 Tap the , (comma) key three or four times to move the clip three or four frames later.
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Now you have a problem. By default, the slip tool shows the four-up display in the 
viewer, which shows only the start and end frames of the clip you are slipping. 
However, you are not interested in the first or last frame of that clip. You need to see 
the exact frame under the playhead where your sound effect is located.

7	 Deselect View > Enable Preview During Editing, or press Shift-Q, to disable the  
four-up display.

8	 Now press the , (comma) and . (period) keys to slip the rifle shot to where the gunman 
smacks his hand on the cartridge.

9	 Choose View > Enable Preview During Editing or press the Shift-Q again to reenable 
the four-up display.

To be sure you have the rifle shot aligned with the sound effect, you need to enable 
the sound effect without enabling the linked video on the higher video tracks.

10	 Press A key to return to the selection mode tool

11	 Opt-click (macOS) or Alt-click (Windows) the audio clip on the Audio 2 track to select it 
without selecting the linked video clip.
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12	 Press D to enable the selected audio clip.

13	 Press / (slash) play over the selection to see how the rifle aligns with the gunshot.

14	 Select the remaining two disabled video clips, and press D twice to reenable them.

Now that you have a layered stack of clips, and aligned their actions, all your video 
elements are edited into the timeline and you can lay out that Mondrian-like wall of pictures. 

Working with Graphics
When working on graphical promos, composition must always influence where your images 
will be placed. Composition also comes into play when deciding what shot to use. 
Aesthetically, for a graphic edit such as in the current project, you must constantly assess 
how the vertically placed elements will work together on screen. Your goal is to make them 
complement each other, enhance the overall topic at any particular moment, and fit 
logically with the voiceover.

By placing images in expressive temporal and spatial relationships, you can guide the 
audiences’ interpretation of what is presented at any moment in time and heighten the 
desired emotional response.

The first step in devising your graphic design is to import any graphics that you may want to 
use. Resolve can import standard graphic file formats including TIF, PNG, JPEG and PSD, 
including any alpha channels that determine the transparency of an image.
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1	 Select the graphics bin, which is where your imported graphic will be placed.

2	 Choose File > Import File > Import Media, or right click in the Media pool and choose 
Import Media. Navigate to R15 Editing Lesson07 > Graphics.

3	 Select the .dropzones file and click Open to import it.

The psd-format graphic is imported into the bin. You can edit this into your timeline 
and extend it to the duration you need.

4	 Drag .dropzones from the bin to the timeline above the uppermost clip  
on the Video 3 track. Release the mouse button when a new Video 4 track is added  
to the timeline.

5	 Trim the head and tail of .dropzones so it extends across the entire timeline from the 
first clip to the last.
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As the name implies (and as you can now see), this graphic has an alpha channel that 
creates transparency. This channel makes it easy to scale and reposition the video 
layers under the graphic to fill in the areas of transparency.

Scaling and Cropping
Currently, each image is full raster layered behind the graphic. Using the on-screen scale 
and crop controls, you can place the images so they appear to fit within the rectangles of 
your graphic.

1	 Position the timeline playhead over the Interview HD clip, and press Shift-V select it 
(because it’s still on the lowest active auto select-enabled track).

You’ll use the on-screen controls to position and crop this interview clip so it fits within 
one of the rectangles. Because this is your main interview clip, it will go into the largest 
rectangle in the layout.

2	 In the lower-left corner of the timeline viewer, click the transform On-Screen Control 
button to show the wireframe outline.

TIP  Resolve’s default scaling behavior is to fit all images within the timeline 
resolution. Although this graphic has a much higher resolution than the 
timeline resolution, it is scaled to fit. This default behavior can be changed 
in the Project settings > Image Scaling category.

TIP  To ignore, invert, or modify the type of alpha channel in a graphic, right-click 
the file in the bin, and choose Change Alpha Mode. Alternatively, you can switch 
between these same options in the Video tab of the Clip attributes dialogue.
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3	 Drag any of the wireframe’s corner control handles to scale down the image and 
position it so it fits within the long, large rectangle in the center of the graphic. 

Because the video frame isn’t in the same aspect ratio as the rectangular graphic, 
some of the image edges bleed over into other rectangles. Again, using on-screen 
controls, you can crop the image to fit perfectly.
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4	 In the lower-left corner of the timeline viewer, click the on-screen control pop-up menu, 
and choose Crop.

5	 Drag the upper, lower, left, and right control handles of the wireframe to crop the image 
until it fits within the rectangular box. If necessary, zoom in on the timeline viewer and 
hold down your mouse’s scroll wheel or middle button to scroll around the image in the 
timeline viewer.
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6	 In the lower-left corner of the timeline viewer, click the crop on-screen control button 
to hide the wireframe outline, and return the zoom pop-up option to Fit.

One by one, you will scale and crop each image to fit into the open rectangles. It’s good 
practice to do so on this timeline, so feel free to complete these tasks as extracurricular 
activity. Then, in the next exercise, you’ll jump to a new timeline in which all the scaling and 
cropping was done for you.

Working in a Compound Clip
Your animation will pan from left to right across the graphic and video elements. Of course, 
whilst you could animate each clip individually in your timeline, the process would be much 
easier if you could treat all the layers as one. By doing so, you could animate just a single 
element rather than having to manipulate several different layers and clips. By collapsing all 
your tracks into a single compound clip, you enjoy the ease of managing a single clip while 
retaining access to all your edits.

1	 In the timelines bin, double-click the “02 cropped” timeline.

This timeline has all the cropping and resizing completed on the remaining clips, 
as well as a few additional clips. Let’s take a quick look.

2	 From the start of the timeline, play over the first five clips, until the narrator says, 
“It’s just because they are scared.”

Although the timeline isn’t completely done, you can still turn it into a compound clip. 
Making a compound clip doesn’t prevent you from making further changes to your 
timeline.

3	 Press Cmd-A (macOS) or Ctrl-A (Windows) to select the entire timeline and all its contents.

4	 Right-click one of the clips and choose New Compound Clip.

TIP  To nudge the control handles and resize the image in very small amounts, 
you may find it easier to adjust the settings in the Inspector. 
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A dialog appears asking you to name the compound clip. Compound clips are treated 
just like regular source clips. They have names and appear in the current bin.

5	 Name the compound clip Animation comp 01, and press Enter.

All of your audio and video edits are collapsed into a compound clip, which is added 
to the current bin in the Media pool. 

However, the compound clip is not a mixdown of your video and audio clips. It is a 
container of all your edits which you can still access at any time.

6	 In the Timeline View Options, enable Stacked Timelines.

7	 In the timeline, right-click the Animation comp 01 clip, and choose Open in Timeline.

The compound clip opens into its own tabbed timeline and includes all your original 
edits. Every change you make inside this compound clip will update every instance of it 
in this project; this case in 02 cropped timeline and in the Animation comp 01 clip in 
the bin. Let’s make some changes to see this updating in action.

TIP  Deleting a compound clip from a bin deletes it from any timeline into which 
it was edited, just as with a normal source clip.
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8	 Go to the start of the timeline and play over the first four clips.

Notice that the first four clips are not on-screen at the same time. They pop on and off 
as one clip cuts to the next. Because you don’t want gaping holes in your graphic, 
you’ll need to ensure that the first four clips appear on-screen simultaneously. To do 
so, you must layer them on top of each other for the same duration.

9	 In the timeline, select the second clip and press Opt-up arrow (macOS) or Alt-up arrow 
(Windows) once to move the clip up to the higher video track. 

10	 Select the third clip in the timeline, and press Opt-up arrow (macOS) or Alt-up arrow 
(Windows) twice to move the clip up two tracks. 
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Because the graphic is on the Video 4 track, you’ll need to move it up to a new track 
before you can move the last clip. Even without an existing track, moving the graphic 
up automatically will create a new track.

11	 In the timeline, select the graphic clip, and press Opt-up arrow (macOS) or Alt-up arrow 
(Windows) once to move the clip up to a new track. 

Now let’s move the last clip.

12	 Select the fourth clip in the timeline, and press Opt-up arrow (macOS) or Alt-up arrow 
(Windows) three times to move the clip up three tracks. 

With all four clips on their own tracks, you can trim their heads so they all begin at the 
start of the timeline.

13	 Cmd-click (macOS) or Ctrl-click (Windows) the heads of each of the three clips on V2, 
V3, and V4.

TIP  When moving clips using the arrow keys, be careful to move only into 
empty areas of the timeline. Any clips you pass over, even temporarily, will 
be overwritten.
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14	 Move the playhead to the start of the timeline

15	 Press E to perform an extend edit, thereby extending the start of each clip to the playhead.

16	 Press Shift-Cmd-A (macOS) or Shift-Ctrl-A (Windows) to deselect the heads of each of 
the clips and then Cmd-click (macOS) or Ctrl-click (Windows) the tails of each of the 
clips on V1, V2 and V3.

17	 Move the playhead to the start of loading rifle, Single round shot and two rounds shot.

18	 Press E to perform an extend edit, this time lengthening the end of each clip to 
the playhead.
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All four clips now fill the rectangles at the start of the timeline. You can return to the 
compound clip using the path control in the lower-left corner of the timeline.

19	 In the lower-left corner of the timeline, in the path control, double-click the name of the 
main timeline, 02 cropped.

Because the timeline was updated with the changes, the Animation comp 01 
compound clip has also been updated.

20	 Play through the first few seconds of the timeline to verify that the changes were made.

The compound clip in the bin includes all the same updates you’ve made to compound 
clip in the timeline.

Animating a Compound Clip
Adding even subtle animation to your promos can make them more compelling. Animations 
can direct the viewers’ eyes, set a mood, and provide more sophisticated transitions 
between individual elements or entire scenes. Animating in DaVinci Resolve is familiar to 
you if you have ever used keyframe animation in another application. You can perform 
animation in the Inspector, in the timeline, or directly in the viewer.

1	 In the timelines bin, double-click the “03 layered” timeline to open it in the timeline viewer.

This timeline has all of the clips layered, trimmed, cropped, and repositioned for you. 
It will enable you to jump right in and begin animating your compound clip.

TIP  When you need to decompose a compound clip back to its constituent 
parts, select the compound clip in the timeline, and choose Clip > Decompose 
in Place; or right click the compound clip in the timeline, and choose 
Decompose in Place. Doing so will return you to all the separate clips that were 
inside the compound clip. Note that this process does not remove the original 
compound clip from your bin.
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2	 With nothing selected in the timeline, type 10. (period), and press Enter. 

The playhead is placed at 10 seconds, just after the gunshots. This is where you will 
create the first keyframe to begin your animation.

3	 In the timeline, select the compound clip. Open the Inspector, and in the Transform 
controls, set the Zoom data field to 2.800 to scale up the image the fill the frame.

4	 Drag right in the Position X data field until the edge of the image reaches the left edge 
of the raster, or type 1145, and press Enter.

TIP  To tidy up all the unused tracks, right-click any of the track headers, 
and choose Delete Empty Tracks.

NOTE  DaVinci Resolve is a resolution-independent application. When making 
complex scaling changes, as in this exercise (where you are scaling clips down, 
and up), the final resolution of each clip is calculated by taking into account the 
original resolution of the source media, the timeline resolution, image scaling 
settings, and any transforms applied in the Edit and Color pages, so that the 
final output always delivers the best possible resolution for each clip, 
regardless of the number of transforms applied to it.
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5	 In the Inspector, to the right of the Position parameters, click the keyframe button.

A keyframe is added to the X and Y Position parameters in the transform category. 
To finish your animation, you now need only to go to the end of the timeline and set 
your final framing. 

6	 With nothing selected in the timeline, type 24. (period), and press Enter.

The playhead is placed just after your on-screen interview shot concludes. This is where 
you will place the ending keyframe.

7	 In the timeline, select the compound clip.

8	 Drag left in the Position X data field until the graphic reaches the right edge of the screen, 
or type -1150, and press Enter.
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9	 Play the Timeline to see the results. 

For the first time, you can start to see what your output eventually will look like and even 
which grid boxes will be visible. However, unless you are using a very powerful 
workstation, the playback won’t be anywhere near smooth enough to properly evaluate the 
actual speed and motion of your animation. To improve playback, let’s look at some of the 
performance optimization available in DaVinci Resolve.

Improving Multi-layered Performance
When working with many layers, it’s important that you optimize your timeline for playback, 
especially if your computer doesn’t have plenty of RAM or a powerful graphics processing 
unit (GPU). Resolve offers several ways to monitor and improve playback performance.

1	 Move the playhead to the start of the timeline and click play.

Look at the frame rate display in the upper-left of the timeline viewer that shows the 
playback frame rate Resolve is achieving. The small green or red light to the left of the 
frame rate display is the graphics processing unit’s performance. Because all image 
processing goes through the GPU (graphics processing unit), if the light is green, it 
indicates that the GPU has enough processing power to render the current frame in 
real-time. A red light indicates that the GPU lacks the processing power for a real-time 
rendering. The fastest way to improve GPU performance is to lower the resolution of 
your clips on-the-fly.

2	 Choose Playback > Proxy Mode > Half Resolution.

3	 Move the playhead to the start of the timeline and click play.

Enabling proxy mode increases performance by lowering the image quality as the 
image is read from disk. If lowering the image quality is not an option, and you have the 
flexibility to wait a few seconds, you can instruct Resolve to render images to a disk 
cache for smoother playback.

4	 Choose Playback > Proxy Mode > Off.
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Enabling the smart render cache automatically renders areas of the timeline that 
would not otherwise play back smoothly. The Project settings dictate the compression 
format used for the cache and sets the wait time to determine when rendering should 
be activated.

5	 Choose File > Project settings to open the Project settings window, or press Shift-9.

6	 In the Master settings, in the Optimized Media and Render Cache area, set the Render 
cache format to DNxHR LB.

This is a low-bandwidth compression format that produces a data rate of around 
4.5MB/second (around 36Mbps) for HD 25fps media. It will result in a better viewing 
quality than proxy mode and still enable smoother playback on almost any system.

7	 Click Save to close the settings window.

8	 Choose Playback > Render Cache > Smart.

A red line appears along the top of the timeline to identify the area to be cached. After 
you leave your system idle for a fixed wait period (the default is 5 seconds), Resolve starts 
to cache the frames and the red lines turn blue to indicate a successfully cached area. 

9	 Allow the compound clip to cache in the timeline, and then play back the timeline to 
review your animation.

TIP  Changing the Render cache format will re-render all previously cached 
frames for your entire project.
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In Lesson 1 you generated lower-resolution proxy files as part of the edit prep process. 
Such files, when combined with smart caching, can vastly improve performance when 
working with high-resolution clips, complex multi-layered timelines or interframe-
compressed video formats, such as H.264. 

Adjusting Keyframes
Now that you have playback performance at a point where you can evaluate the 
effectiveness of your animation, let’s review and adjust the timing and acceleration of that 
animation. At present, the animation begins a little too early. The on-screen interview 
appears as black frames as the animation starts. If you move the keyframe later, your 
interview clip should be on-screen just before the animation gets to her. 

1	 In the lower-right corner of the compound clip, click the diamond-shaped keyframe button.

TIP  Another way you can begin to assess how an animation is working is to open 
the compound clip in the timeline and disable groups of clips or tracks. In doing so, 
less media being is played, and you will be reducing Resolve’s workload. Once you 
have finalized the keyframes timing, you can begin to re-enable the clips or tracks 
within the compound clip and let Resolve cache the resulting animation.
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The Keyframes editor appears directly under the compound clip in the timeline.  
The two white diamond icons represent the current positions of the keyframes  
you’ve added.

2	 To change the start of the animation, select the first keyframe in the Keyframes editor.

When a keyframe is selected, it turns red to show that you can drag it earlier or later in 
the timeline.

3	 Drag the keyframe to the right until the tooltip displays 2:00. This should place it right 
as the on-screen interview can be heard. 

4	 Repeat this process with the second keyframe, moving it to the right until the tool tip 
reads 3:00.

Now, you’ll add an ease-in/ease-out acceleration to the ending keyframe to create 
a smoother landing for the animation.

5	 In the timeline viewer, click the onscreen control menu, and choose Transform.

TIP  You can reveal the Keyframes editor by selecting the clip on the timeline 
and choosing Clip > Show Keyframe Editor or pressing Shift-Cmd-C (macOS) 
or Shift-Ctrl-C (Windows).

TIP  You can Cmd-click (macOS) or Ctrl-click (Windows) multiple keyframes 
to select them, and move them together.
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6	 In the timeline viewer, zoom out of the image. 

You can now see the motion path created by the keyframes you’ve added to the 
compound clip, along with the usual on-screen controls for the clip’s anchor point, 
rotation and zoom.

7	 Click the motion path’s keyframe on the right to select it. (This is your first keyframe on 
Animation comp 01, the animation’s starting point, where the compound clip had been 
moved left across the screen). Right-click the control point, and choose Smooth. 
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A Bézier spline handle is added to the path, allowing you to modify the curvature of the 
path and also to increase or decrease the ease-in, or smoothness, of the motion path. 
The outer handle allows you to modify the shape or curvature of the path. The inner 
handle controls the acceleration of the animation.

8	 Drag the outer control slightly to the right, bringing it closer to the keyframe and then 
adjust the inner handle further to the right.

See how the dots along the motion path adjust to these changes? This behavior will 
help smooth the beginning of the animation so it doesn’t begin moving abruptly.

9	 Repeat these steps to smooth the animation of the second keyframe (to the left of  
the screen).
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10	 Return the timeline zoom pop-up to Fit, and turn off the transform on-screen controls. 
Allow time for the new animation to cache, and then play it to see the smoother start 
and end to the animation. 

Now the motion path has a nice, smooth landing as the animation ends.

You can also see the curve editor for this animation in the timeline.

11	 In the lower-right corner of the compound clip in the timeline, click the curve editor.

This displays the curve controls below the Keyframes editor underneath the clip in  
the timeline.

12	 In the upper-left corner of the curve editor, click the pop-up menu, and choose the 
Position X control.

TIP  If you need to clear the current render cache so you can see your 
changes, select the compound clip in the timeline, and choose Playback > 
Delete Render Cache > Selected Clips.
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13	 Select the first keyframe for Position X to see the Bézier handle.

In the curve editor, you can further refine your animation’s motion path, and edit X and 
Y position keyframes independently.

14	 Once again, allow time for the new animation to cache, and then play it to see any 
changes you’ve made to the animation. Refine further to suit yourself.

Animation is so full of creative possibilities that it can be tempting to add elements just for 
the sake of watching them on the screen. However, animation and graphics added “just for 
fun” typically detract from the overall impact of a message. Unnecessary elements can 
often increase confusion when they should instead bring clarity to your message. 

As a result, when you create a motion graphics animation for promos, think through every 
visual element and the way it will move. Make sure that each creative and technique choice 
the overall communication of the project, as well as the individual scene to which it belongs. 
By doing so, you should be able to create a more appealing design and maximize its impact.

TIP  The checks next to parameters indicate that keyframes have been added 
to those parameters.



239

Le
ss

o
n

 R
ev

ie
w

Lesson Review
1	 What will happen to a four-second source clip that is edited into a two-second marked 

section of the timeline using a Fit to Fill edit?

A) Only the first two seconds will be used in the timeline.

B) The clip will be retimed to 50 percent of its original speed.

C) The clip will be retimed to 200 percent of its original speed.

2	 True or False? The Replace edit will respect in and out points set in the source viewer.

3	 How do you create a compound clip?

A) �Set in and out points around the clips in the timeline, and choose Clip > New 
Compound Clip.

B) Select the clips in the timeline, and choose Clip > New Compound Clip.

C) Click the New Compound Clip button in the Media pool

4	 How can you edit the contents of a compound clip?

A) Right-click the compound clip, and choose Decompose in Place.

B) Right-click the compound clip, and choose Open in Timeline.

C) Right-click the compound clip, and choose Open in Tab.

5	 Where do you adjust the timing of keyframes that have been added to timeline clips?

A) In the Keyframe controls in the Inspector

B) In the Keyframes editor of the Timeline

C) In the clip’s Keyframes editor 
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Answers
1	 C. The source clip will overwrite the contents on the destination track and be retimed 

to 200 percent of its original speed.

2	 False. The duration in the timeline being replaced can be set with in and out points, 
but the replace edit will ignore any in or out points set in the source viewer as it aligns 
the frame at the position of the source playhead with the timeline playhead.

3	 B. Select the elements in the timeline that you want to place within the compound clip. 
Choose Clip > New Compound Clip; or right-click the selected clips, and choose New 
Compound Clip.

4	 B. Right-click a compound clip in the Media pool or the timeline, and choose Open in 
Timeline. Alternatively, choose Clip > Open in Timeline.

5	 C. Click the keyframe button in the lower-right corner of the clip. Alternatively, you can 
select the clip, and choose Clip > Show Keyframe Editor; or press Cmd-Shift-C (macOS) 
or Ctrl-Shift-C (Windows).



Lesson 8

Creating Graphics 
in Fusion

Fusion is an advanced compositing 
application built directly into the 
DaVinci Resolve 15 interface. It employs a 
node-based approach to compiling visual 
effects and motion graphics, which is the 
preferential method in film and television 
industries due to its superior quality, flexibility 
and efficiency. Editors can use Fusion to 
create custom titles and credit sequences, 
insert missing elements into a scene and 
cover-up continuity issues.

As Fusion is located directly in DaVinci Resolve, 
switching between editing, grading, audio 
mixing and compositing is a seamless 
process. It is no longer necessary to 
transcode or pre-render media. Instead, you 
click on the page you need to immediately 
switch to the necessary toolset. The 
exercises in this chapter are designed to 
familiarize you with the Fusion Page interface 
and some of its fundamental operations, like 
merging nodes, creating rolling credits, 
tracking clips, and keying green/blue screen. 

Time

This lesson takes approximately 
90 minutes to complete.

Goals

Navigating the Fusion Page Interface	 242

Understanding the Node Editor	 244

Using Text and Merge Nodes	 249

Creating Rolling Credits	 259

Tracking a Scene	 265

Keying and Compositing	 270

Lesson Review	 279



242

N
av

ig
at

in
g

 t
h

e 
Fu

si
o

n
 P

ag
e 

In
te

rf
ac

e

Navigating the Fusion Page Interface
To begin creating custom graphics and composites in Resolve, all you need to do is click 
on the Fusion page icon at the bottom of the software. This quick exercise will take you 
through the Fusion interface and identify the layout and functionality of its panels.

The project used for the exercises in this chapter will be based on a series of shots from 
the short sci-fi film ‘Sync’.

1	 In the project manager, right-click, and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 07 VFX. 

2	 Select R15 Editing Lesson 08 VFX.drp, choose Open, and click OK to import the 
project into your project manager. 

3	 Open the project and relink media files.

4	 On the Edit Page, ensure 01 Fusion timeline is open, and the playhead is on the first clip. 

To work on a specific clip in Fusion, the playhead needs to be placed over it on the Edit 
page timeline. If there are multiple video tracks, the top-most clip will be sent to Fusion 
for compositing.

5	 Click the Fusion page icon at the bottom of the software interface, or press Shift-5 to 
launch Fusion.

Viewer 1

Work Area Toolbar Inspector

Viewer 2
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Fusion is divided into four main sections. The two viewers at the top can be used to 
show the output of any node in the pipeline. Directly under the viewers is a time ruler 
with playhead controls. In the middle of the page is the toolbar, where you can access 
the most commonly used tools and effects. The large work area at the bottom is used 
to construct and animate composites via the Node, Keyframe and Spline editors. The 
Inspector on the right side of the page contains the adjustable parameters for any 
selected node.

6	 The main work area currently displays the Node editor. The Keyframe and Spline 
editors can be activated in the work area by clicking their respective buttons in the 
Interface Toolbar at the top of the page.

To move around the work area, hold the middle mouse button and drag inside the panel.

TIP  To zoom in and out of the work area editors, press the Cmd key (macOS) 
or the Ctrl key (Windows) and scroll the middle mouse wheel.

7	 Underneath the Viewers, drag the red playhead line to scrub through the clip.

Note the green lines that appear under the frames of the time ruler. These represent 
the portions of the video that are cached. To see a composite in real time, you must 
first play the video through until all frames are cached. Once the time ruler is solid 
green, it will playback in real time. 

TIP  You can allocate more RAM to the Fusion page using the Fusion memory 
cache setting located in Preferences >System>Configuration.

The yellow lines on either side of the time ruler define the render range. This is the 
duration that will be used for playback, caching, previews and final rendering. In longer 
takes, you might want to drag the yellow bars to shorten the render range and focus 
only on the composited areas for faster preview. 

TIP  Use square brackets [ and ] to navigate up and down the timeline by 1 
frame. Move the playhead to the start and end of the render range by pressing 
Option-[ or ] (macOS) or Alt-[ or ] (Windows).

Now that you are familiar the time ruler and can navigate in the node editor, you can 
begin adding nodes to the pipeline.
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Understanding the Node Editor
As with all node-based compositing interfaces (including the node editor in the Color Page 
of DaVinci Resolve), the order and placement of the nodes in the pipeline has great 
significance. The RGB signal flows through the various media and image processing 
operations in the node editor before it reaches a final output node.

This method of compositing requires some practice to fully grasp, but is ultimately more 
processor efficient and versatile than layer-based systems.

The next set of exercises will familiarize you with the signal pipeline and the impact that 
node order has on it.

Assigning Media Nodes to the Viewer
You can change the behavior of the viewers in the Fusion page based on the stage of your 
workflow that you want to focus on. In this exercise, you will assign viewers to different 
nodes for preview.

1	 Any clip or image file that you bring into the Fusion page is represented by a MediaIn 
node. In the current node editor, the MediaIn1 node is connected to the source video 
file of clip 1 in the timeline. 

The MediaOut node is the final output of the signal flow and represents how the image 
will look upon delivery.

Select MediaIn1 and press 1 on your keyboard to send the signal of the source video 
to viewer 1.

The two dots under the nodes represent which node is being shown in which viewer. 
To change what the viewers display, click any node in a pipeline and press 1 or 2 on 
your keyboard, or click directly on the dots underneath the nodes.

TIP  When using a 3rd display, like a full screen broadcast monitor connected via 
a Blackmagic Design UltraStudio or DeckLink card, you will see three dots under 
the nodes. Pressing 3 will display the node in full screen in the grading monitor. 
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2	 To maintain order and ease navigation within the node editor, you can rename your 
nodes. Right-click MediaIn1 and choose Rename or press F2 to reveal the rename tool.

3	 Enter the name SYNC_SHOT.

TIP  Spaces are not displayed in the node labels of the Fusion page. 
Create separation between words with capital letters or an underscore.

4	 Rename MediaOut1 as OUTPUT.

With the media assigned and labelled, you can start to add additional nodes 
between them. 

Adding a New Node
Nodes are essential to manipulating the image in the Fusion page. There are a wide variety 
of node types – some alter the pixel data of the image, some control its movement and 
behavior, and others generate RGB data that is added to the existing image. 

NOTE  In Fusion, nodes that affect the behavior of a signal are also referred to as 
tools. In these exercises, both terms will be used based on function. 

There are several ways in which tools and nodes can be accessed and added to a 
composite. One way is to use the Effects Library panel, in which the tools are clearly 
labelled and categorized. 

In this exercise you will resize and reframe the first shot in the timeline to change its 
narrative.

1	 Open the Effects Library panel.

2	 Expand the Tools folder and enter the Transform category. 
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3	 Drag the Transform tool onto the connection between SYNC_SHOT and OUTPUT 
in the node editor.

4	 Click the Effects Library button again to hide the panel and make more room for 
the viewers.

At the moment, the scene in the viewer is building tension by showing the growing line 
of these ‘sync’ surveillance machines. They take up the majority of the frame, and are 
presented as an imposing group. 

In this quick exercise, you will change the narrative of the scene by resizing and 
reframing the shot. The aim will be to get the audience to connect with the character 
in the middle.

5	 Select the Transform node. 

6	 In the Inspector, increase the Size to about 1.2.

7	 Use the on-screen controls in viewer 2 to push the video to the left. Your goal is to move 
the central character to the left third of the screen, giving them a stronger screen presence.

Note that only viewer 2 shows you the result of this change. This is because viewer 1 
is currently set to show you the state of the SYNC_SHOT source, which is not being 
affected by the transform node.
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This has left the final image with a significant gap on the right side of the screen. 
You can fill this gap by stretching the RGB data on the right side of the shot. This is only 
advisable in shots where there are no moving elements, and the data is either out of 
focus, or a solid/gradient color.

8	 Open the Effects Library.

9	 Expand Tools > Warp and click on Grid Warp. 

This will add the Grid Warp tool directly after the Transform node.

10	 You can use the Grid Warp to stretch pixel data in the viewer. At the moment, there are 
too many divisions to be able to stretch the data to a satisfactory degree.

In the Inspector, change the X Grid Size to 2. This will decrease the divisions down to 2 
columns, which will allow you to use the entirety of the data on the right-hand side of 
the shot.

11	 Press the Cmd key (macOS) or the Ctrl key (Windows) and scroll the middle mouse 
wheel to zoom out of viewer 2. 

12	 Press the Cmd key (macOS) or the Ctrl key (Windows) and drag across the side of the 
grid to select all the points in the right-most column.
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13	 Hold Shift-Alt on your keyboard and press the right arrow key to move the edge of the 
column off the screen.

This will stretch the pixel data on the right side of the image. Continue to stretch the 
grid until the gap on the right is completely filled up.

The scene now has a different feel to it – as the audience, we are now connecting 
much more strongly with the central character. 

This reframed shot is now ready to be viewed back in the timeline of the Edit Page. 

14	 Click the Edit page icon at the bottom of the software interface, or press Shift-4.

Note that the changes you have made have been immediately applied to the clip. 
No rendering or exporting was required. 
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A symbol in the bottom-right corner of the clip indicates that it has been composited in 
the Fusion page. 

15	 Return to the Fusion page.

Warp tools can be used to create dramatic results, but they are also capable of more subtle 
application, like when realistically extending the edge of a frame.

Using Text and Merge Nodes
Nodes that act as tools can be connected directly to the node pipeline. When you want to 
introduce additional media layers to a composite, or add nodes that are generators of RGB 
data (such as text nodes or solid backgrounds), you will need to make use of merge nodes.

Switching Between Clips
For the next exercise, you will first need to switch to a new clip on the timeline. We saw at 
the start of the chapter that you can accomplish this by placing your playhead over the 
relevant clip in the timeline on the Edit Page. But there is also a way to switch between 
clips inside the Fusion Page.

1	 Click the Clips button at the top of the page to open the thumbnail timeline. 

2	 Select clip 2.

The Fusion page will load the new clip, and show you a blank composition pipeline 
consisting of just the MediaIn and MediaOut nodes.

Notice that you can right-click on any thumbnail in the timeline to reveal new 
composition controls. Use these controls when you want to attempt a new version of 
a composite, but do not want to lose your previous work.

3	 Click the Clips button again to hide the timeline and make more room for the Node 
Editor and Viewers.

With the relevant clip selected, you can now begin to composite the opening title 
graphics over it.
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Adding Text to a Composition
When adding additional media to a pipeline, you need to specify how it will relate to the 
existing composite in terms of its layer structure. Merge nodes allow you to combine the RGB 
data of multiple media streams, with dedicated inputs for foreground and background elements.

In this exercise, you will design the opening text graphic for the film ‘Sync’.

1	 Open the Effects Library and locate Tools > Generator.

2	 Drag the Text+ tool into an empty part of the node editor, above MediaIn1.

The Text+ node appears in the graph, but does not yet have a relationship with the 
connection line between the MediaIn and MediaOut nodes, and so will not have an 
impact on the image in Viewer 2.

To layer the Background over the video, you will need to use a Merge node.

Although the Effects Library includes the full range of tools, you can access the most 
common tools in the toolbar above the Node editor. The toolbar is divided into six 
categories. From left to right the categories are: Generators, Color, Transforms, Masks, 
Particles and 3D.

Clicking on any tool in the toolbar inserts it directly after the selected node. This make 
it very easy to add nodes precisely where you need them without having to manually 
connect them.

TIP  Hover your mouse over the icons in the toolbar to see the names of 
the tools. 

3	 With the MediaIn1 node selected in the node editor, click the merge tool in the toolbar.

Generators Color Transforms Masks Particles 3D
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The merge node appears in the editor. It has three color-coded inputs: background 
(yellow triangle), foreground (green triangle), effect mask (blue triangle) and one output 
(white square).

4	 Click the output of the Text1 node and drag it to the Merge node to connect them.

With the Text node selected, you can now enter and customize the text that appears 
over the video clip.

NOTE  The merge node is one of the most essential and frequently used 
tools in the Fusion page. In each merge node, the yellow connector always 
represents one background layer and the green connector is always a 
foreground. Every time you want to add additional layers to a composite, 
you need to create a new merge node and link the respective foreground 
and background layers along the node pipeline.

5	 In the Inspector, enter the film title SYNC into the Styled Text field.

6	 Use the drop-down menu to set the font to Open Sans and give it a Regular weight.

7	 Increase the size of the text slightly (0.125) to make it easier to read on the screen.

Foreground Input

OutputBackground 
Input

Effect Mask Input
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TIP  The small gray dot under any parameter shows the default position of that 
slider. Clicking the gray dot resets the slider to the default position.

8	 Increase the tracking (1.100) to space the letters further apart.

9	 Use the on-screen controls to move the position of the text into the lower-right. Placing 
it over the building in the foreground will give it a good amount of contrast and make 
the text ‘pop’.

At the moment, the text is plain white. You can use the swatch under the Font field 
to change the text to a different solid color. For more advanced controls of the text 
appearance, including adding outlines and shadows, you will need to use the Shading 
tab in the Inspector.

Using Shading Elements to Customize Text
Visual configurations of text nodes are known as shading elements. By default, when you 
create a new text node, there is only one shading element which defines the fill type and 
color of the text.

1	 Click the Shading tab button at the top of the Inspector.

2	 Under the Properties heading, change the fill Type to Gradient.

You can now use the Shading Gradient bar to specify which colors will appear in the 
gradient fill of the text. The default setting is a black-to-white gradient.

3	 Click the triangle on the left side of the gradient bar, and then use the color picker 
underneath to set its color to dark grey.
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4	 Click the triangle on the right side of the gradient bar, and set its color to light grey.

5	 Click on the gradient bar itself to add a new swatch triangle on the left half of the 
gradient. 

6	 Use the color picker to set the middle gradient color to white.

The resulting gradient should look like brushed metal.

To make the text stand out against the background a bit more, you can also add a 
soft shadow. To accomplish this, you will need to create a new shading element and 
designate it as a shadow.

7	 Click the Select Element drop-down menu at the top and choose 2.

8	 Click Enabled to open the shading element controls.

Shading elements can be modified in a multitude of ways – you can use the 
Appearance controls in the Properties segment to specify a starting point like Text Fill, 
Text Outline, Border Fill, or Border Outline.

However, the numbered elements also have some default behaviors. As you can see, 
element 2 begins as a red outline. To save time, you can activate shading element 3, 
which always starts off as a drop shadow.

9	 Unselect Enabled to disable shading element 2.

10	 Select Element 3 and click Enabled. This reveals the default text shadow.

11	 Lower the Opacity to 0.5 to make the shadow softer against the background.

12	 To better blend the text into the scene behind it, you can activate a composite mode 
in the merge node.

NOTE  Composite or blend modes refer to processes in which two layers are 
combined using an algorithm that adds, subtracts, multiplies or divides their 
respective luminance or chrominance pixel values. Blend modes are often 
used in graphic design, or for light/shadow-based visual effects. 

Select the Merge node.

13	 Change Apply Mode to Hard Light.
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This will blend the darker elements of the foreground (the edges of the gradient), while 
retaining the brightness of the lighter elements.

With the text in place, you can now start animating its parameters to make its appearance 
on screen more dramatic.

Keyframing Parameters
You can change the value of a parameter over time by using the keyframe controls in the 
inspector. In this exercise, you will change the opacity and scale of the text as it appears, 
and then refine the gradient to give it a dynamic shine. You will then use the keyframe 
editor to refine your animations. 

1	 When animating motion graphics, it’s often a good idea to start at the end, where your 
graphics are set to their final position.

On the time ruler, move the playhead to frame 75.

2	 One of the most common animations for text is to change the opacity, creating a fade-
in effect.

With the merge node still selected, click the keyframe icon next to the Blend parameter.

This will lock the value of the blend parameter to that moment in time.

3	 Drag the playhead to the beginning of the clip (frame 58).

4	 Change the Blend parameter to 0.0.

The text will disappear from the screen.

5	 Drag the playhead across the time ruler to see the text slowly fading in.

You can also animate physical properties of the text – like size or rotation. Any 
parameter with the keyframe icon next to it is capable of being animated.

6	 Select the Text node.

7	 In the Inspector, enter the Transform tab.

At the bottom, the individual X and Y size parameters allow you to stretch or compress 
the text on a vertical or horizontal scale. You are going to animate the X Size parameter 
to have the individual characters expand into their final positions.

8	 Move the playhead to frame 75.
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9	 Press the keyframe next to the X size parameter.

10	 Drag the playhead to the beginning of the clip.

11	 Change the X Size value to 0.0.

12	 Drag the playhead across the time ruler to check the animation. The characters now 
fade in, as well as scaling horizontally.

Finally, you can also animate color values. You will adjust the behavior of the gradient 
to give the illusion of a white highlight travelling down the letters.

13	 Enter the Shading tab.

14	 Move the playhead to the end of the clip (frame 92).

15	 Press the keyframe next to the Shading Gradient bar.

16	 Drag the playhead to the beginning of the clip.

17	 Drag the center of the gradient (the white triangle swatch) to the right side of the gradient.

Watching back the animation, the highlight will appear to react to the ‘spinning’ effect 
of the letters. However, the speed of the opacity fade and the rotation appears too 
slow. Let’s refine the speed of these two parameters.

18	 Click the Keyframes button in the interface toolbar.

TIP  Press Cmd-F (macOS) or Ctrl-F (Windows) to expand the size of the 
Keyframes or Splines editors to accommodate all the node animations.

19	 Expand the Merge1 and Text1 headers. These will reveal all the parameters you have 
animated, and their respective keyframes.

20	 Drag the first keyframes (white horizontal lines) of the Blend and CharacerSizeX 
parameters to start on frame 65 of the time ruler.



256

U
si

n
g

 T
ex

t 
an

d
 M

er
g

e 
N

o
d

es

When you play back the animation now, there will be a pause before the letters start to 
fade in. The speed of both the rotation and opacity will be increased due the keyframes 
being closer together. 

As you can see, most keyframing can be accomplished directly from the inspector, 
using the time ruler as a reference for placement of keyframes. To make refinements, 
or to ease the speed of animation, you can access the Keyframe and Spline editors 
to gain more control over the behavior of the keyframes.

Adding Effect Nodes to the Pipeline
In this exercise, you will add a lighting effect to the gradient and a simple blur tool to imitate 
a shallow depth of field. An important question to ask yourself when adding new tools is 
where in the pipeline the node should be placed to give you the result you need.

1	 Open the Effects Library.

2	 Expand OpenFX and select ResolveFX Light. You will add an effect to the text to 
enhance the travelling gradient, turning it into a shard of light.

For this to work, the effect needs to be placed directly after the text node.

3	 Drag the Aperture Diffraction effect onto the connection between the text and 
merge nodes.

4	 At first, the light will look distorted. You need to refine the effect parameters to correctly 
impact the gradient values.

5	 Increase the Result Gamma (3.0) to concentrate the brightness to the text gradient 
highlight.

6	 Reduce the Result Scale (0.400) to limit the diffraction to a smaller area.

7	 Reduce the Brightness (0.11) in the Compositing Controls to make the reflection 
more realistic.
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To further enhance the text composite, you’ll blur the image in the background to 
imitate shallow depth of field. Review your node pipeline and think about where the 
blur tool needs to be placed. 

�� If it is placed after the merge node, both the text and image will be blurred. 

�� If it is placed after the Aperture Diffraction, only the text will be blurred.

�� The blur tool needs to be placed after MediaIn1 to only affect the background video.

8	 Select MediaIn1.

9	 Click the Blur tool button in the toolbar – it is the last button in the Color category.

10	 Increase the Blur Size (10.0) until the image appears out of focus.

The text now stands out, but too much interesting information has been removed by 
the blur. Ideally, we’d still want the audience to see the spaceship in the background.

In the next exercise, you will use a mask to define which area of the image will be 
affected by the blur tool, and which area will be left in ‘focus’.

When adding new nodes to a pipeline, you will occasionally need to pause and think 
about how various stages of the signal will be impacted. Occasionally, some 
experimentation may be necessary to review how the node impacts the final 
composite. Over time, this workflow becomes more intuitive and the placement of 
nodes more apparent.

Using Masks to Target Effects
With the effect in place, you can now use a mask node to isolate which region of the image 
the tool affects. Mask nodes can be made based on preset shapes (rectangles, ellipses), 
custom drawn (polygons, b-splines), animated, or even based on luma/chroma data.

1	 With the blur node still selected, click the Ellipse mask in the toolbar. 
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The blur effect becomes contained within a circle in the viewer. To create the effect of 
soft focus, you will need to invert the circle, and then soften its edges.

2	 Select the Invert checkbox in the Inspector.

3	 Increase the Soft Edge (0.18) setting to blur the circumference.

4	 Scrub through the time ruler to check the position of the spaceship. 

5	 Use the controls in the viewer to adjust the position and size of the circle mask to keep 
the spaceship in focus throughout the shot.

Masks have a wide range of application when it comes to compositing. They are frequently 
employed in motion graphic design to achieve specific shapes and animations, they are 
frequently combined with chroma key workflows to eliminate unusable parts of a green 
screen, and they are also used for rotoscoping workflows, in which a subject is carefully 
traced to allow another image or video layer to be placed behind them.
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Creating Rolling Credits
With an understanding of node pipeline construction, you can now start to look at more 
dedicated industry motion graphic workflows. For example, depending on production 
scale and budget, it is frequently the role of the editor to create rolling credits at the end 
of a film. This can be easily accomplished in the Fusion page with the help of a text node, 
a keyframed transform node and some dedicated text parameters.

Generating a Blank Fusion Composition
First, you will need to create a blank Fusion composition to act as the foundation of your 
credit roll animation. 

1	 Click the Edit page icon at the bottom of the software interface, or press Shift-4.

2	 Open the Effect Library from the interface toolbar at the top of the page.

3	 Expand the Toolbox bin and select Generators.

4	 Drag the Fusion Composition generator to the end of 01 Fusion timeline.

5	 To adjust the duration, right-click the Fusion composition clip on the timeline and 
select Change Clip Duration.

6	 Change the clip duration to 00:00:15:00.

This will extend the blank Fusion composition to 15 seconds.
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7	 With your playhead on the Fusion composition, enter the Fusion Page.

This time, the node editor will only have a single MediaOut1 node. Unlike the previous 
exercises, there is no associated source media in the Fusion composition.

8	 Drag the text tool from the toolbar onto an empty part of the node editor.

9	 Connect the text tool output to the MediaOut1 input.

10	 Enter the film title Sync into the Styled Text box of the Inspector.

11	 Press the enter key two times and write Written and Directed by Hasraf Dulull.

12	 Leave the font as Open Sans, but change the weight to Regular.

13	 Reduce the font Size to 0.05

These are the two lines of text that you will want to keep centered. All the following 
credits, listing the actors and their roles need to be placed into columns. 

Using Tab Spacing to Align Columns
Traditional rolling credits tend to appear as two columns of text aligned at the center. 
A parameter in the text node inspector allows you to quickly define and align columns of 
text within a single node.

1	 Press the enter key two times under the director’s line in the Styled Text box.

2	 Type Martin Batchelor Sync
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3	 Press enter and type Dean S. Jagger FBI Agent Jenkins

At the moment, the two actors’ lines appear centered and difficult to read. Tab spacing 
will allow you to define the alignment of their names and roles. You can use the tab key 
on your keyboard (usually above the Caps Lock) to define multiple columns in your text.

4	 Click in front of Martin Batchelor’s name in the Styled Text box and press the tab key.

5	 Click in front of Dean’s name and press the tab key.

To define the second column in the credits, you will need to click in front of the roles 
and press the tab key again.

6	 Click in front of the word Sync and press the tab key.

7	 Click in front of FBI and press the tab key.

You’ve defined the columns, but the text appears to look worse in the viewer! This is 
because you have not specified the position or alignment of the columns.

8	 At the bottom of the Inspector, expand the Tab Spacing category.

9	 Under Tab 1, change the Position to -0.03.

10	 Drag the Alignment all the way to the right (1.0) to line up the names.

11	 In the drop-down menu next to Tab, select 2 to adjust the second tab column.

12	 Change the position to 0.03.
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13	 Drag the Alignment all the way to the left (-1.0) to line up the roles.

The actors’ names now have a right alignment against the roles’ left alignment. You can 
enter the rest of the names from this short film to compete the credits.

14	 Open the R15 Editing 201 > Lessons > Lesson 08 VFX folder and launch Sync_Credits.rtf.

15	 Copy the remainder of the cast list and paste it into the Styled Text box under the two 
lines you have already entered.

The tab information from the text document should travel across and automatically 
place the actors and roles into their respective columns. If it does not, use the tab key 
to define the columns in the Styled Text box.
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When preparing credits for a film, you can pre-emptively start defining the columns by 
pressing tab in front of names and roles. Tab information will carry across from most 
word editors and can immediately be used to define the position of credit columns.

Adding a Logo to a Credit Roll
As a finishing touch, you will merge a logo to the end of the credits sequence and use a 
transform node to have it scroll together with the text layer.

1	 Open the Media Pool.

2	 Enter the media bin and drag Blackmagic_Design_alpha_logo.png into the node editor.

3	 Drag the output of the logo node to the output of the text node.

When connecting the output of one node to another, you automatically generate a 
merge node that will treat the first node as the foreground layer.

4	 Rename MediaIn1 as LOGO.

5	 The logo is too big and is overwriting the credits. You can use a transform node to 
resize and reposition the logo.

With the LOGO node selected, press the Transform node in the toolbar.

6	 In the inspector, decrease the size to 0.60.

7	 To make it easier to see where you are placing the logo, zoom out of the viewer until 
you can see the grey area around it.
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8	 Drag the Center Y parameter in the inspector, or use the on-screen controls to lower 
the logo under the credits.

With all the elements in place, you can now animate the credit scroll. The best place 
to do this will be in a transform node added after the merge, which will treat the credit 
and logo as a single combined layer. 

9	 Add a Transform tool after the merge node.

10	 Drag the playhead to the first frame (0.0) of the composition.

11	 Lower the Center Y value until the top of the credits are beneath the bottom of 
the viewer.

12	 Press the keyframe next to Center Y to activate keyframing.

13	 Drag the playhead to the last frame (359.0) of the composition.

14	 Raise the Center Y value until both the credits and logo are off screen at the top of 
the viewer.

15	 Playback the animation to check your credit scroll.

Credits and logos can be combined in numerous configurations using multiple merge 
nodes and a universal transform control. 
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Tracking a Scene
Tracking refers to a process in which the software detects the motion of a camera or subject 
based on the changing pixel values in a video clip. Once tracking data is extracted, it can 
be applied to other layers to create the illusion of those elements being part of the scene.

Tracking is a vital component of all compositing workflows that feature moving footage - 
whether you are inserting a 3D character, putting up a poster, replacing a screen or removing 
film equipment from a scene. 

Creating a Fusion Clip in the Edit Page
When editing media that is intended for compositing – for example green screen and 
backplate footage - it is usually the role of the editor to define the cut points of both media 
clips. This tends to be easiest to do on the timeline of the Edit page.

Once the clip lengths are determined, they can then be transformed into a Fusion clip, 
where they will appear merged and ready for compositing on the Fusion page. 

1	 Click the Edit page icon at the bottom of the software interface, or press Shift-4.

The third clip in the timeline features a video of a presenter on stage with a robot 
graphic on the video track above it it. You’ll being by rescaling and repositioning the 
graphic before proceeding to the Fusion page. 

2	 Select the robot graphic clip.

3	 Open the Inspector in the Edit Page.

4	 Lower the opacity to 50.00 to see through to the background image.

5	 Click the Transform button in the lower-left corner of the viewer.

6	 Use the on-screen transform controls resize and reposition the robot onto the stage.
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7	 Set the opacity back to 100.00.

8	 Select both the robot graphic and clip 3 on the timeline.

9	 Right-click and choose New Fusion Clip.

10	 Enter the Fusion page.

The two clips will now appear merged in the newly created Fusion clip.

11	 Rename the clips as BACKPLATE and ROBOT.

To remove the black background from the robot graphic, you will use a blending mode 
that subtracts dark areas from a foreground layer.

12	 Click the merge tool and set the Apply Mode to Screen.



267

Tr
ac

ki
n

g
 a

 S
ce

n
e

With the clips merged in the Fusion page, you can now proceed to track the backplate 
and apply the data to the foreground graphic.

Using the Tracker Node
The tracker tool allows you to define a specific area in the frame that is a reliable reference 
for the movement of the camera, or to a visible item in the shot. Ideally, you want to specify 
an area that is always in shot, and located on the same plane as the object you wan to add 
to the scene.

1	 Drag the playhead to the first frame of the clip in the time ruler. This will make it easier 
to perform a track, as you will only need to analyze the footage in one direction.

2	 Select BACKPLATE to indicate the media you wish to track.

3	 In the Effects Library, locate the Tracking folder and click on the Tracker tool node.

Tracker1 appears between the BACKPLATE and merge node. A green tracker outline 
appears in viewer 2.

Hovering over the tracker in the viewer reveals two boxes. The inner box defines the 
‘pattern’ that the program will search for in every frame of the clip. The outer box is 
the search area within which the program will search for the pattern. If the pattern 
travels beyond the confines of the search area from one frame to the next, the track 
will be unsuccessful.

When performing pattern selection, aim to pick an area with high contrast, sharp focus 
and reliable movement in relation to the scene. The search area must also be reshaped 
to match the projected movement of the clip (i.e. a larger search area is necessary for a 
clip with rapid movement). In both cases, the larger the box, the longer the analysis will 
take to perform.

4	 Click the upper-left corner of the tracker and drag it down onto the lower-right corner 
of the projection screen in the shot. The dark geometric shapes against the white 
surface make an ideal tracking pattern.
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5	 Drag the lower-right corner of both boxes to expand the size of the pattern and elongate 
the search box in preparation for the panning camera motion.

6	 At the top of the Inspector, click the Track Forward button.

Keep an eye on the pattern as the track is performed. If the tracker loses its place 
at any point, its best to terminate the action instead of continuing with an unusable 
track analysis.

7	 A pop-up window will verify if you want to stop the render. Click Yes to confirm.

TIP  Double clicking in an empty gray space in the node editor will temporarily 
hide on-screen controls. Select the tracker node to return the on-screen 
controls to the viewer.

Next, you will apply the gathered tracking data to the robot to match its movement 
to the motion in the background.

8	 Click on the Operation tab at the top of the inspector.

9	 Change the Operation to Match Move.

10	 Change the Merge option to FG over BG. This specifies to the tracker that any 
foreground element will be match moved to the motion tracked in the background.

At the moment, the tracker node does not have a foreground signal.
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11	 Drag the output of the ROBOT node to the green foreground input of the tracker.

12	 Like the merge node, the tracker node also offers blending mode options. Change 
the Apply Mode in the inspector to Screen in order to blend the robot graphic into 
the backplate.

Since the tracker is now performing the function of merging and blending the graphic, 
the merge node has become redundant.

13	 Delete the merge node.

14	 Drag the playhead through the time ruler to verify that the track has been successful.

15	 To better blend the graphic into the background, add a blur node after the ROBOT 
node and leave the gentle default blur size 1.0.

16	 Drag the Color Corrector tool from the toolbox and attach it to the connection after 
the blur node.

17	 In the inspector, drag the master wheel towards cyan to make the graphic a greender 
shade of blue.

You can also add another Transform tool to the ROBOT connection line to make changes 
to the scale or positioning of the graphic.

Match moving is the central principle behind placing artificial elements into a scene with 
camera movement. Amongst its most popular applications is sky replacement, sign 
removal, cover-up and paint work, compositing of 3D characters and vehicles, and much, 
much more.
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Keying and Compositing
Chroma keying refers to any process in which a portion of the frame is targeted based on 
its color properties. Most frequently, this is associated with removing blue or green screen 
to leave the foreground subjects on a transparent background. These subjects can then be 
placed over any other layer, giving filmmakers complete control over their environment.

Pulling a Key
In this exercise, you will key a subject from a portable blue screen and place them into a 
new environment. 

1	 Go to the Edit Page.

2	 Select Blue Key Clip and Clip 4 on the timeline, right-click and choose New Fusion Clip.

3	 Rename MediaIn1 as BACKPLATE and press 1 to view it in the left viewer.

4	 Rename MediaIn2 as BLUESCREEN and press 2 to view it in the right viewer.

As you can see, the BACKPLATE node features an interior background onto which you 
want to composite the character. The BLUESCREEN node features the shot of the 
character in front of a portable chroma blue screen. The first step in this composite 
will be to key out the blue screen. 

5	 Select the merge node and press 2 to view it in the right viewer.

6	 Select the BLUESCREEN node.

So far, you have been adding new tools and nodes using the Effects Library and 
the toolbar. There is a third way to quickly add nodes to pipeline with the help of a 
simple shortcut.

7	 Press Shift-spacebar to bring up the Select Tool dialogue window.

8	 Type delta into the search bar at the bottom.
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The Select Tool will filter any tools that contain a search term as you type. This is one 
of the quickest ways to add nodes to the editor, provided you already know their 
names beforehand.

9	 Select Delta Keyer (DK) and press Add.	

10	 To extract the blue screen, click and hold the eyedropper tool next to the Background 
Color swatch in the inspector, and drag your mouse across to viewer 2. 

Release your mouse over the blue screen to grab a chroma sample.
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11	 You will immediately see the result of extracting the selected blue hue. However, this is 
just the first step of the keying process. You now need to review the quality of the key 
and clean it up.

Select the delta keyer node and press 1.

12	 In viewer 1, press the Color drop-down menu and choose Alpha to reveal the alpha 
channel of the key.

A good key should be black and white – with black representing transparency and 
white representing full opacity. At the moment, the matte has too many grey areas, 
which will result in semi-transparency in the top layer.
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13	 To clean up the matte, enter the Matte tab in the inspector.

14	 Drag the Low Threshold right until you no longer see gray areas in the black background.

15	 Drag the High Threshold left until the character in the foreground turns a solid white.

16	 Drag Clean Foreground to the right until the reflection on the helmet is reduced.

The matte looks much cleaner now. However, looking at the merged image, it is 
obvious that there is still a lot of unnecessary information that needs to be removed 
from the edges of the foreground layer.
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Creating a Garbage Matte
In a previous exercise, you used a matte to define which area of the frame should be 
impacted by an effect node. In this exercise, you will use a polygon matte to refine what you 
want to keep visible in the foreground layer. This type of mask is known as a garbage matte.

1	 Drag the polygon tool from the toolbar onto an empty part of the node editor.

2	 Drag the playhead to the first frame of the clip.

3	 Click around the character in viewer 2. If necessary, zoom out of the viewer to make it 
easier to click outside the frame.

When creating custom polygon shapes, you need to click on the first point you made 
last to close the shape loop.

4	 Next, you will need to animate the polygon shape as the camera pushes in. By default, 
all polygon shapes will automatically animate as you make changes to them on 
different frames on the time ruler.

Drag the playhead to the last frame of the clip.

5	 Adjust the polygon corners to fit the new frame.
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6	 Move to the center of the time ruler, and adjust the points further, if necessary.

Keep making changes up and down the time ruler until the polygon moves smoothly 
with the character.

7	 With the garbage matte completed, you can now connect it to the delta keyer node. 
The delta keyer has several dedicated inputs based on your workflow, supporting 
clean plates and solid mattes.

TIP  The Status bar in the lower left corner of the interface shows basic 
metadata about any node you hover over.

Hold the Option (macOS) or Alt (Windows) key and drag the polygon output to the delta 
keyer node.

You will see a drop-down menu prompting you to indicate the input you would like 
to use. 
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8	 Select GarbageMatte.

The edges of the frame will disappear from the foreground layer, revealing a clean 
extraction of the subject.

Compositing Layers using Color Correction
The two layers can now be clearly seen, but do not match due to their different filming 
conditions and color spaces. You will use a color corrector node to match the foreground 
to the background, and then add an additional color corrector at the end of the pipeline to 
create a single look for the scene.

1	 Select the delta keyer node.

2	 Press Shift-spacebar and type in corr.

3	 Select the Color Corrector tool and press Add.

To better match the appearance of the foreground layer to the background, you will 
need to substantially darken the image.

4	 Drag Lift left to darken the shadows (-0.5).

The foreground character becomes darker, but the background is affected too! This is 
occurring because the color correction tool is applied to the full frame of the video, 
with no regard for the mask (or alpha channel) of the BLUESCREEN layer.

When making adjustments to the brightness or color of a node with transparency, you 
will need to specify to the color correction tool to affect only the areas defined (or 
‘premultiplied’) by the alpha channel.

5	 To fix the issue caused by premultiplication, open the Options tab of the color corrector.

6	 Select Pre-Divide/Post-Multiply.
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The grade is now limited to the foreground character layer.

7	 Return to the Correction tab to continue grading.

8	 Drag Gamma left to darken the midtones (0.75).

9	 Drag Contrast left to reduce the contrast and bring the highlights closer to the 
shadows (0.70).

10	 Drag the center of the color wheel slightly towards magenta to undo the green tint in 
the midtones of the image.

11	 The highlights of the image are also very warm. At the top of the inspector, change the 
Range to Highlights.

12	 Drag the center of the color wheel towards blue/cyan.

With the layers matched, you can now apply a uniform look to the clip.

13	 Add a new color corrector node after the merge node.

You’ll aim for a cold, futuristic look.
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14	 First, lower the gamma and increase the gain to increase contrast in the image.

15	 Drag the master color wheel towards cyan/blue to make the image cooler.

16	 Switch the Range to Highlights.

17	 Drag the highlights color wheel towards magenta to give a slight tint to the lights in the 
ceiling and the reflections on the suit.

18	 Switch the Range to Shadows.

19	 Drag the shadows color wheel towards green to give the overall look a more ‘techy’ feel.

The final grading node was effective in compositing the two layers together, helping sell 
the look of the overall environment. In clips where there is a change of lighting conditions 
(such as the light going out at the end of this scene), you can also use keyframing to 
animate colors and luminance values over time.

Fusion is used for professional-grade visual effects work in film and television. Its tools 
offer a wide breadth of functionality, ranging from subtle coverup work, motion graphic 
design and animation, to eye-catching particle generators, 3D assets, green screen keying 
and set extension.

Due to this impressive variety of tools and their parameters, it might take some time to 
discover and master all of them. The DaVinci Resolve 15 User Manual includes more 
in-depth explanations of all the Fusion features and the The Visual Effects Guide to 
DaVinci Resolve 15 is a good follow-up to this training manual.
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Lesson Review
1	 True or False: It is possible to have more than one MediaIn node in a composition.

2	 What type of node do you need to combine media and generator nodes (like text) 
into a single pipeline?

3	 Which inspector tab should you use if you want to add a drop shadow to text? 

4	 Which of the following would be inappropriate to use as a tracking point?

A) Corner of a building

B) Stickers on a desk surface

C) Leaf on a tree

D) Pen mark on actor’s face

5	 True or False: You can animate color correction effects.
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Answers
1	 True. MediaIn nodes are a link to the source media in the Media Pool. When 

compositing multiple layers, there will be a dedicated MediaIn node for each image 
and/or video source.

2	 The merge layer. It has a foreground and background input to indicate the layer order 
of media/generator nodes. A new merge node is required for every additional layer.

3	 The shading tab. In this tab, you will find advanced controls for the text fill, outline 
and shadows.

4	 Leaf on a tree. In all other scenarios, the tracking point will behave in a predictable 
manner (in the case of the actor, it’s assumed we are adding/removing something 
from their face). Leaves tend to move with the wind, which makes them unreliable 
tracking points.

5	 True. Any parameter with a keyframe icon next to it can be animated. This includes 
transform controls, text parameters, effects, and color values. 



Lesson 9

Building and Mixing 
the Soundtrack 

Your project’s soundtrack is an essential  
part of the overall audience experience. 
Fortunately, while the Fairlight Page in 
DaVinci Resolve 15 is designed to create big 
Hollywood soundtracks, you’ll find it familiar 
enough for you to use as an editor. 

In this lesson, you’ll explore techniques for 
audio editing, sound design, and final mixing, 
including “sweetening” your soundtrack as 
you apply professional equalization, dynamic 
controls, panning, and automation to  
your tracks. 

The goal of mixing and mastering is to 
balance the levels coming from each track  
so they sound good as a whole. You do so  
by making subtle changes to the track levels 
or combining similar tracks into submixes  
to make them easier to control with a single 
fader. The final master needs to sound great 
and meet delivery standards for Loudness. 
Fortunately, the Fairlight page includes 
everything you need to make sure the  
levels are right on target.

Time

This lesson takes approximately 
80 minutes to complete.

Goals

Preparing the Project	 282

Setting up the Fairlight Page	 283

Editing in the Fairlight Page	 288

Panning Tracks in Acoustic Space	 296

Normalizing Clip Levels	 299

Working with Clip Equalization	 300

Controlling Dynamic Range 	 314

Automating Track Changes	 318

Simplifying Mixing using Buses	 323

Creating Additional Output Buses	 332

Assigning the Music and  
Effects Tracks	 336

Monitoring Loudness in your Mix	 337

Lesson Review	 341
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Preparing the Project
Before you start, let’s take a moment to open the project and get acquainted with the bins 
and timelines that you’ll be using throughout this lesson. Also, because you’ll be working in 
a new interface page, it’s a good idea to reset the DaVinci Resolve 15 user interface (UI) so 
your interface will match the screenshots and descriptions in this book. Then, you can 
customize your workspace, as needed, while you work your way through the lesson.

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 09 Audio. Select R15 Editing Lesson 09 Audio.drp. Choose Open, 
and click OK to import the project into your Project manager.

2	 Open the project, and relink media files.

In the Media pool, you can see a series of bins that contain the elements of your scene 
with the Doctor and the FBI Agents. 

3	 Right-click the Master bin, and choose Sort By > Name to organize the bins by ascending 
alphabetical order.

TIP  Ideally, you’ll want to have a good set of speakers or headphones connected 
to your computer for this lesson to appreciate the audible subtleties.
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4	 Select the Timelines bin, and if necessary, switch to list view.

This bin contains seven timelines for the exercises in this lesson.

5	 Click the File Name column header to sort the bin in ascending order.

6	 Double-click the 01 AUDIO EDITING timeline to open it.

7	 Play through the timeline to reacquaint yourself with the scene.

For all intents and purposes, this process of enhancing the sound of your audio tracks 
could be called audio correction. You enhance, or sweeten, each track’s four fundamental 
elements—equalization, dynamics, pan, and volume level—so your tracks complement 
each other in the final mix.

DaVinci Resolve 15’s controls enable you to manipulate all four of these elements on every 
track without additional plug-ins or patching. Keep in mind that each of these controls could 
fill an entire lesson on their own, or even a book; however, for the purpose of this advanced 
editing instruction, you’ll gain a basic understanding of how these controls work and when 
you might need to apply them to your projects.

Setting up the Fairlight Page
Moving a project from picture edit to audio post has never been easier than it is in DaVinci 
Resolve. That’s because Resolve is the only professional editing system that also includes 
the Fairlight page, which is a fully functional digital audio workstation (DAW). As you work 
your way through the following exercises, you’ll find that many Fairlight page features function 
similarly or identically as in the Edit page.

1	 At the bottom of the Resolve window, click the Fairlight button to go to the Fairlight page. 
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2	 Choose Workspace > Reset UI Layout.

The default Fairlight layout shows only the audio tracks, toolbar, and transport controls. 
Also, the Fairlight timeline appears with plenty of room allotted for working on additional 
audio tracks. Let’s resize the current tracks to better fit the available workspace. 

3	 Press Shift-Z to fit the timeline clips horizontally, if necessary. 

4	 Fit the audio tracks vertically in the timeline window by holding down Shift and scrolling 
your middle mouse wheel.

The default Fairlight workspace focuses entirely on the audio tracks in the timeline and 
the audio clips in the Media pool. However, you can use the buttons at the top of the 
window to show or hide additional interface panels, as needed.

5	 At the upper-left of the Resolve window, click the Media pool button to show the Media 
pool, including the Fairlight Page’s Media pool preview player. Click the Timelines bin, 
if necessary, and switch to list view.

TIP  On a trackpad, scrolling up zooms in and scrolling down zooms out. 
Keep in mind that when zooming a Fairlight timeline, the focus remains on the 
playhead followed by the selected track.
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6	 At the upper-right of the Resolve window, click the Meters button to open the 
monitoring panel. 

In the monitoring panel, you can monitor all of the audio and video contents of the 
current timeline. 

For the moment, you only need to see the viewer in the monitoring panel. So, this is a 
great time to expand the viewer as a separate window and hide the meters. 

7	 In the lower-right corner of the viewer, click the expand button to turn the viewer into 
a floating window.

TIP  By default, the Media pool in the Fairlight Page displays only audio clips 
or clips that have audio. You can choose to change this behavior in the Media 
pool options menu in the upper-right corner. 
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The viewer appears in the middle of the interface. Now, you can drag the top of the 
viewer to move it. 

8	 Click the Meters button to hide the monitoring panel.

9	 Move the viewer to an unobtrusive position on your screen. Feel free to resize or move 
the viewer at any time as you work through these exercises.

NOTE  If you are using Blackmagic Design hardware to output the video from 
your Resolve workstation to a client monitor, you don’t necessarily need to use 
the preview viewer because the video output will still be maintained when 
working in the Fairlight page.
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You can also view the clips on your video tracks in the Fairlight Page.

10	 Click the Timeline View options button, and select the Video Tracks option.

The video tracks in your timeline are now viewable, but not editable. They will be useful 
to see where the clips start and stop.

Now, you are ready to start your first audio post-production role!
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Editing in the Fairlight Page
When you begin to think about sound effects, the first step is to just watch a scene without 
any audio. That’s right, totally silent. By watching a scene with the audio muted, your 
imagination can fill in the blanks and allow you to think about all the scene audio you might 
expect to hear or would like to hear.

1	 In the audio monitoring controls, click the mute button.

The mute button turns red to indicate that audio playback is muted.

2	 Play the timeline from the beginning.

During playback, make mental notes as to what sounds (other than dialogue) should be 
included to make the scene seem real to the audience. Also, think about moments in 
the scene that might benefit from the addition of music, sound effects, or something 
extra to elevate the moment.

3	 Click the mute button to unmute playback.

4	 Play the timeline again from the beginning. During playback think about which sound 
elements are still needed to enhance the scene.

Chances are, the soundtrack elements that you imagined will seem even more 
necessary during this playback. First, you need to add some background to this scene 
to make it feel as though the room is full of people.

NOTE  The slider to the right of the mute button allows you to change the level 
you are using to monitor the audio playback from Resolve while the DIM button 
is used to lower the playback volume to allow you to chat with your client, 
while keeping half an ear on the mix.

TIP  You may want to add markers to remind yourself of the different sounds that 
may be needed to enhance this scene. Feel free to add any you may think of, so 
you can later refer to the markers tab in the Index to easily locate these sections.
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5	 In the Media pool, in the Audio bin, select the Foley bin.

6	 Select the Atmosphere wild sound clip.

You can play this clip in the Media pool preview player in a similar manner to the 
Source Viewer in the Edit page, including adding in and out points, as necessary.

7	 In the timeline, right-click in the track headers and choose Add Track > Mono.

8	 Rename the track WALLA 1, right-click its track header, and choose Change Track 
Color > Chocolate.
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9	 Drag the Atmosphere wild sound from the Media pool player to the WALLA 1 track, 
starting at the first line from the Doctor on A1.

The audio clip inherits the same color as the track, but it’s a little too long for this scene.

10	 Trim the end of the clip to the end of the last dialogue clip from the FBI Agent on A2.

TIP  A “walla” track is a background track that consists of the general murmur 
of people talking without any actual discernable conversation.
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11	 Drag the fade handles at the start and end of this clip to fade the background sound 
in and out of the scene.

12	 Press Home, and play the scene to hear how the sound effect fits.

Building up Sound Effects
One common sound design trick used in both music production and soundtracks is to 
double a track to thicken, or fatten, the sound. Sound is cumulative, so more tracks equals 
more sound.

For example, if you had a recording of 10 people in a room murmuring to each other like 
party guests, it would sound like ten people in a room no matter how loudly you played the 
track in the mix. However, if you were to copy (double) the track, place the same audio clip 
on a duplicate track, and offset it slightly so it didn’t play in sync with its duplicate, the result 
would sound more like a roomful of people. As it happens, this scene’s party track sounds 
like a handful of people (probably the ones you see in the background). To really “sell” that 
an auditorium full of people are at the gathering, you’ll want to double-up (or possibly even 
triple-up) the walla track.

You’ll need to duplicate the clip and offset it just slightly so that it sounds like more people 
and not just an echo. Then, you’ll apply a couple of tricks to further differentiate it from the 
first track. 

1	 Right-click the WALLA 1 track header, and choose Add Track > Mono. Rename this track 
WALLA 2, Right-click the track’s header, and choose Change Track Color > Chocolate.

2	 Select the clip on the WALLA 1 track, and choose Edit > Copy, or press Cmd-C (macOS) 
or Ctrl-C (Windows).

3	 Click the track header for the WALLA 2 track to select that track.

You will see a semi-transparent version of the copied clip in the selected timeline.
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4	 Choose Edit > Paste, or press Cmd-V (macOS) or Ctrl-V (Windows) to paste the copied 
clip into the new track.

5	 Play the scene back to preview the changes.

So far, this still sounds like a small group of people murmuring and clinking glasses 
every now and then. When the two tracks play together, the only audible difference is 
an increase in the volume level. 

To offset the clips, you could just drag the copy to the left or right. However, a more 
sophisticated way to offset clips is to find a recognizable sound in one and make sure 
that it isn’t too close to the same sound in the other. In this case, you’ll use the sound 
of clinking glasses to track the clip offset. Luckily, that sound also happens to be the 
highest level peak in the clip, so it is easy to locate. 

6	 Press the JKL keys to play the highest peak in the WALLA tracks. Then, place the 
playhead just before the peak.

7	 Using the timeline ruler as a guide, trim the beginning of the duplicate clip to around 
00:00:06:00. 

8	 Select the clip on the WALLA 2 track, and press Cmd-X (macOS) or Ctrl-X (Windows) 
to cut the selected clip. 

The clip’s opacity lowers, just as it did with the copied clip; but this time, instead of 
creating a copy, you want to move the original.

9	 Press the J key to move the transparent duplicate to the left until the beginning of 
the clip aligns with the beginning of the clip on the A6 track. Press Cmd-V (macOS) 
or Ctrl-V (Windows) to paste the clip. 
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Notice that throughout the move, the playhead maintained its position on the selected 
clip. Don’t worry about extending the duplicate clip because you’ll be changing its 
speed shortly. You’ll change its duration, as well. 

10	 Play the beginning of the WALLA tracks to hear how the offset clips suggest a larger 
number of guests in the room. Unsolo and then solo one of the WALLA tracks during 
playback to compare the sounds of one track with the offset-doubled tracks. When you 
are finished, unsolo the tracks.

Of course, because audio levels are cumulative, the background tracks are now too 
loud. So, before moving on, this is a good time to lower the walla clips’ playback levels. 

11	 Choose Fairlight > Clip Info Display, and in the Clip info Display box, select Volume.  
Click OK.

The current gain level for each clip appears at the head of each clip in the timeline.

12	 Play the scene with the WALLA tracks, and lower their clip volume curves. Trust your 
ears and set them to suit yourself. If you aren’t sure of a satisfactory level, set each clip 
to around -2.80 dB. 

TIP  You can also simply pick the clip up and move it as you would in the  
Edit page.
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You’ve just increased the number of party guests without hiring extras, reshooting a 
scene, or even recording audio with more guests. Best of all, you learned a cool audio 
trick for doubling tracks. Audio post-production often involves precisely moving a lot 
of clips, so those common keyboard shortcuts to cut, copy, move, and paste will be 
real-time savers.

Applying Speed Changes to Audio
In this exercise, you’ll apply the power of audio speed changes in the Edit page to enhance 
this scene. The three variables to consider are duration, pitch, and sync.

1	 Go to the Edit page.

The first thing you should notice is that all the editing you’ve been doing in the Fairlight 
page has instantly updated in the Edit page because the two pages display exactly the 
same timeline, albeit in two different ways.

2	 In the timeline, scroll down to the A7 WALLA 2 track, and select its audio clip. Right-
click the selected clip, and choose Change Clip Speed.

TIP  You can also adjust the clip volume of the selected clip or clips in  
the Inspector.
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The Change Clip Speed dialog appears with a Speed field for changing speed, as well 
as the Pitch Correction checkbox. Your goal is to lower the pitch of the walla clip to 
differentiate its sound from the first WALLA track. Doing so will enhance the fuller 
crowd sound that you created previously.

3	 In the Change Clip Speed dialog, deselect the Pitch Correction checkbox which will 
produce a deeper, slower sound. 

4	 In the Speed Data field, type 90. Click Change, or press Return.

You won’t see a difference in the timeline, but you will hear it, eventually. First, let’s trim 
the clip in the WALLA 2 track to match the length of the clip in the A6 track.

5	 Drag the right edge of the clip to extend it. When you are finished, deselect the clip. 

6	 Solo the A6 and A7 tracks. Play them together, and then play each soloed to hear the 
difference in pitch between the original and the modified clips. When you are finished, 
unsolo both tracks.

As you can hear, speed changes are as useful in sound design as they are on your video 
tracks. Those walla tracks now really sound like a roomful of people.
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Panning Tracks in Acoustic Space
Pan controls place a track’s audio within a panoramic sound field. They enable you to 
compose the spatial arrangement of audio elements just as a cinematographer composes 
the visuals of a shot. Mono tracks can be precisely located to sound as if they come from 
an off-screen source, or somewhere within the frame. Resolve 15 includes advanced pan 
controls in both the Edit and Fairlight pages that support both 2D (stereo) and 3D (surround) 
audio placement.

In this exercise, you’ll use the pan controls to widen the walla tracks so they don’t “crowd” 
the dialogue tracks.

1	 Return to the Fairlight page.

2	 Start playback, and listen carefully. Can you pinpoint where the dialogue or walla is 
coming from? 

Your eyes tell you their locations; but when you close your eyes, the sound from all 
of these tracks are playing equally from both speakers, which makes them sound 
centered within the sound environment.

Let’s pan the walla tracks to the far left and right to hear what happens.

3	 Click the Mixer button. 

4	 Using the Mixer’s Pan controls, drag the blue handle for the A6 WALLA to the upper-
left corner of the panning control in the control strip. Drag the A7 WALLA 2 blue 
panning handle to the upper-right corner of the control on the A7 channel strip. 

NOTE  If you are working in a quiet room with a good set of stereo audio monitors, 
you should be good to go. If you have been using your built-in computer speakers 
or an inexpensive single speaker, you are well advised to use headphones for this 
panning exercise. 
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5	 Play the timeline from the beginning to hear the walla tracks panned to the far left 
and right of the acoustic space.

Can you hear the change? In just a matter of seconds, you filled the far reaches of the 
acoustic space with the walla sound, making the crowd seem to spread out within a 
much larger room. Additionally, you moved their sound away from the actors’ audio 
tracks, thereby making it easier to hear the all-important dialogue. 

Let’s take a closer look at the Pan controls.

6	 In the Mixer, in the A6 track, double-click the Pan controls to open the Audio Pan window. 
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The Pan controls can work with either 2D (stereo) or 3D (surround) panning depending 
on your setup and project. The center of the graph represents the acoustic center from 
the audience’s perspective. The small letters F, R, B, and L—positioned clockwise 
around the space in the top, right, bottom, and left positions—represent the Front, 
Right, Back, and Left positions in the panoramic field, respectively.

Where you place audio tracks within the panoramic space will reflect where the 
audience will locate each audio source. The Spread control is for linked sources. 
Divergence determines the spread of the audio signal to additional speakers in a 
surround mix, and Boom determines how much of a track’s sound is sent to the 
low-frequency effect (LFE) speaker.

Look carefully to see that the A6 WALLA track is currently panned to the front-left 
position. Let’s relocate it to the back-left position to hear the difference.

7	 Unsolo all the tracks, except for the A6 WALLA track.

8	 Start playback, and drag the blue Pan handle to the lower-left corner of the pan area. 
Pan the track to the center, and then to the right. Return the control to the back left. 

Could you hear the crowd move around the room as you panned? As the sound 
designer and re-recording mixer for this scene, you can choose where to place 
the crowd.

9	 Use the Pan controls in the A6 and A7 tracks to place the walla tracks wherever you’d 
like in the panoramic field. If you aren’t sure of their placements, try putting them in the 
far-left and far-right between the back and center locations. 

When you are finished panning tracks to compose the acoustic space within your scene, 
you can move on to finessing the levels of those tracks. In audio post-production, volume 
control is an ongoing process right up until you output the final mix.

NOTE  You may or may not hear the sound change from front to back when 
you are listening through stereo speakers or headphones. Also, if you are 
monitoring audio through an audio interface and mixer that outputs only left 
and right channels, then you may not hear any output that is not panned to the 
front left, front center, or front right.
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Normalizing Clip Levels
Ensuring that your dialogue levels are consistent is one of the main issues you’ll be facing, 
whether you are responsible for a dialogue scene such as this, or a timeline with interviews, 
voiceover, or any kind of speech. Thankfully, DaVinci Resolve can help out, so you can 
spend time finessing your levels in other ways.

1	 In the Media pool, select the Timelines bin, and double-click the 02 LEVELS timeline 
to open it.

2	 Play through this timeline and listen carefully to the dialogue.

The dialogue is generally clear throughout, but you do need to sort out some of 
the levels.

3	 Select all the clips along the three dialogue tracks: A1, A2, and A3.

4	 Right-click any of the selected clips, and choose Normalize Audio Levels.

The Normalize Audio Levels box appears asking you to set a peak level and how you 
want to apply normalization across the selected clips.

5	 Set the Reference Level to -12 dbFS and the Set Level option to Independent.
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6	 Play through the timeline to listen to the change.

The level of each clip is now adjusted to the highest peak reached, -12dbFS. But the 
Doctor’s third clip level is now a little high.

7	 Using the volume curve, lower the level of the third clip on the DOCTOR track to 
around 4 db.

Working with Clip Equalization
Equalization (EQ) manipulates specific frequencies to enhance the overall sound. The 
primary function of equalization is to lower frequencies that detract from dialogue and 
boost certain frequencies to improve the overall sound clarity. The Fairlight page includes  
a four-band equalizer for each clip in the Inspector, and a six-band parametric equalizer on 
each track in the Mixer. 

Creating a Two-way Radio Effect with EQ
To better understand the power of frequency equalization, let’s use it in an extreme context 
to transform a recording so it sounds more like a two-way radio. You will systematically 
eliminate frequencies in the clip to emulate the limited frequency response of a CB radio. 
Along the way, you’ll also alter various voice frequencies to determine which ones enhance 
and detract from this recorded voice. 

NOTE  -12 dbFS is a good starting level for these clips. The level that you will 
choose to normalize your peaks may differ depending on your audio delivery 
requirements. By changing the Set Level to Independent, you are letting 
Resolve normalize the levels of each clip relative to its individual peak, rather 
than normalizing the clips by the same amount based on the highest peak level.
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1	 In the Media pool, in the Timelines bin, open the 03 EQ AND COMPRESSION timeline.

This is a version of your scene with a couple extra tracks of ambience added.

2	 Solo the A8 RADIO track and play the clips in the timeline. 

As is, the voice sounds normal. Let’s take a closer look at the radio dispatcher clips 
in the Inspector, focusing on the second and fifth clips that contain the actual voice, 
not the bookend radio clicking sounds on either side. 

3	 Zoom horizontally until you can clearly see both clips in the A8 track. 

4	 In the toolbar, click the Inspector button.

5	 Select the second clip in the A8 track to see it in the Inspector.

6	 Click the enable button to turn on the Clip Equalizer.

Before making any changes, take a quick look at the controls.

Graphical EQ controls

Band enable button

Band filter type

Numeric controls

Frequency

G
ai

n
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In the graphical EQ controls area, you can see and manipulate the frequency graph. 
The numerical controls at the bottom of the equalizer give you more precise control 
over the frequencies and gain of each band.

Looking more closely at the blue graph, you can see that the default setting resembles 
a clip with fade handles applied to the head and tail. The steep slope at the left edge 
of the curve is actually a high-pass filter that allows high frequencies to be heard while 
it eliminates the lowest frequencies. The slope on the right side of the curve is a 
low-pass filter that allows lower frequencies to be heard while eliminating the highest 
frequencies. In the next exercise, you’ll work with both the high- and low-pass filters to 
alter the recorded voice in the clip.

Common Frequencies for Dialogue EQ
Audio frequencies are measured in either Hertz (Hz) or thousands of Hertz, or kilohertz (kHz). 

Low numbers represent low frequencies and high numbers represent high frequencies.

When you change the amount of gain in a frequency range, you either boost (increase)  
or attenuate (reduce) the volume level of the frequencies within that range. Filtering out  
a specific frequency or a narrow range of frequencies is referred to as cutting. 

The audible frequency range for the average human is between 20 Hz and 20 kHz  
(or 20,000 Hz).

Sweeping Frequencies to Target Changes
Dragging the graphical controls left or right through the EQ graph during playback is 
referred to as sweeping and is the most effective way to hear changes and identify areas 
that need work. For this exercise, you’ll sweep a midrange frequency bell curve in Band 3 
to boost or attenuate frequencies during playback and isolate the talent’s voice. Then, 
you’ll adjust the high- and low-pass filters in Bands 1 and 4 to observe how these filters 
change the clip’s audio. Let’s start by turning off all the bands except for Band 3. Then, 
you’ll sweep the bell curve to evaluate the radio dispatcher’s recorded voice. 

1	 In the transport controls, turn on loop playback, and press R to choose the range 
selection tool. 

2	 Using the range selection tool, select the second clip in the A8 track. Click the clip 
a second time to show it in the Inspector. 
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3	 In the Clip Equalizer controls in the Inspector, click the red-colored band enable 
buttons for Bands 1, 2, and 4 to turn them off. This enables you to focus your attention 
on Band 3.

4	 Click the band filter type pop-up menu below the Band 3 button to see the types of 
frequency filters available for Bands 2 and 3.
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High and low-shelf filters are similar to high- and low-pass filters, but the shelf filters 
attenuate (lower) unwanted frequencies, whereas the pass filters completely block 
unwanted frequencies. You can apply bell curves to boost or attenuate frequencies 
anywhere on the graph and their range of influence can be narrowed or widened as 
needed using the Q control. A notch filter is used for completely removing, or cutting, 
specific frequencies. 

Basic frequency ranges for the human voice

Men	 80–160 Hz	 Bass	 50–250 Hz

Women	 165–255 Hz	 Mid-Range  250–2300 Hz

Children  250–300 Hz	 High	 2500–20,000 Hz

Human female voices tend to fall between 165 Hz and 255 Hz. As you sweep the 
frequency graph, this is a good chance to find the fundamental frequencies for this 
particular voice. You can sweep the Band 3 bell curve by dragging its corresponding 
numbered handle on the graph. If you drag the bell curve up, you will boost the current 
frequencies, whereas dragging down will attenuate them.

5	 Press Option-/ (slash) in MacOS or Alt-/ (slash) in Windows to start looped playback of 
the marked range.

6	 During looped playback, drag the Band 3 bell curve handle up, and sweep left and 
right through the graph to hear the boosted frequencies. Then, drag the bell curve 
down, and sweep to hear how attenuating certain frequencies can affect the voice. 
When you are finished, press the spacebar to stop playback.

High shelf

Bell curve

Notch

Low shelf

TIP  A common rule of thumb when adjusting dialogue EQ is to cut narrow and 
boost wide. Also, a little EQ goes a long way, so make subtle changes, just as 
you would when refining an edit, or adjusting hue on the Color wheels.
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As you can hear, sweeping frequencies can really help you pinpoint the best and worst 
frequencies in a vocal. Because this exercise is focused on transforming the voice to 
sound as if it is coming from a two-way radio, you’ll need to eliminate most of the high 
and low frequencies, and boost the remaining frequencies using the bell curve.
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7	 Click Band 3 to disable it, and click Bands 1 and 4. 

You can sweep the high-pass filter (Band 1) by dragging its corresponding numbered 
handle on the graph. Keep in mind that this is a frequency filter that allows only those 
frequencies higher than the shaded part of the curve to pass through.

8	 If necessary, press Option-/ (slash) in macOS or Alt-/ (slash) in Windows to restart 
looped playback.

9	 During looped playback, drag the Band 1 EQ handle to the right on the graph, and 
listen to the change in the voice as you slowly eliminate the low and midrange 
frequencies. Sweep right as far as 4 kHz and sweep back to the left to around 550 Hz.
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10	 Continue with looped playback, and sweep the Band 4 EQ handle to the left as far as 
you can without lowering the curve in Band 1. Then, sweep back to the right to around 
2 kHz. When you are finished, stop playback.

The last step is to use the Band 3 bell curve to sweep and boost the remaining 
frequencies between the Band 1 and 4 handles. 

11	 Enable Band 3, and start looped playback. 

12	 During playback, boost Band 3, and sweep back and forth to find the best sounding 
“radio” voice. When you are finished, stop playback.
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There is no wrong choice here, so trust your ears. Any frequencies that you boost in 
the narrow frequency range that is available will successfully exaggerate the radio 
voice effect. 

The last step is to listen to the clip with and without the EQ changes to compare the 
before and after results. 

13	 Start looped playback. Click the Clip Equalizer button to toggle EQ off and on to 
compare the original audio with the EQ version. When you are finished, stop playback.

14	 Press A to go to Selection mode, and select the second clip in track A8, RADIO.

15	 Press Cmd-C (macOS) or Ctrl-C (Windows) to copy the clip.

16	 Right-click the fifth clip on the A8 RADIO track, and choose Paste Attributes, or press 
Option-V (macOS) or Alt-V (Windows).

17	 In the Paste Attributes box, select EQ, and click Apply to paste the EQ settings.
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18	 Deselect the Solo button for track A8 RADIO.

Using the Equalizer, you’ve manipulated the frequencies to create that radio-voice effect. 
You’ll apply some dynamics controls to the track shortly to complete the effect. First, 
however, let’s apply some track EQ to improve the overall clarity of Agent Jenkins’ voice.

Frequency level troubleshooting

100 Hz - 300 Hz 	 Too low sounds thin, too high loses clarity

200 Hz - 500 Hz	 Just right sounds warm, too high can sound boxy

250 Hz - 750 Hz 	 Potentially muddy if too high

600 Hz -1.1 kHz 	 Potentially nasal/honky if too high

1 kHz - 3 kHz 	 Adjust for intelligibility

3 kHz - 6 kHz 	 Add presence 

5 kHz - 8 kHz 	 Adjusts sibilance (esses)

9 kHz - 15 kHz 	 Adjusts sheen/sparkle

10 kHz - 20 kHz 	 Adjusts Breathiness/Airiness

Sweetening Dialogue with EQ
As you’ve just proven, sweeping frequencies and stripping out the high and low end  
of a voice is pretty easy. In contrast, actively listening, delicately cutting, and selectively 
boosting frequencies to improve a voice takes patience and practice. In this exercise,  
you’ll apply three different bell curves to the AGENT J track to find and reduce detracting 
frequencies, and then selectively boost frequencies to enhance the voice.
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1	 Press Shift-Z to fit all the clips horizontally in the visible timeline.

2	 Solo the A2 AGENT J track. Then, using the range selection tool, drag across the first 
group of clips on the A2 track to select a range for looped playback.

3	 In the Mixer, double-click the EQ box for track A2 AGENT J to open the Track 
Equalizer window.

TIP  You should first find and cut, or attenuate, the detracting frequencies. 
Then boost the positive frequencies to sweeten the voice.
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You can start sweeping for unwanted frequencies. The main issue with Agent Jenkins’ 
voice is that it is a bit boomy or boxy sounding which can compromise its clarity, 
especially in the final mix with all the other tracks. His fundamental vocal frequencies 
fall between 80-160 Hz. The boxy frequencies are somewhere between 200-500 Hz. 
Let’s start by sweeping the Band 3 bell curve in the mid/low range (ML) to identify the 
offending frequencies. 

4	 Start looped playback. Drag the Band 3 handle up to around +10 to +15 dB and sweep 
back and forth between 200-500 Hz. Listen carefully to the agent’s voice as you 
sweep the frequencies. Notice which frequency range improves the voice and which 
amplifies its irritating qualities. When you are finished, stop playback.

Chances are you found that boosting the frequencies near 200 Hz improved his voice, 
while boosting around 450 Hz made his voice sound less pleasant, as if he were 
talking into a cardboard box.

5	 Restart looped playback, and drag the Band 3 bell curve handle to around 450 Hz. 
Then, drag it below the 0 dB line to attenuate the frequencies by about -3 dB.

TIP  Training your ears to recognize subtle dialogue differences, both positive 
and negative, takes time, much the way colorists must train their eyes to see 
subtle nuances in flesh tones and shadows.
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Next, you’ll sweep the Band 4 bell curve to find the sweet spot that enhances clarity. 
You’ve already noticed that the agent’s voice improves with a boost around 200 Hz. 
Now you can pinpoint a more precise range that provides the most improvement and 
boost it by approximately 3 dB. One more thing, try improving his voice while the other 
tracks are playing.

6	 Unsolo the A2 track. Start looped playback, if necessary. Sweep the Band 4 bell curve 
between 120-300 Hz. Identify the frequency range that most improves the clarity of his 
voice, and raise it slightly to boost these frequencies.
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Trust your instincts and your ears. However, if you aren’t sure, try using +3 dB at  
around 130 Hz.

The last adjustment to the agent’s voice is to boost its intelligibility between 1-3 kHz.

7	 Change the Band 5 filter type to a bell curve. Drag the Band 5 bell curve up to see the 
shape of the curve. 

The default curve is too wide for this change. You can narrow the frequency range 
with the Q Factor controls.

8	 At the bottom of the Band 5 controls, drag the Q Factor control to the right until the 
frequency range (curve) resembles the +2.3 curve in Bands 3 and 4.

9	 Start playback, and sweep between 1-3kHz. Identify which frequencies improve the 
intelligibility of his voice, and boost the frequencies between 1-3 dB.
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10	 Continue looped playback, and toggle the Equalizer button off and on a few times to 
hear the agent’s voice with and without the EQ. When you are finished, stop playback.

11	 Close the Equalizer - AGENT J window, and deselect the clips in the A2 track.

Though subtle, the improvement to Agent J’s voice EQ is significant. This is another 
reason to separate each character on their own track during dialogue editing so that 
you can not only balance their volume levels, but also apply equalization to the entire 
track, as needed. 

Controlling Dynamic Range 
The difference between the loudest and quietest levels in a track is its dynamic range. 
A track’s dynamic range is very similar to contrast within a shot. A track with a high dynamic 
range has very loud and quiet elements within the track, such as a character whispering 
and then screaming in the same scene. A low dynamic range is fairly flat, such as in a 
commercial voiceover in which the volume level of the talent is very even from start to 
finish. If you have ever worked with a waveform or Parade scope in the Color page, 
controlling a track’s dynamics is very similar to adjusting the white and black levels of a clip. 
Just think of white as the loudest and black as the quietest. 

The Fairlight page Mixer includes the four most common dynamics controls in one  
easy-to-use panel.

1	 Solo the A8 Radio track, and with the range selection tool, select the second clip in 
the track to mark your looped playback range. 

2	 In the Mixer, on the A8 Channel strip, double-click the Dynamics area to open the 
Dynamics window.

The Fairlight page Dynamics controls include four tools for modifying a track’s 
dynamic range.
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The compressor is the most common control and is used to narrow the dynamic range 
by lowering the highest peaks and bringing them closer to the lowest peaks. It’s a 
great tool for bringing out some of the quieter spoken words, while simultaneously 
lowering the level of the loudest words.

The expander, in contrast, enlarges the dynamic range to increase the difference 
between the loudest and quietest peaks.

The limiter and gate both work as acoustic “barriers” to limit sound from exceeding 
a target level (limiter), and to prevent sounds lower than a set threshold from being 
heard (gate).

In this exercise, you’ll apply heavy compression and boost the overall gain in the Radio 
track to further emulate the radio sound. Adjusting the frequencies was just the first 
step. Compressing the dynamic range will further modify the radio voice to emulate 
the under-the-hood vocal processing in two-way radios.

TIP  Many devices, including smart phones, intercom systems, and two-way 
radios use heavy compression to limit the dynamic range so that each spoken 
word can be heard. Obviously, the results don’t follow natural volume 
fluctuations in vocal patterns but are a convenient enhancement to the voice 
amplification process.
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3	 In the Dynamics - RADIO window, click the Compressor button to enable the 
Compressor controls. 

The default Compressor settings include a Threshold of -15 dB and a Ratio of 2.0:1. 
The Threshold indicates where in the dynamic range you want to start compression. 
So, in this example, any peaks over a Threshold value of -15 dB will be compressed by 
a 2:1 Ratio, which means that with every two decibels increase over -15 dB, only a one 
decibel increase will be permitted. When a track has a wide dynamic range, you can 
apply a higher Ratio value such as 5:1 so that for every five decibels of level increase 
over -15 dB only a 1 dB increase will be permitted. The heavier the compression, the 
more likely you will start to hear it in the quality of the sound. However, because you’re 
emulating a low-quality radio speaker in this scene, the more compression, the merrier.

4	 Start looped playback. In the Dynamics window or the A8 channel strip in the Mixer, 
watch the Output meter, to see the average volume level of the soloed range.

The current average volume is around -23 dB, which is lower than the current Threshold.

5	 Drag the Threshold knob to the left to lower it to around -24 dB. Then, drag the 
Ratio knob to the right to raise it to an 8.0:1 ratio. Listen to the change as you apply 
the compression.
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With this much compression applied at -24 dB, notice that the graph of the upper end 
of the decibel curve (light green) is nearly horizontal, as are the peaks.

Let’s boost the gain to more clearly hear the heavy compression. The Make Up gain 
fader lets you raise the overall level sound coming from the track’s compressor. You 
can still adjust the track’s overall output level independently using the track fader in  
the Mixer.

6	 Drag the Make up gain fader up to around +10 to raise the output level of the track to -12 dB.
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Now you can really hear the compression in the track. Don’t worry, you’ll be able to 
lower the level of the Radio track in the Mixer and still maintain the distorted, over-
compressed effect.

7	 Toggle the Compressor button off and on to compare the voice with and without the 
compression applied. When you are finished, close the Dynamics window, unsolo the 
A8 RADIO track, and deselect the clip.

8	 Play the timeline to hear the finished radio effect with the other tracks. 

Another successful exercise in acoustic manipulation. Although this is an extreme example 
of compression and EQ, it should pave your way to experiment with these controls in your 
own projects. You can start by applying a small amount of compression to the Doctor’s and 
Agent Jenkins’ dialogue tracks to help give them a little more punch in the mix.

Automating Track Changes
Adjusting faders, panning, and other controls during a mix is part of your job. You could 
try making all of the changes on-the-fly during your final mix, or alternatively record the 
parameter changes as automation. In this exercise, you’ll use DaVinci Resolve’s automation 
controls on the Fairlight page to record panning control changes over time. 

At the top of the Fairlight page, you’ll find the automation button to the right of the 
transport controls. 
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1	 In the Media pool’s Timelines bin, open the 04 MIXING timeline.

2	 Click the automation button to open the Automation toolbar. 

The Automation toolbar includes buttons for every available option to set up and 
record automation for your mix. The buttons are organized in groups from left to right.

You can record automation data in Write or Trim modes. Write mode records absolute 
changes to controls, whereas Trim mode records relative changes that either increase 
or decrease levels that are already recorded.

The other important settings for automation include:

�� Touch determines what will happen when you begin automation. If the touch mode is 
turned off, no automation is recorded.

�� Latch begins recording as soon as you touch a control that is set for automation and 
continues to record automation after you release the control.

�� Snap begins recording automation when you touch a control and stops when you 
release the control.

Your goal in this exercise is to start with the radio track panned left and then automate 
panning to the right after the doctor’s first look so the second radio call sounds as if it 
is coming from a radio on Agent Jenkins. Use the doctor’s eyeline in her second look 
as a guide.

3	 Make sure that the Touch automation menu is set to Off.

TIP  Before recording automation, it’s always a good idea to practice recording 
at least once. 

TIP  When you are working with automation, it’s a good idea to set the Touch 
mode to Off any time that you aren’t actively recording. Otherwise, you could 
accidentally record or overwrite automation during playback. Also, you can 
click the Automation button to the left of the Automation toolbar to disable or 
enable all automation that is applied to a timeline. 
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4	 In the Automation toolbar, click the Pan button.

5	 In the A8 RADIO channel strip, double-click the Pan controls to open the Audio 
Pan window. 

6	 Start playback, and practice the panning maneuver once. 

7	 When you are ready to record, set the initial pan to be on the left speaker.

8	 In the Touch pop-up menu, choose Latch.

9	 Click play, and record the panning automation. When you are finished, set the Touch 
menu to Off.

10	 In the Automation toolbar, click the Pan button to deselect pan automation. Close the 
Audio Pan window.

11	 Playback the timeline to hear the automation. 

As the timeline plays back over the automation, you should hear the pan change and 
also see the pan control update on its own accord.

Adjusting Recorded Automation Changes
After you have recorded automation for a particular control, you can view the automation 
graph directly in the timeline track.

1	 In the track header for Track A8 RADIO, right-click, and choose Lock Track Height To > 
Large, or manually resize the track. 

TIP  Automating pan controls on your mono FX tracks is a great way to track 
sounds to objects that move in the frame. 
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So long as your automation controls are visible, an additional set of controls appear 
in the header of each track.

2	 Click the pop-up menu, and choose L/R Pan.

The track updates to display the pan changes you recorded in the previous exercise.
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If you want to adjust this recorded automation data, you have a couple of options. First, 
you could try re-recording the change. Place the playhead before the automation starts 
and play the timeline while adjusting the controls, as necessary. Alternatively, you 
could use the Pencil tool to redraw the automation graph.

3	 Select the pencil tool.

4	 Position the pencil tool to the left of the automation data you want to adjust.

5	 Drag the pencil tool across the automation data to redraw the graph.

When you are working on a slower computer or laptop, automation may affect the 
quality of video playback. To streamline your workflow during the remaining exercises, 
you can temporarily disable automation by hiding the automation toolbar. Later, you 
can turn on automation for your final output.

6	 Click the automation button to hide the automation toolbar.

Now that you’ve had a taste of automating track controls, you can start applying automation 
to your own projects.

TIP  To adjust a group of automation keyframes simultaneously, use the Select 
Range tool to the right of the Pencil tool. Drag out a range across a group of 
automation keyframes, and then move them horizontally and/or vertically within 
the automation graph, or press the Delete (backspace) key to remove them.

NOTE  The Pencil and Select Range tools are visible only when you the 
automation tools are active.
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Simplifying Mixing using Buses
You already know how to balance individual clip levels; but if you have numerous similar 
tracks that have already been balanced, such as dialogue, atmosphere tracks, or music, 
you can combine them and send the output signal from each of the tracks through a bus  
to create a submix. As the name suggests, a submix lets you independently mix a subset  
of the tracks. 

Submix buses are signal paths that send the signal from multiple tracks to a new channel 
strip where the sum of their signals can be controlled like a single track, in a similar way 
that you used compound clips in Lesson 6.

In this exercise, you’ll create submix buses for the dialogue, music, and background FX tracks. 

Once again, before you begin, let’s reconfigure the Resolve interface to more effectively 
support your upcoming workflow.

1	 In the Media pool’s Timelines bin, open the 05 BUSSES AND MAINS timeline.

2	 In the toolbar at the top of the Fairlight page, click the Meters button to show the 
monitoring panel. 

3	 In the upper-right corner of the viewer window, click the dock button to return the 
viewer to the monitoring panel. 

Now the viewer appears to the right of the monitoring panel once more. 

4	 In the Fairlight page, choose Fairlight > Bus Format to open the Bus Format window.
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In the Bus Format window, you can assign tracks to one of four types of buses. The project 
currently contains one bus, the default main bus named Main 1. The Format and Channels 
columns indicate that this main bus is in stereo. 

5	 Click the Sub button three times to add three new submix buses to the list. 



325

S
im

p
lif

yi
n

g
 M

ix
in

g
 u

si
n

g
 B

u
se

s

The three new sub buses (submixes) appear below Main 1 in the Bus Format pane.

Notice that three sub buses—labeled S1, S2, and S3—are to the right of the Mixer, 
as well as on the monitoring panel. 

Let’s name the sub buses and change their formats and colors based on the tracks 
they will contain.

6	 In the User Name column, double-click the Bus 1 name, and enter DIAL. Then change 
the name of Sub 2 to MUSIC and Sub 3 to BG FX. 

7	 In the Format column, change the format of the MUSIC and BG FX subs to Stereo. 
Leave the DIAL sub set to Mono. 

Finally, let’s change the colors of each submix to correspond to the tracks in the timeline. 

8	 In the Color column, change the Sub 1 DIAL color pop-up menu to Yellow, the Sub 2 
bus color to Navy, and the Sub 3 bus color to Chocolate.
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9	 Click OK to close the Bus Format window.

The new sub bus names and colors also appear in the Mixer and the Meters.
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You are all set up with submixes. The next step is to route the appropriate tracks into  
those submixes. 

Assigning Tracks to Submix Buses
You must now assign the tracks that you want to send to each bus. 

1	 Choose Fairlight > Bus Assign to open the Bus Assign window. 

The Bus Assign window has two sections. At the top of the window is a list of all the 
buses. The rest of the window shows the available tracks. In the Available Tracks area, 
initials under each track name indicate the current assignments for each track. Below 
each track name, you’ll see an M1 to indicate that the track is assigned to the Main 1 
output. Tracks with B1, B2, or B3 initials below the name are assigned to those 
corresponding buses (in this case, the DIAL, MUSIC and BG FX submixes respectively). 
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To better understand the bus and main architecture, let’s clear all of the current track 
assignments and reassign them from scratch. To do so, you’ll select each bus 
individually, and click the Un-Assign All button. 

2	 In the Buses area in the Bus Assign window, click the M1:Main 1 button. 

The name of the selected bus highlights to indicate it is selected.

3	 In the Available Tracks area, click the Un-Assign All button.

All of the tracks are removed from the M1:Main 1 output bus. Remember that only tracks 
assigned to a Main output are audible. So, you’ll eventually need to reassign these tracks.
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All the tracks and buses are successfully unassigned. Now you can manually select 
each bus and assign tracks to them. 

4	 In the Buses area, select the S1:DIAL bus. In the Available Tracks area, select the DOCTOR 
K, AGENT J, and ASSISTANT tracks as these are all the tracks containing dialogue.

5	 Select the S2:MUSIC bus, and then select the STING, BEAT, BED, and SCORE tracks 
to assign them to that bus.

6	 Select the B3:BG FX bus, and assign the STAGE FX, WALLA, WALLA 2, and SC MUSIC 
tracks to it.

TIP  The dispatch radio track includes recognizable words in spoken English, 
so like all other dialogue tracks, it would usually be omitted in a Music and 
Effects-only (M&E) mix intended for foreign distribution. However, in this case, 
the purpose of these submixes is to control the primary dialogue tracks. 
Similarly, for this scene, the source music is more a part of the background 
ambience than a musical score, so you’ll assign it to the BG FX submix rather 
than the MUSIC submix. In this scene, the purpose of your submixes is 
primarily to finesse the levels between the dialogue, music, and background 
FX tracks in the second half of the scene.
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Next, you’ll assign the as-yet unassigned tracks to the M1:Main 1 output. They represent 
sounds that are heard for a short time and their tracks levels can be adjusted 
independently using the standard faders in the Mixer. You’ll also need to assign each 
of the three submix buses to the M1:Main 1 bus so that the audio of those buses will be 
audible through the main output. 

7	 Select the M1:Main 1 bus, and assign each of the unassigned tracks to it, as well as the 
DIAL MUSIC and BG FX buses.

8	 In the Bus Assign window, click the Save button. 

All the tracks are assigned to the main output or a sub bus, so you can see and hear 
them in action in the Mixer.

Working with Buses in the Mixer
The middle section of the Mixer always shows your main and submix buses, and the 
current signal flow of each track so you know where it is assigned. In this exercise, you’ll 
play through the timeline to verify that all your tracks and submixes are playing properly. 
Then you’ll try out your new submix faders. 
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1	 Drag the left edge of the Mixer to the left to expand it, if necessary.

2	 Press Shift-Z to fit all the timeline clips horizontally in the visible timeline.

3	 Play the project from the beginning, and listen to the current mix. 

The mix should still sound pretty good. You haven’t actually changed any of the levels, 
just altered the way that you will control them. You can continue to balance clip level 
curves and individual faders as usual. 

The background FX tracks seem a little distracting. Let’s emphasize the dialogue by 
lowering some of the background sounds. 

4	 Start playback, watch the scene, and move the S3 fader down to where it sounds less 
distracting (about -5dB). 

Now you know why submixes are a mixer’s best friend. It is much easier to move one 
fader that lowers three tracks than to manually lower three separate faders on-the-fly.

 

TIP  You can expand or compact the Mixer at any time by dragging its left 
edge. The buses are always visible to the right of the Mixer.

TIP  Re-recording mixers working with large mixing consoles are used to 
moving hardware faders during playback and can maneuver their hands 
around the controls like a musician playing a church organ. When you are 
working in a software-only environment, you must do the best you can using 
a mouse or track pad. You can always record automation to your tracks or 
submix buses to help simplify the final mix. Also, numerous hardware mixing 
consoles are compatible with DaVinci Resolve and its Fairlight page. You can 
find a list of compatible mixing hardware at www.blackmagicdesign.com. 
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Creating Additional Output Buses
Every audio signal in the timeline flows from the track to the main output. Whether you are 
listening to speakers or headphones at your workstation, you are hearing the main output 
every time you play your timeline.

The current timeline has one main output, three submix buses, and sixteen individual 
tracks. However, depending on the delivery requirements for your final project, you may 
need to create additional main output buses in multiple formats. In fact, most professional 
projects require several versions of your mix, such as for stereo and surround.

Furthermore, if dubbing a program into another language, you need to provide an M&E 
version of the mix that is devoid of all intelligible on-screen dialogue so that it can be 
replaced by actors speaking another language.

You can create and assign main buses just as you created submix buses in the Bus Format 
and Bus Assign windows. 

In this exercise, you’ll create a three-channel DCP main output and an M&E main output 
based on the current mix. Since the M&E mix will be identical to the Main 1 mix without 
dialogue, you can simply duplicate the Main 1 with all tracks and subs identically patched 
then make any changes from there. As for the DCP main output, you’ll create that one  
from scratch.

1	 In the Fairlight page, choose Fairlight > Bus Format.

2	 In the Bus Format window, select Main 1, and click the Duplicate button.

The duplicate main appears below Main 1 with the bus assignment of Main 2 and the 
username Main 2. 



333

C
re

at
in

g
 A

d
d

it
io

n
al

 O
u

tp
u

t 
B

u
se

s

3	 Click the Main button to create a new main output bus for the DCP main.

The two new mains (Main 2 and Main 3) appear below Main 1 in the Bus Format pane.

4	 Name the Main 2 bus M&E and the Main 3 bus DCP.

Although the default setting for the Main 1 output format is stereo, you can change it to 
a different format at any time, or create multiple mains for each of your delivery formats. 
Digital Cinema Projection (DCP) delivery, for example, requires a minimum of three 
channels (LCR) or a maximum of 16 audio channels for multichannel surround sound.

Because you probably are not doing this lesson with a surround sound set up, let’s use 
the minimum requirement of three channels and set them to LCR (Left, Center, Right). 
LCR is a common format, sometimes referred to as the “poor man’s surround sound,” 
in which all the tracks are mapped to three front speakers. In LCR mixing, the music 
and effects are mapped to the left and right channels and the dialogue is locked to the 
center channel. This is similar to multi-speaker surround sound formats because they 
also place dialogue in the center channel, but also include additional side or back 
speakers and a subwoofer for low frequency effects (LFE). 

5	 Change the Format of the DCP bus to LCR.
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You now have three Main outputs to the right of the Mixer and on the monitoring 
panel –labeled M1, M2, and M3. 

6	 In the Bus Format window, click OK. 

7	 Choose Fairlight > Bus Assign. 

Now you’ll assign tracks to these main outputs. Let’s start with the M3:DCP bus. Later, 
you can set up the M2 bus on your own.

8	 In the Buses area of the Bus Assign window, select the M3:DCP bus. In the Available 
Tracks area, select the DIAL, MUSIC, and BG FX buses. Finally, select each of the 
tracks that are mapped directly to the M1 output to also route these to the M3 output: 
ROOM, APPLAUSE, RADIO, END FX, SC FX 1, and SC FX 2. 
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9	 Click Save to save and close the Bus Assign window.

Excellent. Your new DCP output bus is set up. 

Monitoring Multiple Outputs and Buses
The Control Room settings in the monitoring panel let you determine which outputs or 
submixes are audible during your mix. The default is always the Main 1 output. To monitor  
a different main output or bus, you choose from the pop-up menu below the control  
room meters. 

Let’s give it a try. In this exercise you will change the control room monitoring to the DCP 
output. Play the timeline once, then change it back to the Main output. Keep in mind, your 
control room monitoring can be changed anytime. 

1	 Below the Control Room meters, in the control room monitoring pop-up menu,  
choose DCP.
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2	 Play the timeline once to monitor the DCP main output. 

3	 Change the Control Room monitoring back to Main 1.

Assigning the Music and Effects Tracks
Now it’s up to you to think through the M&E output to make sure all of the correct tracks or 
submixes are included. 

For example, the dispatch radio sound includes spoken words. Because it is not part of the 
original script, and source is not even visible onscreen, the foreign language translators 
may choose to omit it altogether. You can include those scripted lines and reference audio 
for the distributors and let them decide.

Meanwhile, you need to make sure the spoken radio audio is not included in the M&E mix. 
The best way to do so is to create a duplicate submix for the BG FX that excludes the 
RADIO track.

TIP  It’s a good idea to always reset the control room monitoring to the Main 
output when you are finished. 
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Another consideration is the ROOM track. Technically, ROOM is part of your dialogue mix; 
and because all evidence of the dialogue and production sound must be removed for 
dubbing, ROOM should also be left out of the M&E mix. 

1	 In the Bus Format window, duplicate the S3 BG FX submix. 

2	 Name the S4 BG FX submix, S4 BG FX M&E.

3	 In the Bus Assign window, assign the WALLA and SC MUSIC tracks to the submix.

4	 In the Bus Assign window, select the M2:M&E bus, and assign the appropriate 
submixes and tracks. Keep in mind that no spoken dialogue should be present in the 
M&E output bus. 

5	 Save the changes in the Bus Assign window. 

6	 Choose Control Room Monitoring > M&E, and play the timeline to hear the M&E output. 
The scene should sound great but have no trace of dialogue (including the radio).

7	 If tracks are missing, or you hear dialogue in the M&E output, go back to the Bus 
Assign window, and make the necessary changes to the track assignments. 

8	 Change the Control Room monitoring back to Main 1, and save the project. 

Monitoring Loudness in your Mix
Now that you are ready for final output, you need to monitor your output levels. In the past, 
broadcast standards were based on the highest peak level in a soundtrack. As long as 
audio content did not exceed that level, it would pass quality control. That led to 
commercials that applied heavy compression to narrow their dynamic range and bring all 
voiceovers to the maximum allowable (and overbearing) level.

To even the acoustic playing field, new loudness standards were introduced that apply to 
all broadcast programs (television and radio) regardless of the length or type of program.  
In North America and parts of Asia, an integrated target of -24 LUFS (Loudness Units Full 
Scale) is the norm for broadcast content, whereas in Europe the target is -23 LUFS. 
(Theatrical films, trailers, and streaming videos have different standards.)

Resolve includes two types of monitoring panel meters to measure such standards. Peak 
meters are traditional Root Mean Square (RMS) meters available for every track and bus 
that uses a decibel scale, and Loudness meters measure the loudness in your program 
based on the loudness unit scale (LUFS). 
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You can use the Loudness meters to measure the perceived loudness over the entirety of 
your program to verify that the levels of your final mix meet the current loudness standard, 
ITU BS.1770.  

The Fairlight page Loudness meters include a numeric display that outputs a variety of 
useful loudness measurements with the most important being the Integrated level. 

M measures 
momentary 
loudness unit 
average.

Short measures the average LU 
level over a 30-second window 
following the playhead.

Maximum LU measures maximum 
loudness unit value during playback

Short Max displays the maximum level 
over the same 30 second window. 

Range measures the dynamic range 
of the Loudness of your mix

Integrated measures the LUFS 
value of the range you’ve played. 
This analysis is required by most 
broadcast specifications.
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�� M displays the momentary loudness unit at the playhead location.

�� The loudness units meter displays the sum of all channels for the duration of playback. 
The numeric value at the top is the max LU value over that range. 

�� Short displays loudness over a 30-second range.

�� Short Max displays the played range’s maximum true peak level.

�� Range displays the dynamic range of loudness in the entire program.

�� Integrated displays the average loudness for the entire played range. This is the value 
that targets either -23 LUFS or -24 LUFS as required by broadcasters and is configured 
in your Project settings.

In this exercise, you’ll monitor the integrated loudness display to ensure it comes within 
+/- 0.5 of the target -23 LUFS.

1	 At the bottom of the Loudness meters, click the Reset button to clear all current 
measurements.

2	 Move the playhead to the beginning of the scene.

3	 Under the Loudness meters, click the Start button to enable the analysis. 

4	 Press the spacebar to play the timeline. Watch the integrated loudness display during 
playback to see how close to 0 on the loudness scale (-23 LUFS) your program measures.

The Loudness meter is a solid blue color that measures from -18 to +9, unlike decibel 
meters that show from -50 dbFS to 0 dbFS across their green, yellow, and red ranges. 
The Loudness meter is designed in this manner because -23 LUFS is equal to 0 on the 
Loudness meter scale. When you monitor levels with a Loudness meter, your goal is to 
keep the level near to 0. 

Although they analyze and measure audio differently, Loudness Units and Decibels 
have a 1-to-1 relationship which makes it easy to adjust faders when targeting the 
integrated loudness level. For instance, if the integrated loudness display shows +2 
LUFS after you play through your program, you can use the master fader to lower the 
decibels by -2 dB and reach the targeted 0 in the Integrated display.

5	 Raise or lower the master fader as necessary (a boost of about 1.5db should work here) 
to get the integrated level closest to 0 (-23 LUFS).

TIP  If you are delivering content for a region that requires an integrated 
loudness level other than -23, you can change the target loudness level in 
the Project Setting’s General options.
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6	 Reset the meter, click Pause, and play the timeline again. 

Don’t worry if your levels aren’t perfect. Just be aware of the Loudness meters and the 
Integrated loudness goals before you finally output your project.

7	 Save your progress.

NOTE  To listen to a version of this timeline completely mixed, feel free to open 
and play the 07 FINAL OUTPUT timeline.
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Lesson Review
1	 What steps do you need to perform in the Edit page to prepare your timeline for audio 

mixing in the Fairlight page?

A) Export your timeline as an XML file, and open this file in the Fairlight page.

B) Choose File > Send to Fairlight.

C) Click the Fairlight page button.

2	 Which Mixer control would you use to play one audio track from either the left speaker, 
the right speaker, or any surround speaker attached to your system?

A) Pan

B) Dynamics

C) EQ

3	 Which control would you use to make dialogue sound a little less bass-heavy?

A) Pan

B) Dynamics

C) EQ

4	 Where would you set up a set of submixes for your dialogue, effects, and music tracks?

A) Fairlight > Bus Format

B) Fairlight > Bus Assign

C) Fairlight Patch Input/Output

5	 How do you change the Target Loudness level from the default value of -23 LUFS?

A) You cannot change the Target Loudness level.

B) In Project settings

C) In User Preferences
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Answers
1	 C. Switch to the Fairlight page and continue working. You can switch between the 

Edit page and the Fairlight page at any time.

2	 A. The Pan controls.

3	 C. The EQ controls.

4	 A. Submixes and mains are setup in Fairlight > Bus Format. Individual tracks and 
submixes can then routed appropriately using Fairlight > Bus Assign, or by using 
the Main and Submix buttons in the Mixer.

5	 B. The Target Loudness level is set in the Audio Metering section of the General 
Options panel in Project settings.



Lesson 10

Delivering Projects

When you’re ready to export a project—
whether at the end of a workflow, at an 
intermediate point, or when generating 
dailies—the render settings and final output 
are configured in the Deliver page of  
DaVinci Resolve 15.

The aim of this lesson is to shed some light 
on advanced exporting options. You’ll gain 
an understanding of working with subtitles, 
outputting for digital cinema and outputting 
multiple jobs from different projects.

Time

This lesson takes approximately 
40 minutes to complete.

Goals

Working with Subtitles	 344

Delivering Programs with Subtitles	 354

Configuring a Timeline for 
Digital Cinema	 356

Rendering a DCP 	 359

Rendering and Editing Jobs from 
Multiple Projects	 364

Lesson Review	 367
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Working with Subtitles
DaVinci Resolve 15 allows you to add subtitles to your timelines in several ways. You can 
manually create all your subtitles for your project, or you can import a supported subtitle  
.srt file.

1	 In the Project manager, right-click and choose Import. Navigate to R15 Editing 201 > 
Lessons > Lesson 10 Delivery. Select R15 Editing Lesson 10 Deliver.drp, choose Open, 
and click OK to import the project into your Project manager.

2	 Open the project, and relink media files.

This project contains a finished version of the scene between the doctor and the FBI 
agents. Take a few minutes to reacquaint yourself with the scene and how the audio 
is mixed. All that’s left for you to do is add subtitles before outputting the final files 
for delivery.

3	 On the Edit page, open the Effects Library.

4	 In the Effects Library, in the Titles group, locate the Subtitles section.
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5	 Drag the Subtitle generator to the timeline in the space above the video tracks, and 
snap it to the beginning of the timeline.

A new track appears in the Timeline labelled “ST1 Subtitle 1,” and the subtitle text 
appears in the timeline viewer.

6	 In the timeline, select the subtitle, and open the Inspector.

The Inspector includes the controls for the individual subtitle captions and for the entire 
subtitle track.

TIP  You can show and hide existing subtitle tracks in the Timeline View 
Options menu.
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7	 In the Caption field, highlight the word “Subtitle,” and type Applause.

8	 Place the timeline playhead at the start of the second clip in the timeline,  
02_Dr_Sarah_Close Up.mov, and in the Inspector, click the Add New button.

A new subtitle is overwritten into the timeline at the current playhead position.

NOTE  Settings for the maximum number of characters per line and the 
minimum duration for each of your captions is set in the Subtitles panel of 
the Project settings window.
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9	 Select the new Subtitle generator, and in the Inspector, type the dialogue from the 
doctor, “Oh, thank you. I’m so glad you really liked it.”

10	 Trim the end of the second Subtitle generator to the end of the second clip on V1, 
02_Dr_Sarah_Close Up.mov.

You can edit and trim Subtitle generators, just like any other clip on your timeline.

Importing Subtitle Files
You can continue working through this timeline, adding subtitles for the lines of dialogue. 
However, it’s usually much more efficient and accurate to have someone transcribe the 
dialogue for you, and create a .srt file that you can import directly into Resolve.

1	 In the Media pool, press Shift-Cmd-N (macOS) or Shift-Ctrl-N (Windows) to create a 
new bin. Change the name to Subtitles.

2	 Choose File > Import File > Import Subtitle.

3	 Navigate to R15 Editing Lessons > R15 Editing Lesson 10 Deliver, and select the file 
Lesson 10 Subtitles US.srt.



348

W
o

rk
in

g
 w

it
h

 S
u

b
ti

tl
es

4	 Click Open.

The .srt file is added to the selected bin as a subtitle clip.

5	 Select the subtitle file. Lesson 10 Subtitles US, and drag it into the timeline so it starts 
at the location of the red timeline marker.

All the subtitles in the .srt file are added to the Subtitle 1 track in the timeline.

Adjusting Subtitles
Subtitles clips behave just like any clip in the Resolve timeline, so you can easily adjust 
their timings, as necessary.

1	 Type 1814 to navigate to the point before the doctor says, “That wouldn’t be possible.” 
Play the timeline from this point to review the dialogue and subtitles.

The subtitles appear on-screen too late for the doctor’s line of dialogue. You’ll need 
to adjust the subtitle timing to sync it correctly.

2	 Press T to enter Trim edit mode.

3	 In the timeline, select the lower portion of subtitle, “That wouldn’t be possible,”  
so the mouse pointer changes to a slide icon.
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4	 Slide the subtitle back to the left by about 17 frames, or until it snaps to the beginning 
of the doctor’s audio clip on A1.

5	 When you have finished sliding the subtitle into the correct position, press / (slash) 
to review the change.

6	 Press A to return to Selection mode.

You can also ripple and roll trim each of the subtitle generators, as well as cut each 
subtitle into shorter clips using the Razor Edit mode and keyboard shortcuts. Be aware 
that auto select controls for the subtitle track work the same as they do across all the other 
tracks in the timeline.

Maintaining Subtitle Sync 
If you want to further ensure that your subtitles remain synced to the appropriate audio 
clips, you can link the clips. By doing so, if you inadvertently change the timeline and knock 
the subtitles out of sync, red clip sync indicator will show how far out of sync they are. 

1	 In the timeline, select the second subtitle clip with the text, “Oh thank you, I’m so glad 
you really liked it.”

It makes sense to link this subtitle with the audio clip on A1.

2	 Select the second subtitle clip, and in A1, Cmd-click (macOS) or Ctrl-click (Windows) 
the orange audio clip.
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3	 With both clips selected, right-click either of them, and at the bottom of the shortcut menu, 
choose Link Clips, or press Opt-Cmd-L (macOS) or Alt-Ctrl-L (Windows) to link these clips.

You can also link multiple subtitles to multiple video and audio clips.

4	 In the timeline, select the next three subtitle clips along with the two yellow audio 
clips on A2.

5	 Press Opt-Cmd-L (macOS) or Alt-Ctrl-L (Windows) to link these clips.

These clips are now linked and will display the red out-of-sync indicators if they lose sync.

Styling Subtitles
Just as with any other title generator in Resolve, subtitle generators have many parameters 
that you can change to adjust the style and position of your subtitles and closed captions. 
One common style applied to subtitles is a semi-transparent box behind the text to help it 
stand out against video with a similar brightness.

1	 Move your playhead over the last subtitle in your timeline.

The end of the line appears a little obscured against this final shot and isn’t easy to read.
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2	 In the timeline, select the subtitle, and in the Inspector, click the Track Style tab.

3	 Scroll down to the Background options, and click the switch to enable the  
Background settings.

4	 Adjust the Width and Height settings so that the box extends behind the white text and 
helps it stand out from the similarly light video background.



352

W
o

rk
in

g
 w

it
h

 S
u

b
ti

tl
es

Because you have added this track style, all the subtitles in this track are updated with 
the change. This behavior is particularly useful when you need to modify style settings 
for all the subtitles in a track.

You can, however, override those track-wide settings for any individual subtitle when 
you need to adjust the color, font, or position of one or more subtitles, but not all.

5	 In the timeline, move the playhead to the first subtitle.

This subtitle indicates a sound effect rather than detailing spoken dialogue. As such, 
the director would like you to adjust it to appear a little more obvious.

6	 In the timeline, select the subtitle, and in the Inspector, select the Captions tab.

7	 Deselect Use Track Style.

A set of additional controls appear for this caption.

8	 Change the “Font face” to Italic to distinguish this caption from the other captions. 
The subtitle updates to reflect the change in style.
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Adding Additional Subtitle Tracks
You can add multiple subtitle tracks, which is particularly useful when you have to supply 
subtitles in more than one language.

1	 In the Edit page, right-click any one of the timeline track headers, and choose Add 
Subtitle Track.

An additional subtitle track is added to the timeline.

2	 In the Media pool’s Subtitles bin, right-click, and choose Import Subtitle.

3	 Navigate to R15 Editing Lessons > R15 Editing Lesson 10 Deliver, and select the  
Lesson 10 Subtitles FR.webvtt file. Click Open.

4	 Edit this new subtitle file into the empty subtitle track you just created, starting at the 
beginning of the timeline.
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This subtitle file includes French subtitles. You can rename subtitle tracks to reflect the 
language used, making it easier to identify the different tracks. 

5	 Double-click the Subtitle 1 track name, and type en_US to identify this subtitle as English 
for a US audience.

6	 Double-click the Subtitle 2 track name, and type fr_FR to identify this subtitle as French 
for a French audience.

More Info
Depending on your workflow and delivery specifications, you may be required to use 
standardized two- or three-letter abbreviations for each language as dictated by the 
International Organization for Standardization. 

See the website at www.loc.gov/standards/iso639-2/php/code_list.php for more details.

Delivering Programs with Subtitles
When it comes to delivering subtitles with your finished program, a number of options are 
open to you. Depending on your delivery format, you can include subtitles as burned-in 
graphics, embedded text in a supported media file, or as a separate file.

In this next exercise, you will output a file suitable for web delivery together with the 
necessary separate subtitle files.

1	 On the Deliver page, in the Render Settings window, choose the Vimeo 720p preset.

NOTE  This subtitle has none of the styling included with the previous subtitle 
you worked with; however, because the WebVTT format has support for basic 
text formatting, the first subtitle is italicized.

TIP  To choose the subtitle track visible in the timeline viewer, in the head of 
the track you wish to view, click the eye icon. You can display only one subtitle 
track at a time.
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2	 Scroll to the bottom of the video tab, expand the option for Subtitle Settings, and 
choose to Export Subtitle.

3	 Set the Format options to “As a separate file”.

If you chose the “Burn into video” option, Resolve would burn the currently active 
subtitles (with their styles) into the final rendered video file, so the subtitles would be 
permanently included as part of the video content. Choosing “As embedded captions” 
will output the currently active subtitle track as an embedded metadata layer within 
those media formats that support it. Currently, DaVinci Resolve has support for CEA-
608 and text captions within MXF OP1A and QuickTime containers.

4	 In the Export As pop-up menu, choose WebVTT and select both the “en_US” and 
“fr_FR” subtitle tracks to include them in the export.

5	 Click the Location Browse button, and navigate to R15 Editing Lessons > R15 Editing 
Lesson 10 Deliver > Output folder to choose the destination for your exported content. 
Click ok.

6	 Click the File tab, and in the “File subfolder” field, type Web.



356

C
o

n
fi

g
u

ri
n

g
 a

 T
im

el
in

e 
fo

r 
D

ig
it

al
 C

in
em

a

7	 Click Add to Render Queue.

The job is added to the Render Queue; but before you start the render, you may want 
to add more jobs and process them all at once.

Understanding Data Levels
In the Advanced Settings, Data Levels specifies the data range of an image based on its 
source. The default Auto setting renders media at a data level that is appropriate for the 
selected codec. Video refers to YCbCr formats that constrain to pixel data values between 
64-940 on a 10-bit system in formats using a Rec.709 video standard. Full expands the 
range to the film standard of 4-1024 values, which is utilized in digital film formats such as 
DPX. In general, the choice is leave this setting unchanged and let DaVinci Resolve choose 
the data level automatically. However, if you find that your final video looks substantially 
darker or lighter than it appears on your calibrated monitor, it is possible that the data levels 
are being incorrectly distributed. In that rare case, you may want to manually set the Data 
levels correctly for your intended distribution.

Configuring a Timeline for Digital Cinema
A digital cinema package, or DCP, is a collection of media and metadata files used to 
project digital movie files in a theatrical venue. Resolve makes it convenient to create an 
unencrypted digital cinema package. . This exercise will combine some practical 
information about the DCP with the few configuration steps required in the Deliver page.

When creating a DCP, the timeline in Resolve must be set to one of three 2K resolutions:

�� 2K Native (1.90:1) 2048 × 1080 @ 24, 25, 30, 48, 50 and 60 fps

�� 2K Flat (1.85:1) 1998 × 1080 @ 24, 25, 30, 48, 50 and 60 fps

�� 2K CinemaScope (2.39:1) 2048 × 858 @ 24, 25, 30, 48, 50 and 60 fps

Or one of three 4K resolutions:

�� 4K Native (1.90:1) 4096 × 2160 @ 24, 25, 30, 48, 50, and 60 fps

�� 4K Flat (1.85:1) 3996 × 2160 @ 24, 25, 30, 48, 50, and 60 fps

�� 4K CinemaScope (2.39:1) 4096 ×1716 @ 24, 25, 30, 48, 50, and 60 fps

TIP  DaVinci Resolve 15 also allows for the creation of encrypted DCP files using 
the easyDCP plug-in.



357

C
o

n
fi

g
u

ri
n

g
 a

 T
im

el
in

e 
fo

r 
D

ig
it

al
 C

in
em

a

This project is a Rec.709, full HD-resolution project. But as is often the case, you may have 
to output deliverables in multiple formats. So, let’s assume you need to output a DCP. The 
resolution for your DCP will be 2K flat because it is the closest resolution option when 
starting from full HD. You will still need to scale the project up and crop some of the top 
and bottom but not by much.

1	 Choose File > Save Project As, and save a copy of this project as R15 Editing Lesson 
10 Deliver DCP.

2	 Choose File > Project settings, or press Shift-9.

3	 In the Master settings, set the “Timeline resolution” to 1998 x 1080 DCI Flat 1.85.

16 x 9 frame 1.78:1

Native 1.9:1

Flat 1.85:1

Scope 2.39:1

TIP  4K DCPs use a lower bit rate when played on 2K projectors than do 2K 
DCP’s. For that reason, when your target projector is 2K, always make a 2K 
DCP, even if your content supports higher resolutions.
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4	 In Input Scaling, set the “Mismatched resolution files” to “Scale full frame with crop”.

Scaling full frame with crop ensures that the shortest dimension of the source clip fills 
the timeline resolution’s frame to omit letterboxing or pillars. However, it does crop a 
small bit off the top and bottom of the image.

5	 Click Save to close the window.

That takes care of the frame size, but your timeline frame rate is 23.976 fps and almost all 
DCPs use 24 fps. Fortunately, DCP interprets 23.98 fps as 24 fps, and audio playback is 
pulled up to match. 
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Rendering a DCP 
Now all your formatting is done, and you can move to the Deliver page to set up some 
DCP-specific parameters. 

1	 In the upper-left, in the Render Settings, click Custom.

Because there’s no default preset available for outputting a DCP package, you’ll create 
your own.

2	 In the Render area, choose Single Clip.

When creating a DCP, you will always want to output a single file for your project. 

3	 In the Video tab, in the Format menu, choose DCP.

4	 In the Codec menu, choose Kakadu JPEG 2000 2K DCI Flat.

TIP  The above settings will produce an unencrypted DCP package. If you need 
to produce an encrypted package, you should choose one of the easyDCP 
settings in the Codec pop-up menu. A demo version of easyDCP is included in 
all versions of Resolve that will allow you to playback up to fifteen seconds of 
good quality picture and sound that includes a visible watermark. For full 
functionality, licensing modules must be purchased from www.easyDCP.com, 
and Server Certificate Sets must be generated for each DaVinci Resolve 
system. See the DaVinci Resolve Manual for additional information.
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Let’s leave the maximum bitrate at 250 Mb/sec because that is the limit of most projectors.

The next checkbox determines if you are generating the DCP based on the older but 
more widely supported interop standard, or the more current and feature-rich SMPTE 
standard. One of the benefits of using the SMPTE standard is that it supports a wider 
range of framerates. The major benefit of using the interop standard is that it will work 
in more theaters, even though it is limited to only 24 or 48 fps. 

Setting Audio for DCP
Audio can have a few fits when exporting to a DCP. Stereo mixes such as in this project can 
be troublesome. First, a stereo soundtrack will be heard differently depending on the side 
of the theater you are sitting on, and the mono dialogue track will tend to get lost. If your 
project does not have a full surround sound mix, you can avoid these two-channel stereo 
issues by creating a three-channel LCR (left, center, right) mix for your stereo soundtrack. 
All the dialog will go to the center channel while music and sound effects go to the left and 
right channels.

If you are finishing your audio in the Fairlight page, you only need to set up a Main bus in 
the desired format. In this project, you set up an LCR Main bus in Lesson 8. If you also have 
a 5.1 or 7.1, or Imax mix to output, you could add those additional Main busses which would 
provide for correct signal panning in the Mixer.

1	 Click the Audio tab.

TIP  DCP uses the XYZ color space. The color space conversion is performed 
during the export to DCP. The source color space is determined by the timeline 
color space setting in the Color Management settings, even when DaVinci 
YRGB color management is not in use.
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Your only audio codec choice is Linear PCM. DCP audio is converted to broadcast 
.WAV files in an MXF wrapper at 24-bit, 48 kHz. The important aspect that you do 
control is which Main or Submix you want to output.

2	 In the Output Track 1 menu, choose the DCP (LCR) mix that you created in Lesson 8.

One of the benefits of using Fairlight to mix your audio, other than the fact that it is built 
into your editing and color grading system, is that it is somewhat format agnostic, so 
you can mix content once and then output to several formats. You can easily switch 
between stereo, LCR, and surround formats, and various speaker configurations with 
monitor control and metering following the selected set.

TIP  If you are providing multiple DCPs in various languages, a mixer setup  
with separate M&E and dialogue sub buses would be the desirable  
mixer configuration.
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Naming and Outputting a DCP
DCPs follow a somewhat specific, yet voluntary Digital Cinema Naming Convention for the 
content title. For each version of a movie you create (such as the English 5.1 version, the 
Spanish 5.1 version, the stereo version, the in-flight version, and so on), a composition play 
list (CPL) must be created that contains the appropriate content name. DaVinci Resolve 
includes a straightforward way to create a name that follows this naming convention using 
the DCP Composition Name Generator window.

1	 Click the Video tab.

Access to the content title creation tool is located in the Video tab.

2	 Scroll down to locate Composition name, and click Browse to open the Composition 
Name Generator window.

Here, you can enter the metadata that will be used to create a content title that is 
compatible with DCP servers and theater management systems.

3	 Enter information, and from the various menu options, choose the metadata that will 
be added to the content title. Click OK to close the window.

TIP  Separate the words in your movie’s title using initial caps, not spaces, 
hyphens, or underscores.
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The content title is not to be confused with the folder name that contains the DCP.  
That folder name is still managed in the File tab of the Deliver page.

4	 Click the File tab, and add a custom name as you would for any other output.

Finally, you need to select a destination for this DCP. Because you had previously 
set the output location in the earlier exercises, we just need to specify a different 
File subfolder.

5	 In the File subfolder field, type DCP.
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6	 When you are done selecting your drive destination, click “Add to Render Queue”.

After your DCP is rendered onto the correct hard drive, you’ll want to test it. The only 
foolproof way to test your DCP is to rent a theater and run it just as it would be projected for 
an audience. Only that way can you be absolutely sure that the color conversion worked 
perfectly, and the sound mix is what you wanted. In the meantime, you can view the DCP 
package contents by importing it into Resolve. 

Rendering and Editing Jobs 
from Multiple Projects
The Render Queue can show jobs from the current project or from all projects in your 
database. If you split longer projects into reels, or you are working on timelines with 
different frames rates for the same client, you might need to access all of the jobs in the 
queue instead of waiting for one batch to render before outputting other projects.

1	 Verify that the Deliver page is open.

2	 In the Render Queue options menu, choose Show All Projects.

Any jobs added to the Render Queue in any project currently in the database are 
displayed for you to select and render.

TIP  You can output the DCP to a hard drive in a Cru Dataport DX-115 enclosure 
which will load directly onto many digital cinema servers and is often required 
by some film festivals. More conveniently, you can output to a USB 2.0 or 3.0 
hard disc or USB stick if your film’s file size fits. No matter what storage device 
you choose, the device must be formatted as a Linux EXT2 or EXT3 drive. You 
can do so in a macOS or Windows environment by installing Linux in a virtual 
environment. Some servers do not deliver enough power for some USB-
powered drives to mount. In those scenarios, be sure to use a USB drive that 
uses an external power source.
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Even after you add jobs to the Render Queue, you can update their settings or 
remove them from the queue entirely.

3	 In the Render Queue options menu, choose Show Job Details.

The specific settings for each job are displayed, including resolutions, codec, 
and framerate.

4	 In the Render Queue, click the pencil icon on Job 1.

Because this job was sourced from another project, the project is switched and 
the Render Settings change to reflect the settings of the previous job. 
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The presence of additional Update Job and Cancel buttons at the bottom of the 
Render Settings indicates that a job is currently being edited.

Let’s make a small change to update the job

5	 In the Video tab, change the resolution to 1920 x 1080 HD.

6	 Click Update Job.

The change updates the original Vimeo job settings with the new setting as is reflected 
in the displayed job details in the Render Queue. 

7	 Finally, verify that neither of the jobs are selected in the Render Queue, and then click 
the Start Render button to create the output files.

Remote Rendering
DaVinci Resolve Studio allows you to offload rendering to another Resolve workstation. 
Remote rendering requires that all workstations have a copy of DaVinci Resolve 15 Studio 
installed, a shared Postgres database, and access to all necessary media files using the 
same file name path. With one computer acting as a render station, all other Resolve 
stations can continue to be used for further editing and grading.

Utilizing the correct render settings is vital to delivering an aesthetically correct and 
technically functional video project. Understanding these settings has even greater 
benefits. It elevates your skillset as an editor and imbues confidence that your projects  
are delivered at their optimal quality and adhere to industry standards.

TIP  To delete a job, click the X in the upper-right corner of the job in the 
Render Queue.
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This book has covered a range of editing workflows and tools, while making frequent 
references to craft techniques. However, it is important to remember that even when 
following common guidelines within the craft, each editor has a high degree of leeway in 
the workflows he or she chooses. 

As with any technical and creative skill, editing takes practice and experimentation to 
master. In the early stages of your career, you will experience times of uncertainty and 
self-doubt when cutting a scene. So, it is important to utilize your tools wisely, and 
approach each editing challenge with the intention to produce the clearest possible story.

Listen to feedback and re-evaluate your previous work to understand what did and didn’t 
work (and why). In time, by working through many editing issues and identifying your 
preferred workflows, you’ll acquire a greater sense of confidence in your ability, and a 
defining command over your personal and professional editing style. 

Lesson Review
1	 Depending on the format you choose, what options might you see when choosing to 

output subtitles with your final video file?

A) Burn into video

B) As embedded captions

C) As a separate file

2	 What are acceptable aspect ratio standards for 2K and 4K cinema?

A) DCI, DCI Flat, and DCI Scope

B) 2.35:1, 1.85:1 Anamorphic, and 16:9 Square Pixels 

C) CinemaScope, IMAX, and Supermarionation

3	 True or False? You can adjust the settings of a job that’s already been submitted to the 
Render Queue.

4	 Where do you specify the Composition Name for your DCP?

A) In Project settings

B) In the DCP Render Settings

C) Choose File > easyDCP > import KDM/Digest.

5	 True or False? You can access jobs submitted to the Render Queue from other projects 
in your database in the Project manager?
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Answers
1	 A., B., and C. Subtitles can be output as burned in captions, as separate files (either 

.SRT or .WebVTT), or as embedded captions (Text or CEA-608) for QuickTime or MXF 
OP1A containers.

2	 DCI, DCI Flat, and DCI Scope

3	 True. Click the pencil icon for any job that’s currently in the Render Queue. You can 
then update the current settings in the Render Settings before clicking Update Job.

4	 B. In the DCP Composition Name Generator window—which you find in the Video 
tab of the Render Settings, and access by clicking the Browse button next to the 
Composition Name field.

5	 False. To access jobs submitted to the Render Queue from different projects, click the 
Render Queue options menu, and choose Show All Projects.

Congratulations!

Congratulations! You just completed some high-end professional audio post-production 
from the comfort of your own computer workstation. Hopefully this lesson has opened your 
eyes and ears to the wonderful, yet often underappreciated world of audio post, as well as 
the awesome audio tools available as standard in DaVinci Resolve.

Test your skills by taking the online assessment: http://bit.ly/2O5197B
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